
Oracle® iSupport
Implementation Guide

Release 11i   

Part No.  B10622-01

June 2003



Oracle iSupport Implementation Guide, Release 11i     

Part No.  B10622-01

Copyright © 1997, 2003, Oracle Corporation. All rights reserved. 

Primary Author: Bill Colburn

Contributors: Hari Bala, William Calhoun, Trevor Chau, David Chou, Pulak Das, Jacqueline L. 
Fitzgerald, Maria Hui, Ramesh Jayaraman, Andrew Lam, Alan Lau, Vickie Laughlin, Anurag Malik, 
Bonnie Merritt, Sanjeev Sahni, Loi Tsang, Mani Vemulakonda, Amy Wong, Jack Wong, Mable Yee, 
Eugene Zhang, Nathan Zhou

The Programs (which include both the software and documentation) contain proprietary information of 
Oracle Corporation; they are provided under a license agreement containing restrictions on use and 
disclosure and are also protected by copyright, patent and other intellectual and industrial property 
laws. Reverse engineering, disassembly or decompilation of the Programs, except to the extent required 
to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems 
in the documentation, please report them to us in writing. Oracle Corporation does not warrant that this 
document is error-free. Except as may be expressly permitted in your license agreement for these 
Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, 
electronic or mechanical, for any purpose, without the express written permission of Oracle Corporation.

If the Programs are delivered to the U.S. Government or anyone licensing or using the programs on 
behalf of the U.S. Government, the following notice is applicable:

Restricted Rights Notice  Programs delivered subject to the DOD FAR Supplement are "commercial 
computer software" and use, duplication, and disclosure of the Programs, including documentation, 
shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement. 
Otherwise, Programs delivered subject to the Federal Acquisition Regulations are "restricted computer 
software" and use, duplication, and disclosure of the Programs shall be subject to the restrictions in FAR 
52.227-19, Commercial Computer Software - Restricted Rights (June, 1987). Oracle Corporation, 500 
Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently 
dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, 
redundancy, and other measures to ensure the safe use of such applications if the Programs are used for 
such purposes, and Oracle Corporation disclaims liability for any damages caused by such use of the 
Programs. 

Oracle is a registered trademark, and Oracle8, Oracle8i, Oracle9i, OracleMetaLink, and SQL*Plus are 
trademarks or registered trademarks of Oracle Corporation. Other names may be trademarks of their 
respective owners. 



Contents

Send Us Your Comments ...................................................................................................................    xi

Preface...........................................................................................................................................................   xiii

Audience for this Guide.......................................................................................................................    xiii
How To Use This Guide ......................................................................................................................    xiii
Typographic Conventions ...................................................................................................................     xv
Documentation Accessibility ..............................................................................................................     xv
Related Documentation and Training ...............................................................................................     xv
Do Not Use Database Tools to Modify Oracle Applications Data ...............................................     xxi
About Oracle .......................................................................................................................................     xxii

1  Introduction

1.1 Oracle E-Business Suite Overview......................................................................................    1-1
1.2 Oracle iSupport Overview ...................................................................................................    1-1
1.2.1 Oracle iSupport Key Features ......................................................................................    1-2

2  Technology, Requirements, and Performance

2.1 Architectural Overview........................................................................................................    2-1

3  Dependency Requirements and Verification

3.1 Overview of Dependencies..................................................................................................    3-1
3.2 Mandatory Dependencies ....................................................................................................    3-1
3.2.1 Oracle Application Object Library...............................................................................    3-2
 iii



3.2.2 Oracle Common Application Components ................................................................    3-2
3.2.3 Oracle Workflow ............................................................................................................    3-2
3.2.4 Oracle Trading Community..........................................................................................    3-2
3.2.5 Oracle Accounts Receivable..........................................................................................    3-2
3.2.6 Oracle General Ledger...................................................................................................    3-3
3.2.7 Oracle Human Resource Management System .........................................................    3-3
3.2.8 Oracle CRM Foundation ...............................................................................................    3-3
3.3 Conditional Dependencies ...................................................................................................    3-4
3.3.1 Oracle TeleService ..........................................................................................................    3-4
3.3.2 Oracle Inventory and Oracle Install Base ...................................................................    3-4
3.3.3 Oracle Bills of Materials.................................................................................................    3-4
3.3.4 Oracle Order Management ...........................................................................................    3-4
3.3.5 Oracle Quoting and Order Capture APIs ...................................................................    3-5
3.3.6 Oracle Purchasing ..........................................................................................................    3-5
3.3.7 Oracle iStore ....................................................................................................................    3-5
3.3.8 Oracle Contracts Suite ...................................................................................................    3-5
3.3.9 Oracle Customer Care....................................................................................................    3-6
3.3.10 Oracle Knowledge Management..................................................................................    3-6
3.3.11 Oracle Marketing Encyclopedia System .....................................................................    3-6
3.3.12 Web Call-Back Dependencies .......................................................................................    3-7
3.3.13 Oracle Scripting ..............................................................................................................    3-7

4  Implementation Overview

4.1 Process Overview ..................................................................................................................    4-1
4.2 Implementation Task Sequence...........................................................................................    4-1

5  Implementation Tasks

5.1 Installing the Application.....................................................................................................    5-2
5.1.1 Running Rapid Install....................................................................................................    5-2
5.1.2 Using the Oracle Application Implementation Wizard............................................    5-3
5.2 Confirming General Oracle Applications Setups .............................................................    5-4
5.2.1 Confirming Oracle Trading Community Architecture Setup..................................    5-4
5.2.2 Confirming Accounts Receivable Setup .....................................................................    5-5
5.2.3 Defining Employees.......................................................................................................    5-5
5.2.4 Confirming Oracle Foundation Technology Stack Setup.........................................    5-5
iv



5.3 Performing System Administration Setups.......................................................................    5-5
5.3.1 Confirm Menus/Functions Setup................................................................................    5-6
5.3.2 Understanding Responsibilities and Roles.................................................................    5-6
5.3.3 Set Up Profile Options...................................................................................................    5-7
5.3.4 Set Up Properties............................................................................................................    5-7
5.4 Setting Up Oracle Workflow ...............................................................................................    5-9
5.5 Setting Up CRM Foundation ...............................................................................................    5-9
5.6 Setting Up Oracle iSupport Users.......................................................................................    5-9
5.6.1 Setting Up Oracle iSupport Administrator ................................................................    5-9
5.6.2 Steps to Assign Additional Roles and Responsibilities ..........................................    5-13
5.6.3 Setting Up an Oracle iSupport Primary User...........................................................    5-14
5.6.4 Setting Up Employee User..........................................................................................    5-16
5.6.5 Setting Up Business (B2B) User..................................................................................    5-19
5.6.6 Setting Up Individual (B2C) User..............................................................................    5-20
5.6.7 Setting Up Knowledge Management Administrator-User ....................................    5-22
5.6.8 Setting Up Survey Administrator-User ....................................................................    5-22
5.6.9 Setting Up Guest User .................................................................................................    5-22
5.7 Setting Up Oracle iSupport Homepage ...........................................................................    5-24
5.7.1 Add Oracle Marketing Encyclopedia System Content to Homepage..................    5-24
5.7.2 Understanding the Add/Update Content Page......................................................    5-25
5.7.3 Changing Mandatory Bin Layout/Display..............................................................    5-26
5.7.4 Enabling Homepage Subscription E-Mails ..............................................................    5-26
5.8 Setting Up CRM User Management Framework............................................................    5-27
5.8.1 Setting Up Enrollments (Subscription Services)......................................................    5-28
5.8.2 Setting Up Registration Templates............................................................................    5-29
5.8.3 Setting Up Approval Processes..................................................................................    5-30
5.9 Setting Up Service Request ................................................................................................    5-32
5.10 Setting Up Products and Returns Applications..............................................................    5-32
5.11 Setting Up Knowledge Base Applications.......................................................................    5-32
5.11.1 Setting Up Knowledge Management ........................................................................    5-32
5.11.2 Setting Up Marketing Encyclopedia System............................................................    5-32
5.12 Setting Up iSupport Forums..............................................................................................    5-32
5.12.1 Creating Categories .....................................................................................................    5-32
5.12.2 Creating Forums...........................................................................................................    5-33
5.12.3 Restricting Access to Categories or Forums.............................................................    5-34
v



5.12.4 Creating Forum Moderators .......................................................................................    5-36
5.13 Setting Up Oracle iSupport Surveys.................................................................................    5-37
5.13.1 Setting Up Oracle Scripting ........................................................................................    5-37
5.13.2 Create Surveys in Oracle Scripting ............................................................................    5-38
5.13.3 Assign Survey Administrator Responsibility to an Oracle iSupport User ..........    5-38
5.13.4 Set Up Oracle iSupport Survey in iSurvey ...............................................................    5-39
5.13.5 Make Survey Available in Oracle iSupport..............................................................    5-40
5.13.6 View Survey Results ....................................................................................................    5-41
5.14 Setting Up Oracle iSupport Web Call-Back .....................................................................    5-42
5.15 Setting Up Contracts Applications....................................................................................    5-43
5.16 Setting Up Customer Care .................................................................................................    5-43
5.17 Setting Up Page-Level Look and Feel...............................................................................    5-43
5.17.1 General Steps to Perform JSP Configuration............................................................    5-44
5.17.2 Mapping Customized JSPs to Customizing Functions...........................................    5-45
5.17.3 Mapping Page-Level Configuration Functions to Responsibilities ......................    5-45
5.18 Setting Up Custom Menus .................................................................................................    5-46
5.19 Verifying the Implementation ...........................................................................................    5-46

6  Verifying the Implementation

6.1 Implementation Verification Overview .............................................................................    6-1
6.2 Verifying Homepage Implementation ...............................................................................    6-2
6.3 Verifying User Setups ...........................................................................................................    6-2
6.4 Verifying Service Request Implementation .......................................................................    6-3
6.5 Verifying Products/Returns Integration ...........................................................................    6-3
6.6 Verifying Forums Implementation .....................................................................................    6-5
6.7 Verifying Knowledge Management Implementation ......................................................    6-5

7  Integrating Oracle iSupport with Service Request

7.1 Overview of Service Request Functionality in Oracle iSupport .....................................    7-1
7.2 Overview of Dependencies ..................................................................................................    7-2
7.3 Overview of Setup Steps ......................................................................................................    7-3
7.4 Setting Up Oracle TeleService .............................................................................................    7-3
7.5 Setting Up Oracle Notes .......................................................................................................    7-8
7.5.1 Set Note Types as Public to View in Oracle iSupport...............................................    7-8
7.5.2 Restrict Note Types Viewed in Oracle iSupport........................................................    7-9
vi



7.6 Setting Up Service Request in Oracle iSupport.................................................................    7-9
7.6.1 Set Up iSupport Service Request Profile Options ...................................................    7-10
7.6.2 Set Up Service Request Defaults ................................................................................    7-10
7.6.3 Set up Service Request Templates .............................................................................    7-12
7.7 Setting Up Products ............................................................................................................    7-17
7.8 Using Knowledge Management in iSupport Service Request......................................    7-17
7.9 Setting Up E-mail Submission of Service Request Details ............................................    7-17

8  Integrating Oracle iSupport with Products and Returns

8.1 Understanding Integration with Products and Returns..................................................    8-1
8.2 Setting Up Oracle Inventory ................................................................................................    8-2
8.3 Setting Up Bills of Materials ................................................................................................    8-2
8.4 Setting Up Oracle Install Base .............................................................................................    8-3
8.5 Enabling Returns Functionality...........................................................................................    8-3
8.5.1 Understanding Returns in Oracle Order Management............................................    8-3
8.5.2 Understanding Returns in Oracle iSupport ...............................................................    8-5
8.5.3 Setting Up Oracle Quoting ...........................................................................................    8-6
8.5.4 Setting Up Oracle Order Management .......................................................................    8-6
8.5.5 Guidelines .......................................................................................................................    8-8
8.5.6 Troubleshooting Returns in Oracle iSupport.............................................................    8-9
8.5.7 Set Up Oracle Advanced Pricing .................................................................................    8-9
8.5.8 Set Up Oracle Shipping .................................................................................................    8-9
8.5.9 Set Up Oracle Purchasing .............................................................................................    8-9

9  Integrating Oracle iSupport with Oracle Knowledge Management

9.1 Overview of Oracle Knowledge Management .................................................................    9-1

10  Integrating Oracle iSupport with Oracle Workflow

10.1 Oracle Workflow Overview...............................................................................................    10-1
10.1.1 Workflow Client ...........................................................................................................    10-1
10.1.2 Workflow Server ..........................................................................................................    10-2
10.2 Overview of Oracle Workflow Functionality in iSupport.............................................    10-3
10.2.1 Service Request.............................................................................................................    10-3
10.2.2 Returns...........................................................................................................................    10-3
vii



10.2.3 Homepage Subscription E-mails................................................................................    10-4
10.2.4 Knowledge Management ............................................................................................    10-4
10.2.5 User Approvals.............................................................................................................    10-4
10.3 Setting up Oracle Workflow ..............................................................................................    10-5

11  Diagnostics and Troubleshooting

11.1  Stop/Start Apache (Bounce) Server after Patching .......................................................    11-1
11.2 Java/HTML Stack Errors....................................................................................................    11-1
11.2.1 JspCompileException...................................................................................................    11-2
11.2.2 NoSuchMethod.............................................................................................................    11-3
11.2.3 JTF Login Page Errors ..................................................................................................    11-4
11.2.4 java.lang.nullpointerException ..................................................................................    11-5
11.2.5 JTF-0198..........................................................................................................................    11-5
11.3 How to Find Responsibility ID Values.............................................................................    11-6
11.4 Debugging Oracle iSupport Returns Functionality........................................................    11-7
11.5 Customizing Oracle iSupport Quick Find Menu............................................................    11-8
11.6 Oracle iSupport Administration FAQs ............................................................................    11-8

A  Profile Options

A.1 Before You Begin ...................................................................................................................    A-1
A.2 About User Profile Options..................................................................................................    A-1
A.3 How to Set Profile Options ..................................................................................................    A-2
A.4 Setting Oracle User Management Profile Options............................................................    A-3
A.5 Oracle Common Application Components (JTT) Profile Options .................................    A-4
A.6 Oracle iSupport Profile Options ..........................................................................................    A-6
A.7 Oracle Service Profile Options...........................................................................................   A-13
A.8 Returns Profile Options ......................................................................................................   A-15
A.9 Oracle Knowledge Management Profile Options...........................................................   A-16
A.10 Miscellaneous Profile Options...........................................................................................   A-17

B  Seed Data

B.1 Seeded Menus ........................................................................................................................    B-1
B.1.1 Oracle iSupport Menus..................................................................................................    B-1
B.1.2 Oracle iSupport Top Menus by User Type.................................................................   B-3
viii



B.1.3 Oracle iSupport Menu Structures by User Type .......................................................    B-3
B.2 Oracle iSupport Functions ...................................................................................................    B-7
B.3 Seeded User Responsibilities ...............................................................................................    B-9
B.4 Seeded User Roles ...............................................................................................................    B-10
B.4.1 User Roles......................................................................................................................    B-10
B.4.2 Oracle iSupport User Roles by User Type................................................................   B-10
B.5 Seeded Permissions.............................................................................................................   B-11

C  Functions and Variables for Page-Level Configurability

C.1 Functions for Page-Level Configurability .........................................................................   C-1
C.2 Variables for Page-Level Configurability ..........................................................................   C-4

Glossary

Index
ix



x



Send Us Your Comments

Oracle iSupport Implementation Guide, Release 11i    

Part No.  B10622-01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this 
document. Your input is an important part of the information used for revision.

■ Did you find any errors?
■ Is the information clearly presented?
■ Do you need more information? If so, where?
■ Are the examples correct? Do you need more examples?
■ What features did you like most?

If you find any errors or have any other suggestions for improvement, please indicate the document 
title and part number, and the chapter, section, and page number (if available). 

You can send comments to us by electronic mail to mfgdoccomments_us@us.oracle.com. Please 
include your product name in the subject line: Attn: Oracle iSupport.

If you would like a reply, please give your name, address, telephone number, and (optionally) elec-
tronic mail address.

 If you have problems with the software, please contact your local Oracle Support Services.
xi



xii



Preface

Welcome to Release 11i of the Oracle iSupport Implementation Guide. This guide is 
intended to be utilized in the implementation of Oracle iSupport.

Audience for this Guide
This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle iSupport

If you have never used Oracle iSupport, Oracle suggests you attend one or 
more of the Oracle iSupport training classes available through Oracle 
University.

■ The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

How To Use This Guide
This guide contains the information you need to implement Oracle iSupport and 
Oracle Knowledge Management, release 11.5.9. It is organized into the following 
chapters:

■ Chapter 1 -- Introduction -- Contains an overview of the features and 
functionality of Oracle iSupport. It also highlights what is new in this release of 
the application.
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■ Chapter 2 -- Technology, Requirements, and Performance -- contains an architectural 
overview of the application, as well as the minimum software and hardware 
requirements of Oracle iSupport. 

■ Chapter 3 -- Dependency Requirements and Verification -- details Oracle iSupport’s 
dependency relationships with other Oracle applications. This chapter also 
provides installation and dependency verification steps.

■ Chapter 4 -- Implementation Overview -- describes in general terms the high-level 
implementation steps for Oracle iSupport and its dependencies.

■ Chapter 5 -- Implementation Tasks -- provides the step-by-step instructions 
required to successfully set up Oracle iSupport and its dependencies.

■ Chapter 6 -- Verifying the Implementation -- can assist you in verifying that you 
have successfully implemented the major features and functionality of Oracle 
iSupport.

■ Chapter 7 -- Integrating Oracle iSupport with Service Request -- contains 
information to successfully implement the service request functionality of 
Oracle iSupport.

■ Chapter 8 -- Integrating Oracle iSupport with Products and Returns -- details the 
Oracle applications that provide product information to various processes. This 
chapter also describes the returns process and setup dependencies for returns.

■ Chapter 9 -- Integrating Oracle iSupport with Oracle Knowledge Management -- 
provides an overview of the Oracle Knowledge Management application and 
its importance to Oracle iSupport.

■ Chapter 10 -- Integrating Oracle iSupport with Oracle Workflow -- discusses the 
functionality that Oracle Workflow provides to Oracle iSupport.

■ Chapter 11 -- Diagnostics and Troubleshooting -- provides details of common 
problems found while implementing or accessing the application. This chapter 
also contains FAQs for Oracle iSupport administration.

■ Appendix A -- Profile Options -- describes how to set up the profile options 
related to implementing Oracle iSupport.

■ Appendix B -- Seed Data -- provides information on the data that is seeded 
within Oracle iSupport.

■ Appendix C -- Functions for Page-Level Configurability -- lists the functions with 
which to configure the sections that can surround application pages that Oracle 
supplies with the application.
xiv



Typographic Conventions
This manual uses the typographic conventions listed in the following table:

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/. 

Accessibility of Links to External Web Sites in Documentation 
This documentation may contain links to Web sites of other companies or 
organizations that Oracle Corporation does not own or control. Oracle Corporation 
neither evaluates nor makes any representations regarding the accessibility of these 
Web sites. 

Related Documentation and Training
Oracle iSupport shares business and setup information with other Oracle 
Applications products. Therefore, you will need to refer to other documentation 

Convention Meaning

italic text Book or chapter titles, emphasis

Courier text User commands, file content examples, directory names

UPPERCASE Structured Query Language (SQL) commands, initialization 
parameters, profile options, responsibilities, or environment 
variables

boldface text Menu, button, keyboard, and window options

< > Angle brackets enclose user-supplied names. 

Note: Do not type the angle brackets.
xv



when setting up the application. You also may wish to access training. This section 
discusses your documentation and training options.

Documentation Related to Oracle iSupport Setup/Usage
Oracle iSupport online HTML help is available by selecting Oracle iSupport from 
the online help menu. Printed versions of the user and implementation manuals are 
available for purchase from Oracle Store (http://store.oracle.com) and Oracle 
Technology Network (http://otn.oracle.com/documentation). Online HTML help 
patches and PDF versions of guides are available on OracleMetaLink 
(http://metalink.oracle.com).

Available PDF version of the guides used for implementing and using Oracle 
iSupport and its dependencies are listed below.

■ Oracle iSupport Guides

■ Oracle iSupport Implementation Guide

■ Oracle iSupport User Guide

■ Knowledge Management Applications Guides

■ Oracle Knowledge Management User Guide

■ Oracle Knowledge Management Implementation Guide

■ Oracle Products Applications Guides

■ Oracle Inventory User’s Guide

■ Oracle Bill of Materials User’s Guide

■ Oracle Install Base Implementation Guide

■ Oracle Install Base User Guide

■ Oracle Purchasing-Related Applications Guides

■ Oracle Order Management Suite Implementation Manual

■ Oracle Order Management User’s Guide

■ Oracle Quoting Implementation Guide

■ Oracle Quoting User Guide

■ Oracle iStore Implementation and Administration Guide

■ Oracle iStore User Guide

■ Oracle TeleService (Customer Support/Service Request) Application Guides
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■ Oracle TeleService User Guide

■ Oracle TeleService Implementation Guide

■ Oracle Contracts Applications Guides

■ Oracle Service Contracts User Guide

■ Oracle Contracts Core User Guide

■ Oracle Telephony Manager Guides

■ Oracle Telephony Manager Implementation Guide

■ Oracle Telephony Manager User Guide

■ Oracle Call Center Guides

■ Oracle Call Center Connectors Implementation Guide

■ Oracle Scripting Guides

■ Oracle Scripting Implementation Guide

■ Oracle Scripting User Guide

■ Oracle Quality Guide

■ Oracle Quality User’s Guide

Documentation Related to All Oracle Products
All Oracle Applications documentation is available online (HTML or PDF) by 
selecting Library from the documentation CD-ROM or by selecting the Help button 
on the user interface (UI). Online HTML help patches and PDF versions of guides 
are available on OracleMetaLink (http://metalink.oracle.com).

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle iSupport (and 
any other Oracle Applications products). This guide also includes information on 
setting user profiles, as well as running and reviewing reports and concurrent 
processes.

You can access this user’s guide online by choosing Getting Started with Oracle 
Applications from any Oracle Applications help file.
xvii



Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Oracle 
Business Intelligence System, languages and character sets, and self-service web 
applications.

Oracle Applications Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Rapid Install, which minimizes the time to install Oracle Applications, the 
Oracle9i technology stack, and the Oracle9i Application Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Rapid Install and lists the tasks you need to perform to finish your installation. You 
should use this guide in conjunction with individual product user’s guides and 
implementation guides.

Oracle Applications Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Oracle Applications Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.
xviii



Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library (AOL) 
components needed to implement the Oracle Applications user interface described 
in Oracle Applications User Interface Standards for Forms-Based Products. It also 
provides information to help you build your custom Oracle Forms Developer 6i 
forms so that they integrate with Oracle Applications.

Multiple Reporting Currencies in Oracle Applications
If you use the Multiple Reporting Currencies feature to record transactions in more 
than one currency, use this manual before implementing Oracle iSupport. This 
manual details additional steps and setup considerations for implementing Oracle 
iSupport with this feature.

Multiple Organizations in Oracle Applications
This guide describes how to set up and use Oracle iSupport with Oracle 
Applications' Multiple Organization support feature, so that you can define and 
support different organization structures when running a single installation of 
Oracle iSupport.

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes.You also use 
this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup, and reference information for the 
Oracle iSupport implementation team, as well as for users responsible for the 
ongoing maintenance of Oracle Applications product data. This manual also 
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
xix



Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on OracleMetaLink.

Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual
This manual describes Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Oracle Common Application Components Implementation Guide
Many products use components from Oracle Common Application Components. 
Use this guide to correctly implement CRM Application Foundation.

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle iSupport and 
reach full productivity quickly. You have a choice of educational environments. You 
can attend courses offered by Oracle University at any one of our many Education 
Centers, you can arrange for our trainers to teach at your facility, or you can use 
Oracle Learning Network (OLN), Oracle University's online education utility. In 
addition, Oracle training professionals can tailor standard courses or develop 
custom courses to meet your needs. For example, you may want to use your 
organization’s structure, terminology, and data as examples in a customized 
training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle iSupport working for 
xx



you. This team includes your Technical Representative, Account Manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
business area, managing an Oracle9i server, and your hardware and software 
environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use OracleMetaLink, register at (http://metalink.oracle.com). Bugs created 
against the Oracle iSupport application use the bug identifier number of 381. 

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change that you make 
using Oracle Applications can update many tables immediately. But when you 
modify Oracle Applications data using anything other than Oracle Applications, 
you may change a row in one table without making corresponding changes in 
related tables. If your tables get out of synchronization with each other, you risk 
retrieving erroneous information and you risk unpredictable results throughout 
Oracle Applications.
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When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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Introduction

This topic group provides an introduction to the Oracle iSupport 11i application 
and its components, and lists features and functionality new in this release.

■ Oracle E-Business Suite Overview

■ Oracle iSupport Overview

1.1 Oracle E-Business Suite Overview
Oracle E-Business Suite is a complete set of business applications that enables you 
to efficiently manage customer interactions, manufacture products, ship orders, 
collect payments, and more - all from a business system that shares a single 
technology foundation. For more information, visit the Oracle web site at:

http://oracle.com.

1.2 Oracle iSupport Overview
Oracle iSupport is an Internet-based customer support application that enables 
merchants to provide self-service customer support online. Oracle iSupport 
functionality allows organizations to provide users with support information and 
problem solutions. Integration with other Oracle products gives users the ability to 
manage their own service needs.

A fully-realized Oracle iSupport implementation can reduce service costs, 
consolidate service and product information, and allow service personnel to focus 
on non-repetitive customer requests, thus increasing customer satisfaction and 
product viability.
uction 1-1
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1.2.1 Oracle iSupport Key Features
Key features and benefits of Oracle iSupport include the following:

1.2.1.1 Service Request
Oracle iSupport enables users to manage their service request activity online. This 
functionality is available if the merchant sets up the service request functionality 
detailed in the chapter, Integrating Oracle iSupport with Service Request. Additional 
support features can be realized by implementing Oracle Knowledge Management 
and the products and returns features. See the chapters, Integrating Oracle iSupport 
with Oracle Knowledge Management and Integrating Oracle iSupport with Products and 
Returns for more information.

After the service request information has been entered, it is validated by Oracle 
TeleService and assigned a unique tracking number for future reference. Merchants 
can enforce product selection and/or knowledge base searching during the service 
request process.

A typical business scenario is:

■ Customer logs in to Oracle iSupport.

■ Customer queries knowledge base directly for troubleshooting help prior to 
creating a new request.

■ Customer accesses Create Service Request page and enters contact and service 
request detail information. Customer sets up optional service request profile to 
aid in date entry for submitting this and future service requests. Customer may 
also attach any type of file(s) to the service request.

■ After the service request is submitted, the system returns a tracking number to 
the customer. At the end of the service request submission process, customers 
have the option of adding the service request link to the Homepage, and/or 
having the service request details sent to the e-mail address that is set up in the 
Personal Profile.

■ After service request submission, customers can view, close, update, attach 
additional files, and/or conditionally re-open their service requests.

1.2.1.2 Knowledge Base
Oracle Knowledge Management implementation allows access to the known 
problems/solutions database, and permits users to locate technical documents, 
including white papers, user guides, and FAQs. The merchant benefits by increased 
knowledge among customers and reduced call center activity. The Oracle 
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Knowledge Management user interface is easy to use and features flexible search 
capabilities. For additional information, see the Oracle Knowledge Management 
Implementation Guide and Integrating Oracle iSupport with Oracle Knowledge 
Management chapter of this guide.

A typical business scenario is:

■ Customer logs in to Oracle iSupport. Customer views Alerts and Company 
News on the Homepage.

■ Customer accesses the knowledge base from the Homepage or by using the 
Support page.

■ Customer uses either basic or advanced search functions to locate answers.

■ Customer views solution detail, and can add link to the Homepage if desired.

1.2.1.3 Account Management
Oracle iSupport’s optional account management functionality allows users to view 
detailed transaction history and status, and to create returns. Integration with 
products and returns applications allows a user to view orders, invoices, payments, 
and shipping information, as well as to create return material authorizations 
(RMAs). Integration with Oracle Contracts Suite, if these optional modules are 
implemented, provides a view of contracts, entitlements validation, and customer 
service programs, and warranties.

If all required applications are implemented, this functionality allows customers to 
service their own account needs. For more information, see the chapter Integrating 
Oracle iSupport with Products and Returns. For setting up Contracts functionality, 
refer to Oracle Contracts Core Implementation Guide, and Oracle Service Contracts 
Implementation Guide.

A typical business scenario is:

■ Customer logs in to Oracle iSupport.

■ Using the Accounts tab, the customer has online, real-time access to information 
regarding account data, including:

■ Orders

■ Shipments

■ Invoices

■ Payments
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■ Contracts

■ Returns

1.2.1.4 Products Repository
Oracle Install Base is a repository of customer or organization/party purchase 
information, including purchase date, product attributes, and applicable service 
agreements. Oracle Install Base maintains information about purchased products in 
a tree structure showing all of the parent and child assemblies. It allows users to 
drill down to view detailed product information. Oracle Install Base tracks, updates, 
and maintains product configurations whenever a new part or component is 
installed or replaced. It also allows the grouping of customer products into systems 
for ease of service. Oracle Install Base tracks serialized and non-serialized products, 
and provides powerful search capabilities. Support organizations benefit from 
having customers who are informed about their transaction and product histories 
and applicable contracts.

Required integration with Oracle Inventory, as well as optional integration with 
Oracle Bills of Material, further facilitate access to product information. With 
Products functionality, users can manage and track products themselves online, 
thus decreasing calls to customer service centers and increasing customer control 
over service issues. For more information, see the chapter, Integrating Oracle iSupport 
with Products and Returns.

A typical business scenario is:

■ Customer logs in to Oracle iSupport.

■ Customer accesses Oracle Install Base from the Products tab.

■ Customer reviews product details and/or adds products to Oracle Install Base.

1.2.1.5 Oracle iSupport Homepage
Oracle iSupport’s homepage features links to support areas of the application.

General users can personalize their homepages with links to service request activity 
and knowledge base search results. The user also has the option of having the 
contents of his homepage e-mailed to him; this is known as a homepage 
subscription.

Merchants can send alerts and other system messages to the homepage for viewing 
by general users and employees. The merchant has the option of making some 
homepage content mandatory.
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For more information, see the Setting up iSupport Homepage topic area in this 
guide’s Implementation Tasks chapter.

A typical business scenario is:

■ Customer logs in to Oracle iSupport and access the Homepage (the initial 
landing page).

■ Customer views Alerts, company news, or other content provided by the 
administrator.

■ Customer accesses Content hyperlink to add or remove content.

■ Customer accesses Layout hyperlink to change the layout of content.

■ Customer selects Edit hyperlink on Service Request Quick Links, Service 
Request (saved views), and/or Quick Links bins to configure display of these 
bins.

1.2.1.6 Oracle iSupport Forums
Oracle iSupport Forums are online message boards where customers can post 
questions and comments and review those from other users. Organized into 
categories, forums enable customers to share information. In Oracle iSupport, users 
can search for specific subjects or browse within a particular forum. Oracle iSupport 
allows merchants to create and manage forums, and to use forum moderators for 
certain forum administrative tasks. For more information, see the Setting up 
iSupport Forums topic area in this guide’s Implementation Tasks chapter.

A typical business scenario is:

■ Customer logs in to Oracle iSupport.

■ Customer accesses the Forum tab to view organized categories and forums 
subcategories. 

■ Customer selects a hyperlinked forum message, views the message, and can 
post a new message underneath that forum message or start a new message 
thread.

■ Customer can use forums signature feature to allow personalized signing of his 
forum messages.

■ Customer can use Advanced Search to query by keyword, category, date, 
message status, and author. 
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Technology, Requirements, and

Performance

This chapter provides details on the architecture of Oracle iSupport 11i. 

2.1 Architectural Overview
Oracle iSupport runs on a 3-tier system composed of:

Data Tier - The data tier includes Oracle ERP and CRM main tables that compose 
their common schema. These are driven by the Oracle 8i database. Most of the CRM 
application business logic that is written in PL/SQL are also in the data tier.

Application Tier - The application tier uses business logic APIs and CRM 
Foundation services, Java Server Pages (JSP), and Java APIs. In addition, the Oracle 
Application Object Library (AOL) supplies technology and common libraries for the 
applications. In Oracle applications, Internet Application Server (iAS) drives this 
tier and the Presentation tier discussed below.

Presentation Tier - Generated Java code and compiled servlet code utilize JSP 1.0 
and Servlet 2.0 to form the presentation tier. In Oracle applications, the Apache 
Server 1.3.9 drives this tier.
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Dependency Requirements and Verification

This chapter describes in general terms the dependency requirements and 
verification of dependencies for Oracle iSupport 11i. Topics include:

■ Overview of Dependencies

■ Mandatory Dependencies

■ Conditional Dependencies

3.1 Overview of Dependencies
Because Oracle iSupport is composed of multiple Oracle modules that supply 
varied data and functionality, merchants can choose which modules to implement 
based on their specific business requirements. These integrated modules present 
many dependencies to Oracle iSupport.

Dependencies are classified as either mandatory, meaning that Oracle iSupport 
cannot function without them, or conditional, meaning that they supply additional 
functionality, but are not required to run Oracle iSupport. The Mandatory and 
Conditional Dependencies sections in this chapter provide overviews of these 
dependencies.

For documentation and training related to these modules, see the Preface to this 
guide.

3.2 Mandatory Dependencies
Oracle iSupport relies on several Oracle ERP and CRM modules for its data and 
functionality. The modules that must be installed and set up for Oracle iSupport to 
function properly are discussed in the following paragraphs.
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3.2.1 Oracle Application Object Library
The Oracle Application Object Library is a required dependency of all Oracle 
applications. Supplying technology and common libraries for Oracle applications, 
Oracle Application Object Library allows user creation, responsibility creation and 
maintenance, and the assignment of responsibilities to users. 

3.2.2 Oracle Common Application Components
Oracle Common Application Components is a prerequisite for implementation of 
any Oracle CRM module. The technology stack supplies debug logging trails and 
cookie encryption.

3.2.3 Oracle Workflow
In all Oracle applications, Oracle Workflow provides the ability to send e-mail 
notifications, and allows you to define various workflow processes required for 
normal business operations. Oracle Applications 11i comes with Oracle Workflow 
(WF) already installed as part of the Applications Object Library. For details on how 
Oracle iSupport uses Oracle Workflow, please see the chapter in this guide, 
Integrating Oracle iSupport with Oracle Workflow.

3.2.4 Oracle Trading Community
The 11i Oracle Trading Community Architecture consists of a database schema, 
APIs, and data quality management utilities that allow you to capture and exploit 
valuable information about your commercial community: organizations, people, 
places, and the network of relationships that bring them together. Oracle Trading 
Community Architecture is used by both Oracle ERP and Oracle CRM applications. 
In Release 11i, Oracle’s customer model is based on Oracle Trading Community 
Architecture. 

Some APIs for Oracle Trading Community Architecture are published as part of this 
release. Refer to current Oracle Trading Community Architecture documentation for 
API details.

3.2.5 Oracle Accounts Receivable
A central data repository for customer information that uses the Oracle Trading 
Community Architecture model, Oracle Accounts Receivable provides customer 
account data for Oracle iSupport. After a customer books an order in an Oracle 
CRM application, an account is created in Oracle Accounts Receivable. If a customer 
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is directly created in Oracle Accounts Receivable, then an account number is also 
generated. Oracle Accounts Receivable also calculates taxes and generates invoices.

3.2.6 Oracle General Ledger
Oracle iSupport uses General Ledger to set up ledgers and books, store exchange 
rates, and store related business information. Refer to Oracle General Ledger User 
Guide for complete setup information.

3.2.7 Oracle Human Resource Management System
Oracle Human Resources Management System provides employee data for CRM 
and ERP applications.

3.2.8 Oracle CRM Foundation
CRM Foundation 11i suite of applications supplies a significant amount of 
functionality for Oracle iSupport. The CRM Foundation software suite is split into 
two distinct but interrelated application groups:

■ CRM User Management (JTT) - Provides Java-based infrastructure software 
that is used to develop e-business solutions such as Sales, Marketing, Service, 
E-Commerce, Contracts, and Interaction Center applications. It offers a common 
platform for developing applications with HTML, XML, and Java. It also 
provides user-friendly screens for centralized setup and administration. This 
web-based interface is called the System Administrator Console. The CRM User 
Management Framework uses this application group. For more information, see 
the Oracle Common Application Components Implementation Guide and the Oracle 
Common Application Components User's Guide.

■ CRM Application Foundation (JTA) - Consists of the following CRM 
applications: Territory Manager, Resource Manager, Notes, Calendar, Task 
Manager, Interaction History, Fulfillment, Assignment Manager, and Escalation 
Management. Documentation for this application group also includes 
information on using Spreadtables and TCF Servers for Gantt charts. For more 
information, see Oracle Common Application Components Implementation Guide 
and the Oracle Common Application Components User’s Guide.

In Oracle iSupport, the service request processes are highly dependent upon 
Assignment Manager, Notes, Resource Manager, and Territory Manager. 
Knowledge Management also uses Notes and Resource Manager. For more 
information, see Integrating Oracle iSupport with Service Request and Integrating 
Oracle iSupport with Knowledge Management.
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3.3 Conditional Dependencies
Oracle iSupport relies on several other Oracle applications to extend its 
functionality. The applications that are conditional to Oracle iSupport are discussed 
in the following paragraphs.

3.3.1 Oracle TeleService
A forms-based product, Oracle TeleService contains the bulk of the service request 
functionality for Oracle iSupport. Integration with Oracle TeleService allows 
customers using Oracle iSupport to submit, view, edit, and re-open their service 
requests online. Setup information is in the chapter, Integrating Oracle iSupport with 
Service Request.

3.3.2 Oracle Inventory and Oracle Install Base
Oracle Inventory supplies the infrastructure that contains an organization’s entire 
product repository and configuration. It integrates closely with Oracle Install Base, 
which is the repository of customer- or party-purchased products. Both Oracle 
Inventory and Install Base are required for full service request functionality in 
Oracle iSupport. Both applications also supply product information during retrieval 
of account information on the Oracle iSupport Accounts tab. Setup information is in 
the chapter, Integrating Oracle iSupport with Products and Returns.

3.3.3 Oracle Bills of Materials
Oracle Bills of Materials allows you to configure groups of products into 
coordinated and complementary systems. Oracle Bills of Materials allows the 
creation of products containing multiple components and subcomponents. It 
integrates with Oracle Inventory and Oracle Install Base. Setup information is in the 
chapter Integrating Oracle iSupport with Products and Returns.

3.3.4 Oracle Order Management
Oracle Order Management processes orders booked in Oracle Quoting, Oracle 
iStore, and Oracle Order Management itself. Oracle Order Management and Oracle 
Quoting are both integral applications for returns functionality in Oracle iSupport. 
Oracle Order Management integrates with Oracle Pricing for determining prices of 
goods sold and Oracle Shipping for shipping execution. Oracle Order Management 
uses Oracle Receivables for keeping records of customers and invoices, and 
capturing payments. Oracle Order Management also depends on Oracle General 
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Ledger. Setup information is in the chapter, Integrating Oracle iSupport with Products 
and Returns.

3.3.5 Oracle Quoting and Order Capture APIs
Orders quoted in Oracle Quoting are sent to Oracle Order Management for 
processing. These orders then can be viewed within the Oracle iSupport Accounts 
tab. There are three parts to quoting: Oracle Quoting for forms, Oracle Quoting for 
HTML, and Oracle Order Capture APIs. All of these coordinate in the returns 
process, and Oracle Order Capture APIs are essential to returns functionality in 
Oracle iSupport. Setup information is in the chapter, Integrating Oracle iSupport with 
Products and Returns.

3.3.6 Oracle Purchasing
The Receipts form of Oracle Purchasing receives returns created in Oracle iSupport. 
Setup information is in the chapter, Integrating Oracle iSupport with Products and 
Returns.

3.3.7 Oracle iStore
The Oracle iStore application provides allows merchants to set up Internet 
storefronts that capture and process customer orders. Oracle iStore is not required 
for any functionality within Oracle iSupport, but orders placed in Oracle iStore can 
be viewed within the Oracle iSupport Accounts tab. Setup information is contained 
within the Oracle iStore Implementation Guide.

3.3.8 Oracle Contracts Suite
Oracle Contracts Suite - made up of Oracle Contracts Core and Oracle Service 
Contracts - provides a complete range of contracts creation, service, organization, 
and termination. Oracle iSupport relies on the Contracts Suite to provide data about 
customer entitlements, service contracts, warranties, extended warranties, and 
response commitments. This data is retrieved by Oracle iSupport when customers 
view account information and create service requests. See the latest Oracle 
Contracts documentation available on OracleMetaLink for setup information.

3.3.8.1 Oracle Contracts Core
Oracle Contracts Core is both an application that provides supporting master 
agreements and a foundation for all other Oracle Contracts modules. The generic 
functionality required by all types of contracts is contained in the Oracle Contracts 
Dependency Requirements and Verification 3-5



Conditional Dependencies
Core foundation layer, such as contract access control, renewal, termination, and 
notification management. 

3.3.8.2 Oracle Service Contracts 
Oracle Service Contracts creates and manages service contracts, warranties and 
extended warranties; provides visibility to contract entitlements; and acts upon 
contractual commitments within the contract. Oracle Service Contracts builds upon 
the foundation of Oracle Contracts Core and adds functionality to meet the specific 
needs of the service industry, such as coverage terms and entitlement checking.

3.3.9 Oracle Customer Care
The Oracle Customer Care part of Oracle TeleService is composed of four modules:

■ Contact Center

■ Relationship Plans

■ Customer Profile/Dashboard

■ Critical Customer Management

These modules allow customer support agents to manage many aspects of support, 
including real-time interactions, information retrieval, customer creation, historical 
views, service request creation, knowledge base data retrieval, product 
management, and relationship plans.

Oracle Customer Care integrates with several ERP and CRM modules to support 
and extend its functionality. Setup information can be found in the Oracle TeleService 
Implementation Guide.

3.3.10 Oracle Knowledge Management
In Oracle iSupport, Oracle Knowledge Management allows knowledge base 
searches during service request creation, the display of frequently used solutions on 
the home page, and knowledge base searches from the Support tab. Setup 
information is in the chapter, Integrating Oracle iSupport with Oracle Knowledge 
Management.

3.3.11 Oracle Marketing Encyclopedia System
In Oracle iSupport, Oracle Marketing Encyclopedia System provides functionality 
for publishing information to the home page Alerts bin, displaying other optional 
home page content, and searching and browsing the technical library. Setup 
3-6 Oracle iSupport Implementation Guide



Conditional Dependencies
information can be found in the Oracle Marketing Encyclopedia System Implementation 
Guide.

3.3.12 Web Call-Back Dependencies
The Web Call-Back (Call Me) feature allows users to submit a call-back request 
through the Oracle iSupport user interface. The web call-back requires 
implementation of the Oracle Interaction Center suite of applications and the 
purchase of call center hardware. It also requires the implementation of Oracle 
Universal Work Queue, Oracle Customer Care, and Oracle CRM Foundation Notes 
module. For further information, see the Setting up iSupport Web Call-Back in the 
Implementation Tasks chapter.

3.3.13 Oracle Scripting
Oracle iSupport uses Oracle Scripting to provide Surveys functionality. Oracle 
Scripting also presents scripts to the desktop of an Interaction Center agent to aid 
customer service. For further information, see the Setting Up Oracle iSupport 
Surveys topic in the Implementation Tasks chapter.
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Implementation Overview

This chapter provides an overview of the implementation process for Oracle 
iSupport for Release 11i. 

Topics include:

■ Process Overview

■ Implementation Task Sequence

4.1 Process Overview
Oracle iSupport relies on other Oracle applications for its functionality. In order to 
successfully implement Oracle iSupport, you must set up its mandatory 
dependencies, and optionally, its conditional dependencies.

The tasks described in this guide assist your setup of Oracle iSupport, Release 11i. 
Many companies installing Oracle iSupport already are running some of the 
mandatory and/or conditional Oracle applications. For them, Oracle iSupport is an 
add-on or upgrade. Thus, depending upon your particular situation, you may or 
may not need to perform all of the tasks listed here.

4.2 Implementation Task Sequence
The following table, Oracle iSupport Implementation Steps, shows the 
recommended task sequence for setting up Oracle iSupport.
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Table 4–1 Oracle iSupport Implementation Steps

Step Required? Related Documentation

Install Oracle iSupport Yes Oracle iSupport Implementation Guide

Confirm General Oracle 
Applications Setups

Yes Oracle iSupport Implementation Guide, Preface

Perform System Administrator 
Setups for Oracle iSupport

Yes Oracle iSupport Implementation Guide

Oracle Applications System Administrator’s Guide

Setting Up Oracle Workflow Yes Oracle iSupport Implementation Guide, Chapter 10, Integrating 
Oracle iSupport with Oracle Workflow

Oracle Workflow User’s Guide

Oracle Workflow Web Services Guide

Oracle Workflow Client Installation Notes for Oracle Applications

Setting Up Oracle CRM 
Foundation

Yes Oracle Common Application Components Implementation Guide

Setting Up Oracle iSupport 
Users

Yes Oracle iSupport Implementation Guide, Chapter 5, Implementation 
Tasks

Setting Up Oracle iSupport 
Homepage

Yes Oracle iSupport Implementation Guide, Chapter 5, Implementation 
Tasks

Setting Up CRM User 
Management Framework

No Oracle Common Application Components Implementation Guide

Setting Up Service Request No Oracle iSupport Implementation Guide, Chapter 7, Integrating Oracle 
iSupport with Service Request

Oracle TeleService Implementation Guide

Setting Up Products and 
Returns

No Oracle iSupport Implementation Guide, Chapter 8, Integrating Oracle 
iSupport with Products and Returns

Setting Up Oracle Knowledge 
Management

No Oracle iSupport Implementation Guide, Chapter 9, Integrating Oracle 
iSupport with Oracle Knowledge Management

Setting Up Oracle iSupport 
Forums

No Oracle iSupport Implementation Guide, Chapter 5, Implementation 
Tasks

Setting Up Oracle iSupport 
Surveys/Feedback

No Oracle iSupport Implementation Guide, Chapter 5, Implementation 
Tasks

Setting Up Oracle iSupport 
Web Call-Back

No Oracle iSupport Implementation Guide, Chapter 5, Implementation 
Tasks
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Setting Up Oracle Contracts 
Applications

No Oracle iSupport Implementation Guide, Chapter 5, Implementation 
Tasks

Oracle Contracts Core Implementation Guide 

Oracle Service Contracts User Guide

Setting Up Oracle Customer 
Care

No Oracle TeleService Implementation Guide

Setting Up Page-Level Look 
and Feel

No Oracle iSupport Implementation Guide, Chapter 5, Implementation 
Tasks

Setting Up Custom Menus No Oracle iSupport Implementation Guide, Chapter 5, Implementation 
Tasks

Verify the Implementation No Oracle iSupport Implementation Guide, Chapter 6, Verifying the 
Implementation

Table 4–1 Oracle iSupport Implementation Steps

Step Required? Related Documentation
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Implementation Tasks

This topic group provides step-by-step implementation tasks for setting up Oracle 
iSupport Release 11i. Topics include:

■ Installing the Application

■ Confirming General Oracle Applications Setups

■ Performing System Administration Setups

■ Setting Up Oracle Workflow

■ Setting Up Oracle CRM Foundation

■ Setting Up Oracle iSupport Users

■ Setting Up Oracle iSupport Homepage

■ Setting Up Oracle CRM User Management Framework

■ Setting Up Service Request

■ Setting Up Products and Returns

■ Setting Up Knowledge Base Applications

■ Setting Up Oracle iSupport Forums

■ Setting Up Oracle iSupport Surveys

■ Setting Up Oracle iSupport Web Call-Back (Call Me)

■ Setting Up Oracle Contracts Applications

■ Setting Up Oracle Customer Care

■ Setting Up Page-Level Look and Feel

■ Setting Up Custom Menus
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Installing the Application
■ Verifying the Implementation

5.1 Installing the Application
Oracle strongly encourages all applications customers to install the latest 11i CD 
Pack or upgrade to the latest Maintenance Pack. The Maintenance Pack is a 
consolidation of product minipacks. Customers wishing to upgrade their 
applications may upgrade to this version by applying the Maintenance Pack. 

To obtain the Maintenance Pack, go to the OracleMetaLink home page and select 
Patches (left hand menu), enter the patch number in the Patch Number box, select 
your platform in the Platform box, and select the Submit button. 

Customers who are upgrading from an earlier version of applications (Release 10.7 
or Release 11 for example) or conducting a fresh installation of the applications 
should order the latest Release 11i CD Pack from Oracle Store 
(http://store.oracle.com).

As with any maintenance pack, you may need to apply additional individual 
product patches in order to bring your applications to the latest code. Please 
continue to check for high-priority patches for your product areas via the Patches 
button on the OracleMetaLink homepage. 

Oracle iSupport is available on the Oracle CD Pack and on OracleMetaLink 
(http://metalink.oracle.com). 

Please be sure to download the latest copy of the Release Notes, Installation Update 
Notes for your platform and RapidWiz prior to beginning your install or upgrade. 

5.1.1 Running Rapid Install
Rapid Install (RapidWiz) helps you install a complete set of Oracle Applications 
products at the latest available maintenance pack level. It installs the required 
technology stack and creates the Oracle Applications database. You can use Rapid 
Install to install any of three environments: a production installation, a test 
installation, and an installation of the Vision Demo database. In addition, Rapid 
Install lets you license products, country-specific functionality, and languages.
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Rapid Install stores the parameters you choose in a configuration file, and then uses 
that file as a road map to perform the installation or upgrade. It installs all 
necessary components, and then sets up your database listeners, web listener, web 
server, Forms server, and Reports server.

In a single-node installation, all servers (database, concurrent processing, forms, and 
web) are installed on a single node. This type of installation is generally used for 
smaller installations and for demonstration purposes. In a two-node installation, one 
node contains the database server, concurrent processing server, and reports server, 
and another node contains the forms server and the web server. A multi-node 
installation sets up any combination of servers you specify, on any number of 
nodes. This type of installation provides the most scalability. 

For more information on Rapid Install, see the latest version of Installing Oracle 
Applications and Upgrading Oracle Applications.

5.1.2 Using the Oracle Application Implementation Wizard
Use the Oracle Application Implementation Wizard (AIW) to coordinate 
dependency setups and identify the steps required to implement the Oracle 
iSupport. You can use AIW to see the graphical overview of the steps involved, read 
online help on set up and open the appropriate forms. You can also document your 
actions for further reference and review. 

The Wizard detects the products installed on your implementation site and displays 
all the processes you need to run in the correct order. You can locate specific 
processes and corresponding task assignments using a variety of flexible selection 
criteria. After you are in a task, you are automatically routed from step to step.

The processes guide you through the specific implementation steps required for 
your installation. The sequence of steps are contingent on which application 
modules you install. This structure reduces complexities introduced when you must 
implement multiple application modules that have the same setup steps.

Note: On the screens that tell RapidWiz where to store 
files/directories, do not press Ctrl + V (paste) with an empty 
clipboard. Be sure your clipboard has some data stored on it   
before pressing Ctrl + V, or you will receive an error, 
Java.lang.NullPointerException. (The command in Windows for 
copying text to the clipboard is Ctrl + C.)
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As you proceed through the implementation processes, you are able to document 
the completion of setup steps and append notes for later recall. Additionally, the 
Wizard provides guidance, such as instructions, options, warnings, and alerts to 
help with key decision making.

Refer to Oracle Application Implementation Wizard User’s Guide for more details.

5.2 Confirming General Oracle Applications Setups
Your setup steps for Oracle iSupport depend upon whether you are creating a fresh 
install of Oracle Applications or upgrading to the current release from a previous 
release. The steps in this section are confirming setups of applications that all Oracle 
applications depend upon. 

On OracleMetaLink, the Oracle Applications Installations and Upgrade Self-Service 
Toolkit page contains information on the top subjects for Oracle applications 
installations. You will find the latest patchset information in addition to the 
following:

■ Current Issues (alerts and selected articles) 

■ Patches (specific patches related to the subject) 

■ Setup and Usage (white papers and setup instructions for the subject) 

■ FAQ (Frequently Asked Questions) 

■ Troubleshooting (troubleshooting guide for the subject) 

After logging into OracleMetaLink (http://metalink.oracle.com), navigate to the 
Self-Service Toolkit page as follows: 

Technical Libraries > ERP Applications > Applications Installation and Upgrade. 

5.2.1 Confirming Oracle Trading Community Architecture Setup
Ensure the setup of the following in the model for the Oracle Trading Community 
Architecture:

■ Parties

■ Party Relationships

■ Locations

■ Contact Points

■ Customer Attributes
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Refer to current Trading Community Model documentation for additional details.

5.2.2 Confirming Accounts Receivable Setup
Confirm the setup of Oracle Accounts Receivable.

Refer to Oracle Accounts Receivable documentation, available on OracleMetaLink 
under Technical Library > Financials > Receivables.

5.2.3 Defining Employees
Define or confirm the definitions of your employees in Oracle Human Resources 
Management System or another HR application.

For Oracle Human Resources Management System documentation, refer to the 
following titles available on OracleMetaLink:

■ Implementing Oracle HRMS

■ Using Oracle HRMS - The Fundamentals

■ Managing People Using Oracle HRMS

■ Customizing, Reporting and System Administration in Oracle HRMS

■ Managing Total Compensation Using Oracle HRMS

5.2.4 Confirming Oracle Foundation Technology Stack Setup
Confirm the setup of the technology stack. Refer to Oracle Foundation Technology 
Stack documentation, available on OracleMetaLink. The Oracle Foundation 
Technology stack is also known as the HTML Stack or the Tech Stack.

5.3 Performing System Administration Setups
The merchant implementing Oracle iSupport receives a system administrator login 
and uses that login in the setup of the application. The system administrator 
username and password that are seeded are: sysadmin/sysadmin. It is 
recommended that you change this password to something unique.

Some of the setups listed here are optional. Refer to the text for details.
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5.3.1 Confirm Menus/Functions Setup
The menus on the Oracle iSupport HTML UI are seeded in AOL. They are linked to 
the seeded Functions in AOL. It is optional to confirm the setup of menus and 
functions. 

For a list of seeded menus and functions in Oracle iSupport, see the appendix, 
Oracle iSupport Seed Data.

5.3.1.1 Confirm Functions
Functions link to coding within specific JSPs and to application menus. Those 
necessary for Oracle iSupport are seeded in AOL. To view Functions in AOL, log 
into the Oracle Forms application as sysadmin and navigate to System 
Administrator > Application > Function. From there, query for function names that 
begin with IBU_.

5.3.1.2 Confirm iSupport Menus
Each menu in Oracle iSupport links to a Function. Confirming Menus is not 
mandatory. To view Menus in AOL, log into the Oracle Forms application as 
sysadmin and navigate to System Administrator > Application > Menus. From 
there, query for menu names that begin with IBU_.

For additional information, see the Oracle Applications System Administrator’s Guide.

5.3.2 Understanding Responsibilities and Roles
Responsibilities are defined for application security and determine which menus a 
user will see. Roles are collections of permissions which allow users to perform 
various functions. Roles and responsibilities must be assigned to usernames to be 
effective. 

If you are using the CRM User Management Framework for user setup, 
responsibilities and roles are seeded within each User Type. As each user is 
approved, the default roles and responsibilities that are assigned will depend upon 
your setup of the user framework. Refer to the CRM Technology Foundation 
Implementation Guide for more information on what is seeded by user type, and how 
to customize user types. 

The Oracle iSupport module has its own seeded responsibilities and roles that you 
can use in addition to or in place of the user framework. Setup steps for creating 
users are in the Setting Up Oracle iSupport Users section. Refer to the Seed Data 
appendix for Oracle iSupport roles and responsibilities that ship with the 
application.
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Refer to AOL documentation for information on how to set up new responsibilities, 
roles, and permissions, or to customize existing ones.

5.3.3 Set Up Profile Options
Profile options are seeded within all Oracle applications, and each module has its 
own specific set of profile options. Although all profile options are seeded, there are 
some settings that must be performed by sysadmin. See the appendix, Profile 
Options, for details.

5.3.4 Set Up Properties
There are two sets of key components for Oracle iSupport that must be set. These 
are:

■ Company key components

■ Quick Find window key components 

Steps
1. Log in to the JTF user interface as sysadmin/sysadmin.

2. Navigate to Settings > System > Advanced. Select Oracle iSupport’s product 
code, IBU, from the View drop list.

3. Set the following company key components to appropriate values: 

■ COMPANY_ADDRESS

■ COMPANY_EMAIL ADDRESS

■ COMPANY MERCHANT_NAME

■ COMPANY_NAME

■ COMPANY_URL

4. To confirm the set up the Quick Find window items, verify that the following 
values are set: 

■ oracle.apps.ibu.requests.bean.RequestSearchFactory

■ oracle.apps.ibu.knowledge.bean.TechLibSearchFactory

■ oracle.apps.ibu.communities.bean.MyForumSearchFactory

■ oracle.apps.csi.qk.CsiqkInstanceFactory
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■ oracle.apps.cs.knowledge.bean.SolutionSearchFactory

■ oracle.apps.cs.knowledge.bean.SolutionCategorySearchFactory

5. Next, verify that the Quick Find window key components are set according to 
what your business processes require. Remove any items that you do not wish 
to use

■ When deleting items, be sure to remove the pairs of items that end in 
.categories and .desc.

Here is an example of what the seeded components will be:

Install Base:

■ service.oracle.apps.cs.inquiries.bean.IBSearchFactory.categories

The value of this component is Install Base.

■ service.oracle.apps.cs.inquiries.bean.IBSearchFactory.desc

The value of this component is IBSearch.item.

Forums:

■ service.oracle.apps.ibu.communities.bean.MyForumSearchFactory.categories

The value of this component is Forums.

■ service.oracle.apps.ibu.communities.bean.MyForumSearchFactory.desc

The value of this component is MyForumSearch.item.

Knowledge Management:

■ service.oracle.apps.ibu.knowledge.bean.SMSSearchFactory.categories

The value of this component is Solutions.

■ service.oracle.apps.ibu.knowledge.bean.SMSSearchFactory.desc

The value of this component is SMSSearch.item.

Marketing Encyclopedia System (MES):

■ service.oracle.apps.ibu.knowledge.bean.TechLibSearchFactory.categories

The value of this component is Library.

■ service.oracle.apps.ibu.knowledge.bean.TechLibSearchFactory.desc

The value of this component is TechLibSearch.item.

Service Request:
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■ service.oracle.apps.ibu.knowledge.bean.RequestSearchFactory.categories

The value of this component is Service Requests;

■ service.oracle.apps.ibu.knowledge.bean.RequestSearchFactory.desc

The value of this component is RequestSearch.item.

5.4 Setting Up Oracle Workflow
See the chapter in this guide, Integrating Oracle iSupport with Oracle Workflow, or refer 
to Oracle Workflow Guide.

5.5 Setting Up CRM Foundation
Set up and/or confirm the setup of the CRM Foundation software suite. Oracle 
iSupport service request functionality uses the Notes, Resources, and Assignment 
Manager modules. Oracle Knowledge Management functionality also uses Notes 
and Resources. Thus, at a minimum, you should be familiar with the setup and 
functionality of Notes, Resources, and Assignment Manager. For information on the 
Oracle iSupport-specific setups related to these modules, see these chapters:

■ Integrating Oracle iSupport with Service Request

■ Integrating Oracle iSupport with Oracle Knowledge Management 

Refer to Oracle Applications CRM System Administrator’s Guide and Oracle Common 
Application Components Implementation Guide for full implementation details.

5.6 Setting Up Oracle iSupport Users
Oracle iSupport uses the Oracle CRM User Management Framework. Because 
Oracle iSupport also has its own user responsibilities and roles, this section contains 
information on setting up Oracle iSupport users exclusive of the new framework. 
See Setting up Oracle CRM User Management Framework for more information on 
its functionality.

5.6.1 Setting Up Oracle iSupport Administrator
The merchant implementing Oracle iSupport uses the sysadmin login to set up the 
Oracle iSupport Administrator. This is a required user and is not one of the seeded 
user types within the CRM User Management Framework. 
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The Oracle iSupport Administrator responsibility, iSupport System Administrator, 
is seeded in AOL. This responsibility has the responsibility key IBU_SYS_ADMIN.

The menu assigned to this responsibility is called iSupport Administration Root 
(IBU_SYS_ADMIN_TOP_MENU). See Oracle Applications System Administrator’s 
Guide for more information on building menus and creating responsibilities.

The Oracle iSupport Administrator typically performs routine but high-level 
administrative tasks, such as:

■ Setting up users and assigning appropriate roles and responsibilities

■ Setting up the application homepage

■ Setting up optional service request functionality

■ Setting up optional products and returns modules

■ Setting up optional knowledge management modules

■ Setting up optional accounts functionality

■ Setting up iSupport forums

■ Setting up iSupport Call Me (web call-back)

■ Setting up iSupport Surveys/Feedback feature

Oracle iSupport Administrator functions are accessible by using the Oracle iSupport 
Administrator username and password on the JTF login page, and then selecting 
the Administration button in the top-right of the window.

5.6.1.1 Steps to Set Up Oracle iSupport Administrator
Follow the steps below to set up the Oracle iSupport Administrator.

Prerequisite:
Employees have been defined using Oracle Human Resources Management System 
or another human resources application. For Oracle HRMS documentation, refer to 
the following titles available on OracleMetaLink:

■ Implementing Oracle HRMS

■ Using Oracle HRMS - The Fundamentals

■ Managing People Using Oracle HRMS

■ Customizing, Reporting and System Administration in Oracle HRMS

■ Managing Total Compensation Using Oracle HRMS
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Associate User Name with Employee and Assign Responsibility
1. Log in to the Oracle Forms application as sysadmin. Select System 

Administrator responsibility. Navigate to Security > Users > Define. The Users 
window opens.

2. In the Users window, enter the username for the Oracle iSupport 
Administrator. An example is IBUADMIN. (IBU is the product code for Oracle 
iSupport.)

3. Associate the user with an employee by using the Person LOV in the User 
Form. Select the desired association by double-clicking on the employee name.

4. Tab to Password field and enter a password. Tab to clear the field and re-enter 
the same password to validate.

5. In the Responsibilities tab, select the IBU_SYS_ADMIN responsibility. 

6. Save changes.

7. Still using System Administrator responsibility, navigate to Profile > System. 

8. Query with the username in the username field and JTF%DEF% in the Profile 
field.

9. Set the following profile option at the user level for the administrator:

■ JTF_PROFILE_DEFAULT_APPLICATION - 672

This tells the system that the default application for this user is Oracle iSupport, 
whose application ID is 672.

10. Find the responsibility ID for the IBU_SYS_ADMIN responsibility (see steps 
below) and enter that value as the JTF_PROFILE_DEFAULT_RESPONSIBILITY 
value. Set at user level. 

This tells the system that the default responsibility for this user is IBU_SYS_
ADMIN.

5.6.1.2 Finding Responsibility ID
Use the following steps to find the RESPONSIBILITY_ID value of a 
responsibility. See the Profile Options appendix for details on determining 
APPLICATION_ID values -- The application ID is used when setting system 
profile values.

a. In Oracle Forms as System Administrator, navigate to Security > 
Responsibility > Define. The Responsibilities window opens.
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b. From the top menu, select View > Find. Search for the IBU_SYS_ADMIN 
responsibility. After this is found, highlight the responsibility, and select Ok 
in the search window. The Responsibilities window is populated with the 
information for the responsibility.

c. With the cursor in any field of the record, select Help > Diagnostics > 
Examine. The Examine Field and Variable Values window opens.

d. In the Examine Field and Variable Values window, select 
RESPONSIBILITY_ID from the Field LOV. The Value field displays the 
value of RESPONSIBILITY_ID.

11. Save and close the window.

Assign Role(s)
1. Navigate to Users > Registration > User Maintenance.

2. Find the user who will be the Oracle iSupport Administrator. Select the 
underlined hyperlink of the username. 

3. Select Roles. Assign IBU_SYSTEM_ADMIN and IBU_REG_USER to the user.

4. Select Update.

5. Log out.

Verification
1. Log in to the JTF login as the Oracle iSupport Administrator just created.

2. Verify that appropriate menus are displayed. The Oracle iSupport 
Administrator has the following main tabs on the UI: 

■ Home

■ Support (subtabs: Ask Me, Technical Library, Forum, View/Update 
Requests, and Create Request.)

3. Under Profile, the Oracle iSupport Administrator has access to the following 
links:

■ Personal Profile

■ Contact Points

■ Addresses

■ Navigation Preferences

■ Display Preferences
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■ Accounts

■ Support

■ My Enrollments

■ A section for Company Information.

4. Select the Administration button at the top of the window. Verify that the 
Oracle iSupport Administrator can access the following administrator tabs:

■ User (subtabs: User, Pending Approvals)

■ Homepage (subtabs: Content, Subscription)

■ Support (subtabs: Request Management, Call Me, Survey, Technical Library, 
Usergroup)

■ Forum (subtabs: Category, Forum, Messages, User Group)

■ Solutions (subtabs: Setup, Solution, Search)

■ MES

5.6.2 Steps to Assign Additional Roles and Responsibilities
After you have set up the Oracle iSupport Administrator, you can use that user to 
assign additional responsibilities and/or roles to users. 

Remember, as a CRM User Management Framework User Type is approved, the 
system automatically gives those users a default role(s) and a default responsibility. 
Which roles and responsibilities are granted depends upon how you have 
configured the user management framework, including what roles and 
responsibilities are linked to the User Type and Enrollment selected during 
registration. 

If you are creating custom users or if you need to assign additional responsibilities 
or roles to users, then use the following steps:

1. Log into Oracle iSupport as the Oracle iSupport Administrator.

2. Navigate to Administration > Users. Search for the user whom you wish to 
modify.

3. Select the underlined link of the username.

4. In the Personal Profile window, select either Roles or Responsibilities as 
appropriate.
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5. Assign the roles/responsibilities as desired. If you assign additional 
responsibilities, then be sure to select a default responsibility.

5.6.3 Setting Up an Oracle iSupport Primary User
The Oracle iSupport Primary User typically:

■ Approves other users within his party/organization

■ Adds/modifies responsibilities to users within his party/organization

■ Adds/modifies roles to users within his party/organization

The primary user can be approved by another primary user with the same 
responsibility as that of an Oracle iSupport Primary User for the party 
(organization) to which the primary user belongs, or by the Oracle iSupport 
Administrator.

Steps to Set Up an Oracle iSupport Primary User
Follow the steps below to set up the Oracle iSupport Primary User.

Registration
1. Select the Register Here link on the JTF login. Or, have the user self-register 

using the Register Here link.

Note: If you have already set up this user through the Oracle Forms interface, 
Oracle Human Resources Management System (HRMS), or your company’s 
own HR application, then you may skip the Registration step. Instead, associate 
an employee with a user name in the Forms application (as you did with the 
administrator-user), and assign the iSupport Primary User responsibility there. 
This has the responsibility key IBU_PRIMARY_USER_RESP.

2. Select Primary User as the user type; select Next.

3. Enter the company ID in the textbox and Submit. The company ID is a unique 
number assigned during company registration. The User Registration window 
appears. 

Note: The default responsibility that is active at the time a user 
logs in to the JTF login determines which application he initially 
accesses. The user can change this default by accessing the Profile > 
Preferences menu in Oracle iSupport.
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4. Enter required information on the User Registration window. Make a note of the 
username and password. Select Submit. The Available Enrollments window 
appears.

5. Select Self-Service Support Over the Web and select Next. 

Note: The Enrollments window brings in the CRM User Management 
Framework. The default roles and responsibilities linked to the Self-Service 
Support Over the Web enrollment will be assigned to this user upon approval. 
See the topic, Seeded Self-Service Support Over the Web Enrollment, for default 
roles and responsibilities that are seeded by user type for this enrollment.

6. A confirmation message appears. Select Next. 

Approval
1. Log in to the JTF login page as sysadmin. 

Note: It is possible to set up a user other than sysadmin to be the approver. 
Consult the Oracle CRM Technology Foundation Implementation Guide and the 
Oracle CRM Technology Foundation Concepts and Procedures for details.

2. Navigate to Users > Registration > Pending Approvals. 

3. In the Request Summary window, select the appropriate underlined username.

4. Fill in the mandatory information. Select Next.

5. Select the Accounts button. Choose the company account(s) to associate with 
the user. Select Next.

6. Enter any comments in the Comments area. Select Accept.

Verification
1. At the JTF login page, log in as the Primary User just created.

2. Verify that appropriate menus are displayed. The Primary User has access to the 
following main tabs on the UI: 

■ Home

■ Accounts (subtabs: Orders, Invoices, Payments, Contracts, Returns, 
Products)

■ Support (subtabs: Ask Me, Technical Library, Forum, View/Update 
Requests, Create Request)

3. Under the Profile button, the Primary User has access to the following links:
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User Profile:

■ Personal Profile

■ Contact Points

■ Addresses

■ Navigation Preferences

■ Display Preferences

■ Accounts

■ Support

■ My Enrollments

Company Profile:

■ Information

■ Contact Points

■ Addresses

■ Administrators

4. Select the Administration button at the top of the window. Verify that the 
Primary User can access the following administrator tabs:

■ User

■ Pending Approvals

5.6.4 Setting Up Employee User
This type of user is an employee of the merchant using Oracle iSupport. This user is 
set up through the Forms interface and approved by the Oracle iSupport 
Administrator or the Primary User for the Employee User’s organization.

5.6.4.1 Steps to Set Up Employee User
Follow the steps below to set up this user.

Prerequisite:
Employees have been defined using Oracle Human Resources Management System 
or another HR application. For Oracle HRMS documentation, refer to the following 
titles available on OracleMetaLink:
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■ Implementing Oracle HRMS

■ Using Oracle HRMS - The Fundamentals

■ Managing People Using Oracle HRMS

■ Customizing, Reporting and System Administration in Oracle HRMS

■ Managing Total Compensation Using Oracle HRMS

Steps
1. Log into Oracle Forms application as sysadmin. Select System Administrator 

responsibility.

2. Navigate to Security > User > Define. The Users window appears.

3. Enter a Username for the user. For example, you could use the first initial and 
last name of the employee.

4. On the User window, associate the new username with an employee: Click in 
the Person field on the User window. Search for the employee by clicking on the 
LOV field [...}, entering a partial value and clicking Find. Select the employee by 
double-clicking the employee name.

5. In the Password field, enter a password for the username. Use the Tab key to 
clear the Password field, and then re-enter the password to validate.

6. If desired, limit the number of days this password will be valid by entering a 
value in days in either the Accesses or Days fields. The user will be prompted to 
change this password after x number of days/accesses, where x represents the 
value that you entered in the Days field or Accesses field. If you select None, 
the user will not be required to change the password.

7. In the Responsibility tab, click in the Responsibility field. Select the LOV {...} 
that appears, and enter IBU% to query for IBU responsibilities.

8. Double-click the IBU_EMPLOYEE_USER_RESP responsibility key.

9. Under Effective Dates, enter an the effective date in the From field. If desired, 
enter an end-date for the user in the To field. Leave the To field blank to create 
the user with no end-date.

10. Save and close the window.

Assign Role(s) and Default Responsibility
1. Log in to the JTF login page as Oracle iSupport Administrator. Navigate to 

Administration > User.
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2. Search for the user. After you find the user, select the underlined hyperlink of 
the username. The Personal Profile page appears.

3. Select Roles. Assign IBU_REG_USER and IBU_EMPLOYEE to the employee.

4. Save your work.

5. Return to the Personal Profile page. Select Responsibilities and assign iSupport 
Employee User as the default responsibility for this user. This responsibility has 
the key IBU_EMPLOYEE_USER_RESP. 

6. Save your work.

Verification
1. At the JTF login page, log in as the user just created.

2. Verify that appropriate menus are displayed. The Employee User has the 
following main tabs on the UI: 

■ Home

■ Support (subtabs: Ask Me, Technical Library, Forum, View/Update 
Requests, and Create Request.)

3. Under the Profile button, the Employee User has access to the following links:

User Profile:

■ Personal Profile

■ Contact Points

■ Addresses

■ Navigation Preferences

■ Display Preferences

■ Support

Note: When setting up new users of the Install Base functionality, 
please add the role, CSI_END_USER, to them. This role contains 
the required permissions for Oracle Install Base general users.
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5.6.5 Setting Up Business (B2B) User
B2B (business users) are generally customers who have accounts on the merchant 
and are not associated with the merchant’s company. These users select the Register 
Here link on the JTF login page to register. 

5.6.5.1 Steps to Set Up B2B User
Follow the steps below to set up this user.

Registration
1. Select the Register Here link on the JTF login. Or, have the user self-register 

using the Register Here link.

2. Select Business User from the list of User Types. Select Next.

3. Enter the company ID in the textbox and Submit. The company ID is a unique 
number assigned during company registration. 

4. Enter required information on the User Registration window. Make a note of the 
username and password. Select Next. The Available Enrollments window appears.

5. In the Enrollments window, select Self-Service Support Over the Web and select 
Next. A confirmation message appears. Select Next.

Approval
1. Log in to the JTF login page as sysadmin. Navigate to Users > Registration > 

Pending Approvals. 

2. In the Request Summary window, select the appropriate underlined username.

3. Fill in the mandatory information. Select Next.

4. Select the Accounts button. Choose the company account(s) to associate with 
the user. Select Next.

5. Enter any comments in the Comments area. Select Accept.

Note: When setting up new users of the Oracle Install Base 
functionality, add the role CSI_END_USER to them. This role 
contains the required permissions for Oracle Install Base general 
users.
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Verification
1. At the JTF login page, log in as the user just created.

2. Verify that appropriate menus are displayed. The B2B User will have the 
following main tabs on the UI: 

■ Home

■ Accounts (subtabs: Orders, Invoices, Payments, Contracts, Returns, 
Products)

■ Support (subtabs: Ask Me, Technical Library, Forum, View/Update 
Requests, Create Request)

3. Under the Profile button, the B2B User has access to the following links:

User Profile:

■ Personal Profile

■ Contact Points

■ Addresses

■ Navigation Preferences

■ Display Preferences

■ Accounts

■ Support

■ My Enrollments

Company Profile:

■ Information

■ Contact Points

■ Addresses

■ Administrators

5.6.6 Setting Up Individual (B2C) User
The B2C (individual users) is typically an individual person with no relationship to 
the organization using Oracle iSupport. B2C users will normally be self-registering 
over the Internet, using the Register Here link on the JTF login page.
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A B2C user’s seeded approval process in the CRM User Management Framework is 
automatic. B2C users thus can access the application immediately after registering, 
unless you set up a separate approval process. Consult the Oracle Common 
Application Components Implementation Guide for more details.

5.6.6.1 Steps to Set Up B2C User
Follow the steps below to set up this user.

Registration
1. Select the Register Here link on the JTF login. In the list of available user types, 

select Individual User. Select Next.

2. Enter required information on the User Registration window. Make a note of the 
username and password. Select Submit. The Available Enrollments window 
appears.

3. Select Self-Service Support Over the Web and select Next. A confirmation 
message appears. 

Verification
1. At the JTF login page, log in as the user just created.

2. Verify that appropriate menus are displayed. The B2C User has the following 
main tabs on the UI: 

■ Home

■ Accounts (subtabs: Orders, Invoices, Payments, Contracts, Returns, 
Products)

■ Support (subtabs: Ask Me, Technical Library, Forum, View/Update 
Requests, Create Request)

3. Under the Profile button, the Employee User has access to the following links:

User Profile:

■ Personal Profile

■ Contact Points

■ Addresses

■ Navigation Preferences

■ Display Preferences
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■ Accounts

■ Support

■ My Enrollments

5.6.7 Setting Up Knowledge Management Administrator-User
This is an administrator-user who performs Oracle Knowledge Management setup 
and management. This user is required only if a merchant uses the Knowledge 
Management functionality. Often the Oracle iSupport Administrator is set up to 
perfrom this function. For more information, see the Oracle Knowledge Management 
Implementation Guide.

5.6.8 Setting Up Survey Administrator-User
This is a user who performs Surveys setup and management. This User Type is not 
seeded in the JTT user management framework. This user is required only if a 
merchant uses Surveys. For more information, see the Setting Up iSupport Surveys 
topic of this chapter.

5.6.9 Setting Up Guest User
A guest user is one who comes to the Oracle iSupport site and does not log in 
explicitly. Use this procedure to set up a guest user.

Steps
1. Create the fnd user.

2. Create any parties and accounts that must be linked to this user.

3. Set the appropriate value in the profile option iSupport Guest Responsibility, 
whose default value is iSupport Guest Responsibility.

4. Set the appropriate value in the profile option iSupport Guest Quick Find 
Display, whose default value is N. If you decide to display the Quick Find menu 
to guest users, then also set up the appropriate search categories that can be 
displayed to guest users. Refer to the Oracle JTT Developer's Guide for 
instructions.

5. Set the appropriate value for the guest user in the profile option JTF_
DEFAULT_RESPONSIBILITY.
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6. Assign the proper role to the guest user. The role IBU_GUEST is shipped out of 
the box.

7. Set the JTT property for guest_username, and guest_password.

8. Set up the guest user group. The required SQL is the following:

select party_id from hz_parties where party_id in ( Select customer_id from 
fnd_user where user_name in (select upper(b.attribute_value) from jtf_perz_
data a, jtf_perz_data_attrib b where a.perz_data_type ='JTF' and a.perz_
data_name = 'guest_username' and a.perz_data_id = b.perz_data_id))

9. Run the concurrent program IBU_PRODUCT_UUGCP to populate the user 
group users.

10. If you want to hide certain categories from the Quick Find drop down, then set 
up the categories in the JTT system administrator console.

11. Hide the Logout button by creating the property in the JTT system console 
under iSupport. By default this is set up for IBU_GUEST_USER_RESP. If you up 
a different responsibility for the guest user, then set this up manually:

Ui.nav.logout.disabled.resp.<resp key> = true;

12. If you want to use the home page,ibuhpage.jsp, as the login page for normal 
registered users, then modify the JTT property to set the .logout.page property 
to point to this JSP, and set this URL to be used to access Oracle iSupport. 
Otherwise, inform guest users of a special URL to use for guest user access.

13. Do not expose any functionality to guest users that have not been guest 
enabled.

14. If you do not want to expose all guest-enabled pages to guest users, then 
explicitly remove the corresponding permissions from the guest user role.

15. Optionally customize the message IBU_G_LOG_NOTE. This message is 
displayed to guest users, if the guest user feature is enabled, on the right hand 
side of Oracle iSupport pages. If you do not want to display the message, then 
set this message to "null."

Note: Oracle iSupport uses same guest user that Oracle iStore 
uses. If Oracle iStore is being used, then you do not need to create a 
guest user, but you still need to do the other setups.
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5.7 Setting Up Oracle iSupport Homepage
The Homepage is a work page and the application landing page for the user. Here, 
users can store service request and knowledge base bookmarks, as well as receive 
system alerts and other data that the merchant chooses to display. Options for 
Homepage setup include:

■ Use default settings shipped with the application (some basic setups are 
required).

■ Add bins from a pre-defined selection that ships with the application.

■ Add content from Oracle Marketing Encyclopedia System.

■ Disable content.

■ Make content a required item (mandatory) on UI.

■ Change display of mandatory content on UI.

The sections that follow discuss Homepage options.

5.7.1 Add Oracle Marketing Encyclopedia System Content to Homepage
Oracle Marketing Encyclopedia System can supply the functionality to provide bin 
content on the Homepage. Examples include Alerts and Company News bins. You 
can also publish other types of information in Oracle Marketing Encyclopedia 
System and select it as Homepage content in Oracle iSupport. 

Prerequisites
■ Set up Oracle Marketing Encyclopedia System.

■ Publish content within Oracle Marketing Encyclopedia System.

■ Verify Oracle Marketing Encyclopedia System setup.

See Oracle Marketing Encyclopedia System Implementation Guide and Oracle Marketing 
Encyclopedia System Concepts and Procedures for details.

Steps
1. Log in to the JTF login window as the Oracle iSupport Administrator.

2. Navigate to Administration > Homepage > Content > Add MES Content 
(bottom of window).
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3. In the Add MES Content window, the content you have published in Oracle 
Marketing Encyclopedia System appears. Select the content that you wish to 
add by selecting the appropriate checkbox. 

4. Select Save. The Content Administration window appears.

5. Navigate to the Home tab on the general user UI to verify that the content 
appears on the page.

5.7.2 Understanding the Add/Update Content Page
The Add/Update Content page allows you to:

■ Set content as mandatory.

■ Disable existing content.

5.7.2.1 Setting Homepage Content as Mandatory
You can set information on the homepage as mandatory. Mandatory content has the 
following characteristics:

■ Cannot be disabled by users.

■ Always appears at the top of the column that it is in.

■ Can be displayed as wide-format or narrow-format.

Follow the steps below to change content to mandatory and choose its layout.

Steps
1. Log in to the JTF login window as the Oracle iSupport Administrator.

2. Navigate to Administration > Homepage > Content. The Content 
Administration window appears.

3. Select the underlined hyperlink of the content you wish to make mandatory. 
The Update Content window appears.

4. In the Update Content window, select the Mandatory checkbox.

5. Select Update.

5.7.2.2 Disabling Homepage Content
Follow the steps below to disable homepage content and make it inaccessible to all 
but the Oracle iSupport Administrator.
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Steps
1. Log in to the JTF login window as the Oracle iSupport Administrator.

2. Navigate to Administration > Homepage > Content. The Content 
Administration window appears.

3. Select the underlined hyperlink of the content you wish to disable. The Update 
Content window appears.

4. In the Update Content window, select the Disable checkbox.

5. Select Update.

5.7.3 Changing Mandatory Bin Layout/Display
If you have more than one mandatory homepage content item and wish to change 
the order of the bins, follow the steps below to do so.

Steps
1. Log in to the JTF login window as the Oracle iSupport Administrator.

2. Navigate to Administration > Homepage > Content > Mandatory Layout.

3. Select and arrange content as desired, using the right (>) and left (<) arrow 
buttons to move content from two to three column layout. 

4. To arrange content vertically in a column, select content and select the up or 
down arrow buttons to set the order.

5. Select Update to save changes.

5.7.4 Enabling Homepage Subscription E-Mails
The Subscription E-Mails feature of Oracle iSupport allows users to receive 
Homepage content in e-mail window. This can be useful if a user is unable to access 
the Homepage for a period of time. Set up of this feature includes: 

■ Set up template.

■ Run necessary concurrent programs.

Prerequisites
■ The e-mail subscription feature must be activated for the user who is to receive 

the e-mails. Navigate to Profile > Support; select content and delivery days as 
desired.
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■ You must be running Oracle Workflow to enable this feature. For more 
information, refer to the chapter in this guide, Integrating Oracle iSupport with 
Oracle Workflow.

5.7.4.1 Setting Up E-Mail Subscription Templates
Setting up the e-mail template allows you to control the framework for the e-mail 
that is delivered to a user. 

Steps
1. Log in to the JTF login as Oracle iSupport Administrator.

2. Navigate to Administration > Homepage > Subscription. The Subscription 
Template Administration window appears.

3. In the Subject text field, enter the text to display as the subject of the e-mail that 
will be sent to the user.

4. In the Header and Footer fields, enter the information you wish to display in 
the header (top) and/or footer (bottom) area of the template. 

Use the Clue Word/Description table (copy and paste as desired) at the bottom 
of the window to build the header and footer text. 

5. Optionally, select Preview to see how the framework will appear to the user.

6. To save changes, select Update. A confirmation message appears.

5.7.4.2 Running Concurrent Programs
In Oracle (Forms) Applications, run the Notification Mailer and IBU_PRODUCT_
EMGEN concurrent programs. See Oracle Applications Concepts Release 11i for more 
information on running concurrent programs. For more information on Oracle 
Workflow, see the chapter in this guide, Integrating Oracle iSupport with Oracle 
Workflow. Also consult the Oracle Workflow User’s Guide. 

5.8 Setting Up CRM User Management Framework
The Oracle CRM User Management Framework consists of enrollments 
(subscription services), approval processes, registration templates, and user types. 
These components provide a flexible framework for user creation, approval, 
management, and information gathering.
Implementation Tasks 5-27



Setting Up CRM User Management Framework
The user management framework is an optional but recommended integration for 
your organization. While the framework will be installed automatically when you 
install CRM Foundation modules, there are some setups you will need to perform. 

The information in this section is meant to give you an overview of the user 
management framework concepts. Consult the Oracle Common Application 
Components Implementation Guide and the Oracle Common Application Components 
User’s Guide for more details.

5.8.1 Setting Up Enrollments (Subscription Services)
Enrollments are application-specific subscription services at the user level. They 
reference the registration templates, roles, and responsibilities that are tied to user 
types. Enrollments are of two basic types:

■ Implicit - Implicit enrollments are services that the user receives automatically 
during the registration process. 

■ Explicit - Explicit enrollments are services that users select during registration 
following their selection of user type.

One enrollment can equal: 

■ 0 or 1 responsibility - You can link no more than one responsibility to an 
enrollment.

■ 0 or 1 template - You can link no more than one registration template to an 
enrollment.

■ 0 or 1 workflow - You can link no more than one workflow process to an 
enrollment.

■ 0 or more roles - You can link any number of roles to an enrollment.

5.8.1.1 Seeded Self-Service Support Over the Web Enrollment
The enrollment tied to Oracle iSupport is called the Self-Service Support Over the 
Web Enrollment. It is seeded within the CRM User Management Framework.

The table below, Self-Service Support Over the Web Enrollment Responsibilities, 
lists seeded responsibilities and corresponding Oracle iSupport user types for the 
Self-Service Support Over the Web Enrollment. 
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The table below, Self-Service Support Over the Web Enrollment Roles, lists seeded 
roles and corresponding Oracle iSupport user types for the Self-Service Support 
Over the Web Enrollment.

5.8.1.2 Modifying Seeded Enrollments
The seeded enrollments can be modified, and you can also create new enrollments. 
Consult the Oracle CRM Technology Foundation Implementation Guide and the Oracle 
CRM Technology Foundation Concepts and Procedures for details.

5.8.2 Setting Up Registration Templates
Applications require different pieces of information to register various user types. 
Registration of a sales representative might require the sales territory, while a 
consumer registration would need to include the credit card number. Registration 
data is being stored in different tables - some is common data and is stored (mostly) 
in the Trading Community Architecture (TCA); the rest is stored into 
application-specific tables. 

Registration templates, which can be one JSP or multiple pages, accommodate these 
information-gathering requirements. The registration pages rendered to a user will 
depend on the user type and the services/enrollments the user is subscribing to. 
Registration templates refer to JSP files that are used to capture the registration 
information that is particular to a User Type.

Characteristics of registration templates include:

Table 5–1 Self-Service Support Over the Web Enrollment Responsibilities

Responsibility Description

IBU_INDIVIDUAL USER_RESP Individual User (B2C)

IBU_PRIMARY_USER_RESP Primary User

IBU_BUSINESS_USER_RESP Business User (B2B)

Table 5–2 Self-Service Support Over the Web Enrollment Roles

Role Description

IBU_REG_USER Individual User (B2C) or Business 
User (B2B)

IBU_B2B_PRIMARY_USER_
MANAGEMENT and IBU_REG_USER

Primary User
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■ JSPs associated with a template handler to execute the logic on data captured 
through JSP pages

■ Can be tied to enrollments

■ Are set up by the application administrator during implementation

■ Can consist of one page or many

5.8.2.1 Defining New Registration Templates
New registration templates can be created using the JTF sysadmin console. Consult 
the Oracle Common Application Components Implementation Guide and the Oracle 
Common Application Components User’s Guide for details.

5.8.3 Setting Up Approval Processes
Approval is a step in the registration process whereby users and/or their 
enrollments are confirmed by an approving authority. After the approval process is 
completed, the system automatically grants the appropriate default role(s) and 
responsibility (based on User Type and/or Enrollments) that allow access to the 
application.

The approval process uses Oracle Workflow to track and route the request (via an 
e-mail message) to each approver set up in the approval definition. The e-mail 
informs the approvers of the request type (user type or enrollment) and what action 
is required.

5.8.3.1 Seeded JTF Approval Processes
User Type seeded approval processes are:

■ Individual User - No approval required

■ Business User - Approval notification sent to Primary User(s)

■ Primary User - Approval notification sent to Oracle iSupport Administrator, or 
System Administrator

5.8.3.2 Who Can Be an Approver?
■ Request Owner - This user is the current approver based on the approver list 

and current state of workflow defined for given approval. The Request Owner 
will only be able to approve the requests that are owned by him. This user 
should have JTF_APPROVER permission.
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■ Oracle Applications System Administrator (sysadmin) - The sysadmin will see 
and be able to approve all pending requests. Users who have the JTF_REG_
APPROVAL permission are considered sysadmins. The Oracle iSupport 
Administrator role (IBU_SYSTEM_ADMIN) has the JTF_REG_APPROVAL 
permission.

■ Oracle iSupport Administrator - The Oracle iSupport Administrator sees a list 
of pending approvals. Users who have the IBU_SYSTEM_ADMIN role are 
considered to be the Oracle iSupport Administrator.

For primary users to see the list of pending approvals in their company, the 
administrator must do the following setup:

a. Create a dummy user JTA_DUMMY through the fnd_user window.

b. Assign CRM_PRIMARY_USER responsibility to this user.

c. Assign the JTF_APPROVER role to this user.

d. Set this user to be the value of the JTF_PRIMARY_USER profile option.

■ Primary User - This user can view and approve the requests that are assigned to 
the Primary User role, as well as the requests owned by the Primary User. The 
requests assigned to the Primary User role are filtered based on the current 
approver’s organization. Primary Users need the JTF_PRIMARY_USER_
SUMMARY role to view the pending requests page showing their list of users 
waiting approval. Requests assigned to the Primary User role are identified by 
the JTF_PRIMARY_USER profile option, which should be set to a 
predetermined username or an FND dummy user. The name used for the 
Primary User Role needs to be in the approval hierarchy if the primary user is 
needed for approval.

For a primary user to see the list of pending approvals in his company, the 
administrator must do the setup described under the section about the Oracle 
iSupport Administrator.

A primary user does not see any listing on the pending approvals page unless 
his turn in the approval process. For example, if the approval chain is A, B, C, 
where C is the JTA_DUMMY, then only after A and B has approved the user 
will the primary user see this in his pending approval window.

5.8.3.3 Defining a New Approval Process
New approval processes can be defined on the JTF sysadmin console. Consult the 
Oracle Common Application Components Implementation Guide and the Oracle Common 
Application Components User’s Guide for details.
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5.9 Setting Up Service Request
See the chapter Integrating Oracle iSupport with Service Request.

5.10 Setting Up Products and Returns Applications
See the chapter in this guide Integrating Oracle iSupport with Products and Returns.

5.11 Setting Up Knowledge Base Applications
The following Oracle knowledge base applications integrate with Oracle iSupport:

■ Oracle Knowledge Management

■ Oracle Marketing Encyclopedia System (MES)

MES is also known as the Technical Library.

5.11.1 Setting Up Knowledge Management
Set up Oracle Knowledge Management. See the chapter in this guide, Integrating 
Oracle iSupport with Oracle Knowledge Management. 

5.11.2 Setting Up Marketing Encyclopedia System
Oracle Marketing Encyclopedia System (MES) is required for technical library 
functionality in Oracle iSupport. It also supplies the Alerts bin content. Refer to 
Marketing Encyclopedia System Implementation Guide for setup details.

5.12 Setting Up iSupport Forums
The sections below details steps for setting up Oracle iSupport interactive forums.

5.12.1 Creating Categories
Categories help to organize forums into topic areas. Oracle iSupport allows you to 
set up as many categories as you wish. The steps below describe how to create a 
category.

Steps
1. At the JTF login, log in as the Oracle iSupport Administrator.
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2. Navigate to Administration > Forum > Category > Create. The Create New 
Category window appears.

3. You can choose to have the category exist at the topmost (root) level, or you can 
structure the category to be a sub-category of another category.

Of course, the very first category that you create will be at the Category Root 
level. Thus, for the first one, leave the Choose a parent category field set to 
Category Root. 

Guidelines for creating additional categories:

■ Leave the drop-down menu set to Root to create a category at the top-most 
level.

■ Select the parent category to create a sub-category within a category.

4. Enter a name for the Category in the Enter the name of the new category field.

5. Select an Access Type. Access type determines who can view the category on 
the UI. Access options are:

Open - All users can view/access.

Restrict - Only members of a usergroup can view/access. For more information, 
see Restricting Access to Categories or Forums.

Close - This option closes the category or forum to all users except the Oracle 
iSupport administrator. It can be utilized as a temporary state for a category or 
forum while the administrator is performing maintenance or setup tasks 
relating to the category or forum. It can also be used to permanently disable a 
category or forum.

6. Select Create. Respond to the confirmation message.

5.12.2 Creating Forums
Forums are focussed topic areas within broader categories. There is no limit to the 
number of forums you can create within any given category or sub-category. Follow 
the steps below to create a forum. 

Steps
1. At the JTF login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Forum > Forum > Create. The Create New Forum 
window appears.
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3. From the drop-down list, select the category within which you wish the forum 
to reside.

4. Enter a name for the forum in the Enter forum name field.

5. Select an Access Type:

Open - All users can view/access.

Restrict - Only members of a usergroup can view/access. For more information, 
see Restricting Access to Categories or Forums.

Close - This option closes the category or forum to all users except the Oracle 
iSupport administrator. It can be utilized as a temporary state for a category or 
forum while the administrator is performing maintenance or setup tasks 
relating to the category or forum. It can also be used to permanently disable a 
category or forum.

6. Select Create. Respond to the confirmation message.

5.12.3 Restricting Access to Categories or Forums
In Oracle iSupport, the administrator has the ability to create categories and forums 
that only members of a usergroup can view and access. 

5.12.3.1 Set Restricted Access on Category or Forum
Use the procedures below to set the Access Type of Restricted on a category or 
forum.

Prerequisite
A category or forum has been created.

Steps
1. Log in to the JTF login window as the Oracle iSupport Administrator. 

2. Navigate to the Forum tab.

Note: Restricted categories and forums do not appear to users who 
are not members of the usergroup associated with the restricted 
category/forum. You should inform users of the existence and 
nature of restricted areas so that they can request inclusion in them, 
if appropriate.
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3. To change the access type of a category, navigate to Category > Modify Status. 
To change the access type of a forum, navigate to Forum > Modify Status. The 
Modify Access Status page appears for either forums or categories.

4. In the Modify Access Status page, select the category or forum you wish to 
restrict.

5. In the Choose access type area, select the Restricted radio button. 

6. Select Next or Modify, depending upon which button appears. Respond to the 
confirmation message.

5.12.3.2 Create Usergroup
Follow the steps below to set up a usergroup to associate with the restricted 
category or forum. Only the usernames that are associated with the usergroup will 
be able to view the category or forum.

Steps
1. Log in to the JTF login window as the Oracle iSupport Administrator. 

2. Navigate to Administration > Support > Usergroup > Create.

3. Enter a unique name for the usergroup in the Name field.

4. Select a effective date for the usergroup using the Start Date calendar icon.

5. Select an ending date for the usergroup using the End Date calendar icon. 

You can also end date a usergroup to disable it.

6. Enter a brief description for the usergroup in the Description text field.

7. In the SQL statement field, enter an appropriate SQL statement.

Sample SQL Usergroup Select Statement

select EMPLOYEE_ID from FND_USER where EMPLOYEE_ID > 0

This select statement retrieves all employee IDs greater than zero (i.e., all 
employees) from the fnd_user table.

Note: Usergroup select statements support PARTY_ID and EMPLOYEE_ID, but 
not USER_ID.

8. Select Save.
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5.12.3.3 Running Usergroup Creation Program 
To populate necessary tables in the database, run the concurrent program 
Usergroup Creation Program (short name is IBUUG). This concurrent program 
must be run each time you update or add users to a usergroup.

5.12.3.4 Associate Usergroup to Restricted Category/Forum
Follow the steps below to associate a usergroup with a restricted category or forum.

Prerequisites
■ A restricted category or forum has been created. 

■ A usergroup has been created. 

■ The usergroup creation concurrent program has been run.

Steps 
1. At the JTF login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Forum > Usergroup > Associate.

3. Choose a category or forum from the drop-down list.

4. Select a Usergroup to associate with the Forum. 

5. Select Associate.

6. A confirmation window appears.

5.12.4 Creating Forum Moderators
A Forum Moderator is a user designated to handle specific administrative tasks for 
message threads (groups of related messages). 

Forum moderators can:

■ Change the status (open or closed) of a message thread

■ Change the distribution (public or internal) of a message thread - internal 
threads can only be viewed by employee users

■ Delete message threads

Forum moderators cannot:

■ Change access type of a category or forum

■ Set up usergroups for restricted categories or forums
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■ Create forums or categories

■ Move message threads from one forum to another

Steps for creating forum moderators are below. See the Oracle iSupport User Guide 
for more information on typical forum moderator tasks.

Steps
1. Log in to the JTF login window as the Oracle iSupport Administrator. 

2. Navigate to Administration > Forum > Forum > Modify Attributes.

3. From the drop-down list, select a Forum where you wish to add a Moderator.

4. Select Next. The Modify Forum Attributes window appears. 

5. Select the Add button under Moderator List area. The Add Moderator window 
appears.

6. Enter the name of the user who will be the Forum moderator. 

If necessary, search for the user:

a. Enter partial search criteria, using % as a wildcard

b. Select the radio button next to the appropriate username

7. After you have entered the appropriate name in the textbox, select Add. A 
confirmation message appears.

5.13 Setting Up Oracle iSupport Surveys
The Surveys functionality of Oracle iSupport allows you to survey usergroups on 
topics of your choice. Surveys require you to set up Oracle Scripting. Follow the 
steps below to implement Surveys.

5.13.1 Setting Up Oracle Scripting
Oracle Scripting presents scripted messages which guide interaction center agents 
through their interactions with customers. With a release of Scripting, Oracle 
introduced the survey component of Oracle Scripting, called iSurvey. Through the 
Scripting Survey component, enterprises can create, manage, and report on surveys 
to evaluate customer satisfaction, gain customer input on new initiatives, and gain 
other feedback from survey respondents. Oracle Scripting is one application 
module of Oracle's Interaction Center Suite of Applications.
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Oracle Scripting consists of the following components: 

■ Scripting Engine - The simple graphical user interface that displays a script at 
an agent's workstation via a browser or within an Oracle Window. 

■ Scripting Author - A script and survey development studio which is 
downloaded to a user’s workstation. Scripting Author uses visual layouts to 
allow a script developer to create, modify, and deploy scripts for agents at the 
interaction center. 

■ Survey Component - An HTML user interface providing web-based surveys 
that can be deployed on the Internet, via email messages or direct links on 
enterprise web sites. The survey component contains all the tools needed to 
manage lists, set up survey campaigns, and provide result information. 

Set up Oracle Scripting according to the Oracle Scripting Implementation Guide. 

5.13.2 Create Surveys in Oracle Scripting
Oracle iSupport uses only the non-list-based types of surveys. 

Create scripts in Oracle Scripting according to the steps and guidelines documented 
in the Oracle Scripting Implementation Guide, Oracle Scripting User Guide, and the 
Oracle Scripting Developer’s Guide. 

5.13.3 Assign Survey Administrator Responsibility to an Oracle iSupport User
Assign the responsibility, Survey Administrator, to either an existing Oracle 
iSupport user (such as the Oracle iSupport Administrator), or to a special user 
created just for this purpose. See the Implementation Tasks chapter of this guide, 
Setting up iSupport Users section, for details on how to set up users.

Steps
1. Log into Oracle iSupport as the Oracle iSupport Administrator.

2. Select Administration > User. Search for the user who will be the Survey 
Administrator, whether this is you as the Oracle iSupport Administrator or 
another user. Select the underlined hyperlink of the username.

3. In the Personal Profile Screen, select Responsibilities. 

4. In the Responsibilities window, select the underlined hyperlink of the word, 
Select. A list of responsibilities appears. If necessary, search for the Survey 
Administrator responsibility. After you find it, select the Survey Administrator 
responsibility. 
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Note: Do not set the Survey Administrator responsibility as the default unless 
you wish to force the user to log into iSurvey the next time the user logs in to 
the HTML JTF login.

5. Save your work.

5.13.4 Set Up Oracle iSupport Survey in iSurvey
Surveys have three parts:

■ Header - this is the header area of the survey

■ Error - this is the error page that is displayed when an error occurs during the 
survey

■ Final - this is the final page displayed to the user after the survey is complete

All of these parts you create as JSPs in the steps outlined in this section.

Follow the steps below to set up Surveys in the Oracle iSurvey module.

Steps
1. Log in to the JTF login page as the user with Survey Administrator 

responsibility. 

If you are already in Oracle iSupport, you can change current responsibility: 
Navigate to Profile > Preferences and select the Survey Administrator 
responsibility from the Current Responsibility LOV on the General Preferences 
page. Select Update.

2. Navigate to Survey Campaign > Survey Resources. In the Resources window, 
select Create.

3. In the Create Resource window, create a Header page, a Final page, and an 
Error page according to the steps and guidelines documented in the Oracle 
Scripting User Guide, with the following exception:

■ Be sure to enter ibupfbgl.jsp in the File Name field for the Final page 
file. This is the Oracle iSupport JSP which lists the surveys you set up.

4. Navigate to Survey Campaign > Survey Campaign. Select Create. 

5. In the Create Survey window, select the appropriate script using the Go button 
and the % as a wildcard.

6. Continue creating the survey by following the steps and guidelines 
documented in the Oracle Scripting User Guide, with the following exception:
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■ For the Final page field, using the Go button, select the resource, Oracle 
iSupport JSP (ibupfbgl.jsp), created in step 3 above.

7. Select Create to save the survey.

8. Navigate to Survey Campaign > Cycle and set up a cycle to associate with the 
survey by following the steps and guidelines documented in the Oracle Scripting 
User Guide.

9. Navigate to Survey Campaign > Deployment and create a deployment for the 
survey by following the steps and guidelines documented in the Oracle Scripting 
User Guide.

10. Deploy the survey by clicking on the Deploy button.Oracle iSupport will only 
display surveys which have the status of Active and whose dates fall within 
current dates. See the Oracle Scripting User Guide for additional information.

5.13.5 Make Survey Available in Oracle iSupport
After you have created the survey in iSurvey, you need to select it in Oracle 
iSupport and then associate a usergroup(s) to the survey. Follow the steps below to 
activate the survey in Oracle iSupport. This section contains three parts:

■ Set up usergroup.

■ Run Usergroup Creation concurrent program.

■ Select Survey and Usergroup in iSupport.

5.13.5.1 Set Up Usergroup
 Follow the steps below to set up a usergroup to associate with any surveys that you 
have created in iSurvey. Only the usernames that are associated with the 
usergroup(s) selected will be able to view the surveys that you have created.

Steps
1. Log in to the JTF login window as the Oracle iSupport Administrator. 

2. Navigate to Administration > Support > Usergroup > Create.

3. Enter a unique name for the usergroup in the Name field.

4. Select a effective date for the usergroup using the Start Date calendar icon.

5. Select an ending date for the usergroup using the End Date calendar icon. 

You can also end date a usergroup to disable it.
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6. Enter a brief description for the usergroup in the Description text field.

7. In the SQL statement field, enter an appropriate SQL statement.

Sample SQL Usergroup Select Statement

select EMPLOYEE_ID from FND_USER where EMPLOYEE_ID > 0

This select statement retrieves all employee IDs greater than zero (i.e., all 
employees) from the fnd_user table.

Note: Usergroup select statements support PARTY_ID and EMPLOYEE_ID, but 
not USER_ID.

8. Select Save.

5.13.5.2 Run Usergroup Creation Concurrent Program 
To populate necessary tables in the database, run the concurrent program 
Usergroup Creation Program (short name is IBUUG). This concurrent program 
must be run each time you update or add users to a usergroup.

5.13.5.3 Select Survey and Usergroup to Associate to Survey
Use the following steps to associate the usergroup(s) with surveys that you have 
created in iSurvey. Only members of the usergroup(s) will be able to view and 
respond to surveys.

1. Log into Oracle iSupport as the Oracle iSupport Administrator. 

2. Navigate to Administration > Support > Survey. Select Add New Survey. The 
Survey Detail window appears with a drop-list of active surveys.

3. Select the desired survey from the drop-list, and then select a usergroup(s) to 
associate with the survey, by clicking on one or more of the checkboxes.

4. Select Create to save the changes.

5. To take the created survey(s), log into Oracle iSupport as a member of a 
usergroup associated with a survey, and navigate to Support > Survey.

5.13.6 View Survey Results
iSurvey allows you to view the results of your surveys. The following steps can 
assist you in retrieving survey results. For complete information, refer to the Oracle 
Scripting Implementation Guide and the Oracle Scripting User Guide.
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Steps
1. Log in to iSurvey as a user with Survey Administrator responsibility. 

From Oracle iSupport, to switch current responsibility, select the Profile > 
Preferences menu to switch current responsibility to the Survey Administrator 
responsibility. You must select the Update button to save changes.

2. In iSurvey, navigate to Response > Survey. Follow the steps and guidelines 
documented in the Oracle Scripting User Guide to view and manage your survey 
results.

5.14 Setting Up Oracle iSupport Web Call-Back
The Web Call-Back (Call Me) feature allows users to submit a call-back request via 
the Oracle iSupport UI. The web call-back requires implementation of:

■ CRM Interaction Center (formerly Call Center Technology - CCT) suite

■ Oracle Universal Work Queue (UWQ)

■ Oracle Customer Care

■ Oracle CRM Foundation, Notes module

The purchase of call center hardware also is required.

This section provides an overview of the call-back functionality in Oracle iSupport. 
For more information, consult the CRM Interaction Center documentation available 
on OracleMetaLink.

Outside of Oracle iSupport, the call routing process is essentially this: After the 
call-back entry is made by the user, Oracle iSupport sends the request to the CCT 
server group specified by the Oracle iSupport Administrator on the Oracle iSupport 
UI. The CCT applications and hardware route the request to the UWQ server. The 
UWQ server decodes the customer information (the Notes module captures 
comments from user) and assigns it to the UWQ client, and the call request 
immediately pops up in an agent’s window in Oracle Customer Care.

There are very few setups required in Oracle iSupport after the dependencies listed 
above are installed and functioning properly. Oracle iSupport simply calls one of 
the CCT APIs to provide the list of available call center server groups that appear 
the Oracle iSupport UI. 

Refer to Oracle CRM Interaction Center documentation for information on setting 
up the underlying products which enable the Web Call-Back functionality in Oracle 
iSupport.
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After the CCT and UWQ applications and call center hardware are installed and 
implemented, you can use the steps below to set up Call Me in Oracle iSupport.

Steps
1. Log into Oracle iSupport as the Oracle iSupport Administrator.

2. Navigate to Support > Call Me.

3. In the Call Me Administration window, select a call center server group from 
the drop-list.

4. Select Update to save the data. 

5.15 Setting Up Contracts Applications
Set up and/or confirm the setup of Oracle Contracts Core and Oracle Service 
Contracts. 

There are no contracts setups specific to Oracle iSupport. See the following 
documentation for setup information:

■ Oracle Contracts Core User Guide

■ Oracle Contracts for Service User Guide

5.16 Setting Up Customer Care
Set up and/or confirm the setup of Oracle Customer Care. Refer to Oracle Customer 
Care Implementation Guide.

5.17 Setting Up Page-Level Look and Feel
An administrator can configure the look and feel of Oracle iSupport JavaServer 
Pages (JSPs) for different users without customizing these pages directly. This is 
accomplished by putting customized material in the top, left, right, and bottom 
sections of the original content pages that Oracle supplies. Oracle provides 
functions that you use to associate your own JSPs with each section of a given 
Oracle iSupport page. Then such a page dynamically includes your pages in a 
user’s browser. Refer to Appendix C for the table of pages that you can configure in 
this way together with their corresponding functions.
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5.17.1 General Steps to Perform JSP Configuration
Here are the general steps to configure the high-level look and feel of a content 
page.

Steps
1. Determine what you want to appear in the four regions around an Oracle 

iSupport content page. Regions can be intentionally left blank. If they are blank, 
then the content region expands into blank regions. 

2. Write the JSP that will provide the intended output. Probably write some simple 
HTML to test the configuration framework to see if the output is placed 
correctly. Pay attention to have matching end tags for all starting tags, 
especially for <table>, <tr>, and <td>. A mismatch of tags results a misplacing 
of the different regions in the standard user interface. Refer to table Table C–2 
for variables that you can use in customizing a JSP.

3. Determine in which page or pages to place the custom JSP. Each page in Oracle 
iSupport has four sections corresponding to four different function names. 

4. Map the functions for the content page to the corresponding customized JSPs 
that you created. Refer to Section 5.17.2 for details of this step.

5. Map the menu IBU_DEFAULT_CONFIG_MENU to the menu corresponding to 
the responsibility to which you want to expose a custom JSP. Refer to 
Section 5.17.3 for details on how do to this.

The reason for this step is responsibility security. Responsibilities can show or 
not show a custom JSP by having a different configuration menu. For example, 
IBU_GUEST_CONFIG_MENU can contain several functions and can be 
attached to the menu corresponding to a guest user. A business use, for 
example, does not see a custom JSP that is tied only to a guest user. 

6. Make sure that the functions that correspond to the custom JSPs are not part of 
excluded menu items. In the responsibility window, assure that none of the 
functions that correspond to a custom JSPs are in the excluded item table.

7. Copy your customized JSP into the $OA_HTML directory, which was 
established when the configuration files for your web server were set up. This is 
the location where the process looks to find customized JSPs.

8. Restart your web server, navigate to the page that has a customized JSP, and 
check the result.
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5.17.2 Mapping Customized JSPs to Customizing Functions
Use this procedure to map your customized JSPs to regions of a content page in 
order to alter the high-level look and feel of that page.

Steps
1. Using the Forms mode and the Application Developer responsibility, navigate 

to Application > Function. The Form Functions window appears.

2. Using Appendix C, determine the functions that correspond with the page 
sections that you want to customize.

3. In the Description tabbed page, query for these functions. The results populate 
the window, including the Web HTML tabbed page.

4. In the Web HTML tabbed page, in the HTML Call column, enter the name of 
your customized JSP that corresponds with each listed function. Include ".jsp" 
in the name.

5. Save your work.

5.17.3 Mapping Page-Level Configuration Functions to Responsibilities
For a custom JSP to adjust the high-level look and feel of a content page, the 
mapping function for the JSP must be in the menu corresponding to the 
responsibility to which you want to expose the custom JSP. You can add functions 
individually, but often a more efficient way is to map the menu IBU_DEFAULT_
CONFIG_MENU or a variant of this menu. This is the case because IBU_DEFAULT_
CONFIG_MENU is associated with full access and thus already contains all the 
configuration functions. As an example of mapping, the seeded responsibility 
iSupport Business User has the seeded menu IBU_BUS_USER_TOP_MENU. You 
must attach IBU_DEFAULT_CONFIG_MENU to IBU_BUS_USER_TOP_MENU for 
a custom JSP to appear. Use this procedure to map IBU_DEFAULT_CONFIG_
MENU to the menu for a responsibility.

Steps
1. Using the Application Developer responsibility, navigate to Application > 

Menu. The Menus window appears.

2. Use the Menu or User Menu Name fields to query for the name of the menu 
that is associated with the responsibility to which you want to expose a custom 
JSP.
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3. Create a new sequence line with IBU_DEFAULT_CONFIG_MENU in the 
Submenu field. Doing so calls in the functions in this menu. Leave the Prompt 
field blank because normally you do not want a user to see the function list.

4. Save your work.

5.18 Setting Up Custom Menus
Oracle iSupport is fully integrated with the Custom Menu feature of the JTT tech 
stack. You can write a new menu renderer by implementing a JTT custom menu 
class and associating it with different Oracle iSupport responsibilities. Thus you can 
create a different menu look and feel for different users. For details and sample 
code, refer to JTT developer documentation, which is in process for release on 
OracleMetalink.

5.19 Verifying the Implementation
Refer to Verifying the Implementation chapter of this guide.
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Verifying the Implementation

This chapter contains steps to verify the successful implementation of Oracle 
iSupport. Topics include:

■ Implementation Verification Overview

■ Verifying Homepage Implementation

■ Verifying User Setups

■ Verifying Service Request Implementation

■ Verifying Products and Returns Integration

■ Verifying Forums Implementation

■ Verifying Knowledge Management Implementation

6.1 Implementation Verification Overview
Following are brief guidelines to verify the successful installation of the major 
functional areas of Oracle iSupport. 

You will be using both administrator and regular user windows during the 
verification process. However, all of the verification tasks below assume that you 
will log in as a regular user, unless otherwise noted.

Help with performing the general user or administrator steps described in this 
chapter can be found in the Oracle iSupport User Guide (available in PDF and online). 
Some of the steps also are in the Implementation Tasks chapter of this guide.

For additional help with implementation, contact Support via OracleMetaLink 
(http://metalink.oracle.com). OracleMetaLink provides support and technical 
information relating to Oracle iSupport, as well as all Oracle products.
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6.2 Verifying Homepage Implementation
Verify that you have set up the Oracle iSupport Homepage.

■ As Oracle iSupport Administrator, select content for the Homepage. 

■ As Oracle iSupport Administrator, change the layout of Homepage content and 
verify that the changes can be seen on the Homepage.

■ As Oracle iSupport Administrator, make some content mandatory on the 
Homepage, and then log in as a non-administrative user and attempt to disable 
it.

■ As Oracle iSupport Administrator, sign up for Homepage e-mail subscription 
feature and verify that you receive the contents in an e-mail. 

■ Log in as a non-administrative user. Verify that you can view Homepage 
content set up by the administrator.

■ Log in as a non-administrative user. Verify that you can edit:

■ Service Request Quick Links bin

■ Service Request (saved views) bin

■ Quick Links bin

References: Setting up iSupport Homepage in the Implementation Tasks chapter of 
this guide.

6.3 Verifying User Setups
Verify that you can create the iSupport users and that you can log in as these users.

■ Create an Individual (B2C) User.

■ Create a Business (B2B) User.

■ Create a Primary User.

■ Create an Employee User.

■ Log in to Oracle iSupport as the users created. Verify that they can access the 
application and that their menu setups are as described in the Setting up 
iSupport Users section.

References: 

■ Setting up iSupport Users in the Implementation Tasks chapter of this guide
6-2 Oracle iSupport Implementation Guide



Verifying Products/Returns Integration
■ CRM User Management Framework documentation (available online)

6.4 Verifying Service Request Implementation
Verify that you have set up service request functionality in Oracle iSupport.

■ Create a service request. Verify that you can attach files to the service request. 
Try attaching different types of files (.gif, .htm, .doc, etc.)

■ If you are integrating service request with Oracle Workflow, select the Email 
This to Me button on the service request confirmation page and verify that the 
e-mail reaches you.

■ Close the service request. Verify that you can re-open it.

■ Wait until the Re-open closed service request time limit (set in the service 
request default settings) has expired, and then verify that you cannot 
re-open the service request.

■ If you have set up Products applications, verify that you can attach a product to 
a service request.

■ As administrator, set service request defaults to enforce product selection, 
then verify that a regular user is required to select a product while creating 
a service request.

■ If you have set up Oracle Knowledge Management, verify that you can search 
the solution repository while creating a service request.

■ As administrator, set service request defaults to enforce knowledge base 
search, then verify that a regular user is required to search the knowledge 
base while creating a service request.

References: 

■ Integrating Oracle iSupport with Service Request chapter of this guide

■ Integrating Oracle iSupport with Oracle Knowledge Management chapter of this 
guide.

■ Oracle TeleService documentation 

■ Integrating Oracle iSupport with Products and Returns

6.5 Verifying Products/Returns Integration
Verify that you have set up the dependent products and returns applications.
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6.5.0.1 Products (Products tab)
Verify the following:

■ As a non-administrative user, navigate to the Products tab. Verify that you can 
search and view products in the Install Base. 

■ As a non-administrative user, verify that you can add products to the Install 
Base.

References: 

■ Integrating Oracle iSupport with Products and Returns chapter in this guide

■ Oracle Install Base Implementation Guide

■ Oracle Inventory documentation

6.5.0.2 Returns (Accounts tab)
■ Log in as a non-administrative user and verify that you can create a return and 

receive an RMA number.

6.5.0.3 Account Management (Accounts tab)
■ Book an order in Order Management, ship it, and make a payment against it. 

Verify that you can view order under the Orders subtab. 

■ Verify that you can see the shipment details for the order.

■ Verify that you can view the invoice associated with the order under the 
Invoices tab.

■ Verify that you can view the payment details associated with the order under 
the Payments subtab.

■ If you have set up Contracts applications, create a contract in Contracts Core. 
Verify that you can you view the contract under the Contracts subtab.

References:

■ Integrating Oracle iSupport with Products and Returns chapter in this guide

■ Oracle Contracts documentation

■ Oracle Accounts Receivable and other financial products documentation
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6.6 Verifying Forums Implementation
Verify the setup of the Forums functionality.

■ As a non-administrative user, verify that you can view forums.

■ As a non-administrative user, verify that you can subscribe to forums.

■ As a non-administrative user, verify that you can select a forum message and 
post a reply that then shows up in the forum.

■ As Oracle iSupport Administrator, verify that you can create categories.

■ As Oracle iSupport Administrator, verify that you can create forums.

■ As Oracle iSupport Administrator, verify that you can create a forum 
moderator.

■ As a forum moderator, verify that you can perform the forum moderator tasks 
listed in the Creating Forum Moderators section of the Implementation Tasks 
chapter.

References:

■ Setting up iSupport Forums in the Implementation Tasks chapter in this guide

6.7 Verifying Knowledge Management Implementation
The following are the verification steps for using Oracle Knowledge Management 
module:

1. Verify that you have assigned CS_System_Admin role to the user and assigned 
CS_KB_Sys_Admin responsibility.

2. Verify that you can perform the following steps:

1. Create, view, and update a Solution Type.

2. Create, view, and update a Statement Type.

3. Associate, and disassociate a Statement Type to a Solution Type.

4. Relate Statement Types to External Links.

5. Create and modify Categories.

6. Create a new authoring flow, and edit an existing flow.

7. Create a Solution.
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8. Create a Statement, add Attachments, and add Comments.

9. View and search Work Pending Solutions.

10. Accept or reject a solution in the workflow.

11. Run Concurrent Programs. 

3. Verify that you can perform the following steps:

1. Add or update frequently used definitions for solutions.

2. Set up recommended solutions.

4. Verify that you can perform the following steps:

1. Basic Search

2. Advanced Search

3. Searching for a Statement

References:

Integrating Oracle iSupport with Oracle Knowledge Management chapter of this guide.
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Integrating Oracle iSupport with Service

Request

Oracle iSupport features the ability to create, update, and track service requests. It 
does this through integration with Oracle TeleService. The service request feature of 
Oracle iSupport also includes optional product selection/association, knowledge 
management queries, and e-mail submission of service request details.

Topics in this chapter include:

■ Overview of Service Request Functionality in Oracle iSupport

■ Overview of Dependencies

■ Overview of Setup Steps

■ Setting Up Oracle TeleService

■ Setting Up Notes

■ iSupport Service Request Setups

■ Testing/Verification of Basic Setup

■ Products in iSupport Service Request

■ Knowledge Management in iSupport Service Request

■ Setting up E-Mail Submission of Service Request Details

7.1 Overview of Service Request Functionality in Oracle iSupport
The main features of service request functionality in Oracle iSupport are:

■ Customizable templates for gathering information from users during request 
creation.
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■ Enforceable or optional knowledge base search during request creation.

■ Enforceable or optional product selection during request creation.

■ Customer ability to re-open a closed request. Administrator ability to set a time 
limit on re-opening a closed request.

■ Customer ability to update an existing request by adding notes, attachments, or 
re-opening within a specific timeframe.

■ Delivery of submitted service request information to users via e-mail.

7.2 Overview of Dependencies
Oracle TeleService provides the bulk of the service request functionality in Oracle 
iSupport. Oracle TeleService tracks all service issues reported by customers and 
employees of the merchant. It does this through agent and customer input and 
integration with other Oracle applications.

In addition to the dependency upon Oracle TeleService, other service request 
functionality within Oracle iSupport can be highly dependent upon additional 
applications, depending upon the features you elect to implement. These other 
applications include:

■ Oracle Workflow for processing e-mails.

■ Oracle Inventory and Oracle Install Base for products data.

■ The following Oracle Common Application Components:

Assignment Manager (Assignment Engine) - Manager is required for service 
request functionality in Oracle iSupport and Oracle TeleService. Oracle iSupport 
calls the assignment manager to determine the owner (resource) of a service 
request. Who the assignment engine picks as the owner is dependent upon: 
request type, severity, urgency, status, problem code, product, and answers to 
template questions. If the assignment engine is unable to find an appropriate 
owner, the system picks the default resource and resource type configured in 
the profile options. 

Notes - The Notes module is required for service request functionality in Oracle 
iSupport and Oracle TeleService. Service request processes use notes to capture 
data during creation and update. Administrators must set up note types and 
map them to Oracle iSupport. 
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Resource Manager - The Resources module is optional for service request 
functionality in Oracle iSupport, unless you are going to set up and use 
Resources as owners of service requests. 

Territory Manager - Territory Manager is optional for service request 
functionality in Oracle iSupport.Territory Manager allows you to define rules in 
Assignment Manager.

Task Manager - The Tasks module is optional for service request functionality 
in Oracle iSupport, unless you are going to assign Tasks based on service 
request activity. Tasks allows you to create and assign work items to Resources. 
You create tasks, for example, to call back a customer or dispatch a service 
engineer to the customer site to fix a problem. A task may be assigned to an 
individual employee, a team, or a group.

7.3 Overview of Setup Steps
In order to use the service request functionality of Oracle iSupport, you must:

■ Set up the Oracle TeleService application, which supplies the base functionality. 
See Setting up Oracle TeleService.

■ Set up the Notes module, which allows the capture of textual information in 
service request functionality. See Setting up Notes.

In addition to setting up the basic functionality, you can choose to implement 
additional, optional functionality, including:

■ Products integration (see Setting up Products).

■ Knowledge base integration (see Knowledge Management in iSupport Service 
Request). 

■ E-mail of service request data to users (see Setting up E-Mail Submission of 
Service Request Details).

7.4 Setting Up Oracle TeleService
The following sections provide abbreviated details of the Oracle TeleService setups 
required for service request functionality in Oracle iSupport. For additional 
information, consult the Oracle TeleService Implementation Guide.
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7.4.0.1 Define Service Request Status Codes
Service request status codes indicate the current state of a service request. In the 
most generic sense, the status of a service request can only be open or closed. 
Statuses default to open unless the Closed checkbox is selected during setup.

Within the open type, you can define any number of statuses that mean open, and 
within the closed type status, you can define any number of statuses that mean 
closed. Since service requests can be re-opened, you may also wish to define a 
closed status that means permanently closed. Oracle TeleService ships with a 
limited number of seeded status codes, but you need to define your own to increase 
service request flexibility.

Examples of status codes are: Assignment/Dispatch Complete, Cancelled by User, 
Engineer On-Site, Open, Closed, Resolution in Progress, and Permanently Closed.

In addition, it is important that you define status code transition rules to control the 
use and display of status codes. See Define Status Code Transitions for details.

See the latest version of Oracle TeleService Implementation Guide for additional setup 
details.

7.4.0.2 Define Status Code Transition Rules
Status code transition rules help control the use of status codes in the following 
ways:

■ Enables you to limit the status values that are allowable based on user 
responsibilities. If you do not define transition rules for status codes, then all 
status codes will be displayed to all users.source:

■ Allow users to change statuses based on rules, that is, open -> working or 
closed, working -> closed, and closed -> open. Note that a status cannot go from 
working back to open.

The steps below can assist you in setting up transition rules for Oracle iSupport. 
Consult the Oracle TeleService Implementation Guide for more information on status 
code transition rules.

Prerequisite
■ Status Codes have been set up.

Steps
1. Log into Oracle Forms as sysadmin. Select the Customer Support responsibility.
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2. Navigate to Setup > Service Request > Request Status. The Service Request 
Statuses window appears with a list of all statuses that have been defined.

3. Select the Transitions button in the lower right-hand corner of the window. The 
Status Transitions window appears.

4. In the Application field, select iSupport using the popup LOV.

5. Enter a name for the transition rule in the Rule Name field.

6. Place the cursor in the Current State field and activate the popup LOV (...). 
Select a service request status from the Initial States window.

7. Place the cursor in the Next State field and activate the popup LOV. Select a 
status from the Final States window.

8. Continue pairing Initial and Final states as desired.

9. Save your work by selecting File > Save, or press the Save icon on the toolbar.

10. Select the Responsibility tab. Select a responsibility to map to the transition rule 
defined above.

11. Save your changes.

12. Enter additional responsibilities to map to transition rules, if desired.

13. Select Ok to save, and close the form.

7.4.0.3 Set Up Service Request Types
Service request types categorize service requests and remain dynamic according to 
the state of the service request. For each service request type, you can set up a 
corresponding service request status or statuses. Additionally, each type can be 
linked to an Oracle Workflow process that can be automatically launched when the 
service request is created, or manually launched in the service request window in 
Oracle TeleService. Service Request Type is a mandatory field in any service request.

You can also associate a service request type with a business process. Business 
processes are defined in Oracle Install Base and are used in generating charges for 
service requests.

The types you set up in the Forms application populate the customer LOV in Oracle 
iSupport. Typical types might be: Technical Problem, Installation Request, or 
Information Inquiry.

Prerequisites to Setting Up Service Request Types
■ Set up your Status Codes.
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■ Define business processes in Oracle Install Base if you are going to use business 
processes. See the Oracle Install Base Implementation Guide for details.

■ Define workflow processes in Oracle Workflow if you are going to associate a 
workflow with a service request type. See Oracle Workflow Implementation Guide 
for details.

For more information on setting up Service Request Types, see the Oracle TeleService 
Implementation Guide.

7.4.0.4 Map Service Request Types to Responsibilities
You can control what service request types can be shown to a user based on his 
current responsibility for service request creation. A single responsibility can be 
mapped to multiple service request types. A service organization can utilize this 
feature to present different service request types to customers and to employee 
users of the service organization based on their responsibility. 

You can enable this mapping in Oracle iSupport by using the system profile option 
Oracle iSupport: Enable Responsibility and Type Mapping.

For more information on mapping service request types to responsibilities, see the 
Oracle TeleService Implementation Guide.

7.4.0.5 Map Problem Codes
You can control what problem codes are presented to a user while creating a service 
request based on his selection of service request types and product combination. A 
service organization can utilize this feature to show related problem codes for a 
service request type or a product or a combination of a product and service request 
type to a user when he is creating a service request for accurate problem capture.

You can enable this mapping in Oracle iSupport by using the system profile option 
Oracle iSupport: Enable Request Type, Product, and Problem Code Mapping.

For more information on mapping problem codes, see the Oracle TeleService 
Implementation Guide.

7.4.0.6 Set Up Service Request Severities
Service request severities indicate the agent’s perception of the reported service 
request. The severities you set here populate the LOVs on the Service Request 
Defaults setup window in Oracle iSupport. Severity is a mandatory field in all 
service requests. Typical severities include: High, Medium, and Low.
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Prerequisite
If you are using Oracle Quality Online, defect severity must be defined in that 
application if you wish to associate a service request severity with a defect severity. 
See the Oracle Quality Online Implementation Guide and the Oracle TeleService 
Implementation Guide for additional details.

For more information on setting up service request severities, see the Oracle 
TeleService Implementation Guide.

7.4.0.7 Set Up Notifications
You can set up Oracle TeleService to automatically notify a service request owner 
and customer contacts associated with the service request whenever a certain event 
occurs, for example, whenever a service request is created, closed, reassigned, or 
changed. Notifications can be sent by Oracle Workflow notifications or by e-mail.

Oracle TeleService includes a notification workflow and notification templates 
suitable for different types of events, but implementers must set up the rules that 
trigger the workflow.

The rules make it possible to selectively notify users only about events of interest to 
the organization. This notification functionality enhances and replaces notifications 
through the Call Support Process workflow that can be associated with service 
request types. The Call Support Process notifies users each and every time a service 
request is updated.

For more information on setting up notifications, see the Oracle TeleService 
Implementation Guide.

7.4.0.8 Set Up Service Request Urgencies
Service request urgencies indicate the customer’s perception of the reported Service 
Request. The urgencies you set here populate the LOVs on the Service Request 
Defaults setup window in Oracle iSupport, and will populate the Urgency LOV that 
the customer selects from when creating a service request. Urgency is an optional 
field in the Oracle TeleService application, but is required in Oracle iSupport.

Typical urgencies include: Inoperable, Partially Operable, and Not Urgent.

For more information on setting up service request urgencies, see the Oracle 
TeleService Implementation Guide.
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7.4.0.9 Set Up Service Request Problem Codes
Service request problem codes can further isolate the reason for a service request. 
Problem codes are user-subjective and are not required in the service request. The 
problem codes you setup here populate the customer LOV in Oracle iSupport. 

Some sample problem codes include: Network Incident, Electrical Problem, and 
Usability Issue.

For more information on setting up Service Request Problem Codes, see the Oracle 
TeleService Implementation Guide.

7.4.0.10 Set Up Service Request Resolution Codes
Service request resolution codes describe how a service request issue was resolved. 
It is optional to set up Resolution Codes. Some sample resolution codes include: 
Servers Rebooted, Unit Replaced, and Patch Sent.

For more information on setting up service request resolution codes, see the Oracle 
TeleService Implementation Guide.

7.4.0.11 Set Up Oracle TeleService Profile Options
For information on setting up Oracle TeleService profile options, see the Oracle 
TeleService Implementation Guide.

7.5 Setting Up Oracle Notes
The Notes module of Oracle Common application Components enables the entire 
suite to create, maintain, and share notes related to customers, opportunities, 
service requests, and other business objects. Notes allows the capture of extensive, 
textual, project relevant information within Oracle applications. Notes comes 
seeded with predefined note types which you can use, or you can define new note 
types of your own. 

See the Oracle Common Application Components Implementation Guide for more 
information. 

7.5.1 Set Note Types as Public to View in Oracle iSupport
In order for a Note to be viewed in Oracle iSupport, it must be specified as public.
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7.5.2 Restrict Note Types Viewed in Oracle iSupport
Because note types are used across Oracle products, it is important to restrict the 
note types that can be viewed in Oracle iSupport. If you do not do this, all note 
types used across applications are displayed in the service request default settings 
page in Oracle iSupport.

Prerequisite
■ Note types have been set up.

Steps
1. Log on to Oracle Forms as sysadmin and select the Customer Support 

responsibility. 

2. Navigate to Setup > Notes > Source and Note Type Mapping. The Mapping 
Objects window appears.

3. Find the Source Object Public Service Requests:

a. Enter Query mode (F11). 

b. Enter Public Service Requests in Source Object field.

c. Execute the query (Ctrl + F11).

4. Ensure that the note types you are using are mapped to iSupport in the 
Application column.

For more information on setting up Notes, see the Oracle Common Application 
Components Implementation Guide.

7.6 Setting Up Service Request in Oracle iSupport
This section outlines the service request setups that are specific to Oracle iSupport. 
Topics include:

■ Set up iSupport Service Request Profile Options

■ Set up Service Request Defaults

■ Set up Service Request Templates
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7.6.1 Set Up iSupport Service Request Profile Options
There are profile options that control the user of some service request functionality 
in Oracle iSupport. See the appendix, Profile Options, for details.

7.6.2 Set Up Service Request Defaults
In the Request Management window, Oracle iSupport administrators can control 
the following service request default settings:

■ List of Values defaults in the Create Service Request window

■ Enforcing knowledge base search

■ Enforcing product association with a service request

■ Setting the time limit for re-opening a closed service request

■ Default note types used for various service request processes

■ Default owners of service requests.

Use the steps below to set service request defaults.

Prerequisites
■ Oracle TeleService has been installed and configured. See Oracle TeleService 

Implementation Guide for details.

Steps
1. At the JTF login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Support > Request Management > General. The 
Request Management Administration window appears.

3. In the Request Management Administration window, set defaults for the 
following:

■ Default Severity - Default Severity for new Service Requests.

■ Default Status - Set a Default Status for new Service Requests. The Default 
Status is the status assigned to the Service Request at creation.

■ Closed Status - From the Closed Status list, set a default for closed Service 
Request.

■ Default Create Notetype - Set a default for the notetype used when a 
Service Request is created.
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■ Default Update Notetype - Set a default for the notetype used when a 
Service Request is updated.

■ Default Escalate Notetype - Set a default for the notetype used when a 
Service Request is escalated.

■ Default Closed Notetype - Set a default for the notetype used when a 
Service Request is closed.

■ Default Resource Type - From the Default Resource Type list, set the 
default resource type. This indicates the resource type associated with the 
Default Resource ID (see below).

■ Default Resource ID - From the Default Resource ID list, set the 
person/group who will be the default resource for Service Request routing.

■ Reopen SR Time Limit - Set the timeframe in hours during which a closed 
Service Request can be opened. 

4. In the During Service Request Creation area, set the following defaults: 

Enable Template:
■ Yes allows the use of templates during Service Request creation.

■ No prohibits the use of templates during Service Request creation.

There is also a profile option which controls this enabling of the templates. See 
the Profile Options appendix.

Search Knowledge Base:
■ Always Prompt Customer gives users the option of searching or not 

searching the knowledge base.

■ Always Search Knowledge Base enforces knowledge base search prior to 
submission of the service request.

■ Directly Submit to Oracle iSupport bypasses the knowledge base search 
option. The knowledge base button does not appear in this case.

Enforce Product Selection:
■ Yes enforces that the user select a product to associate with the request 

prior to submission.

■ No bypasses the product selection enforcement option.

5. When finished, select Update.
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7.6.3 Set up Service Request Templates
Service request templates provide a structured, formatted method of gathering 
information during Service Request creation. Templates characteristics include:

■ Administrator-defined questions that gather information about service requests; 
these questions can be configured so that the user is required to answer them.

■ Administrator-defined free-form and choice-type answers that relate to the 
questions posed on the template.

■ Weighting of choice-type answers used to determine severity of service requests 
automatically.

■ Ability to associate a template with a specific product and/or urgency.

■ Short codes which assist in characterizing and routing the service requests.

Templates are presented to the customer/user during request creation as questions 
and responses.

The information gathered from the templates assists in:

■ Routing the service request to the appropriate support agent or support group 
in Oracle TeleService.

■ Determining the severity of the service request in Oracle TeleService.

This topic area includes:

■ Creating New Templates

■ Selecting Effective Dates for Templates

■ Associating Products with Templates

■ Associating Urgencies with Templates

■ Defining Questions/Answers on Templates

■ Defining Severity Thresholds for Templates

■ Setting up a Default Template

7.6.3.1 Creating New Templates
Use the steps below to begin creating a new service request template.

Steps
1. Log in to the JTF login as Oracle iSupport Administrator. 
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2. Navigate to Administration > Support > Request Management > Template. The 
Service Request Template Administration window appears.

3. In an empty textbox in the Template Name column, enter a meaningful name 
for the new template. 

4. In the Short Code column, enter a meaningful code for the template. The code 
must be less than 8 characters and should indicate an overall category for the 
template. For example, a short code for a template used for Toshiba laptop 
service requests could have a short code of TOSH_LAP.

Note: In this release of Oracle iSupport, the Short Code field is non-functional, 
but it is recommended that you use it so that when it is utilized in a future 
release, existing templates will already be using it. In a future release, the short 
code will help route service requests. The short code is not exposed to end 
users. 

5. Select Add. The window refreshes and displays a confirmation message.

6. Next, select effective dates for the template. Click on the hyperlink of the 
template name. The Modify Template window appears.

7. In the Template Info area, select the calendar icon next to the Start Date field 
and choose an effective start date for the template. Do the same for End Date. 
(You can also use the End Date function to disable existing templates.) All of the 
date steps are optional.

Renaming the template and altering the Short Code can be done here as well.

8. Select Update. A confirmation message appears.

9. Next, associate the template with a product. Select the underlined hyperlink of 
the appropriate template. The Modify Template window appears.

10. In the Associate Attribute, Attribute to Associate: Product area, select Modify. 
The Associate Product window appears.

11. From the Available Product list, select the desired association(s) and use the 
right (>) arrow button to move them to the Associated Product column. Select 
Update and then Back (bottom of window) to return to the Associate Attribute 
area of the Modify Template window.

12. Next, associate an urgency to the template. Select the underlined hyperlink of 
the appropriate template. The Modify Template window appears.

13. In the Associate Attribute, Attribute to Associate: Urgency area, select Modify. 
The Associate Urgency window appears.
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14. From the Available Urgencies list, select the desired association(s) and use the 
right (>) arrow button to move them to the Associated Urgencies column. Select 
Update and then Back (bottom of window) to return to the Associate Attribute 
area of the Modify Template window.

15. Next, define questions and answers for the template. Select the underlined 
hyperlink of the appropriate template. The Modify Template window appears.

16. Set up Questions on Template: In the Modify Template window, the Template 
Detail area will list any questions associated with the template. If none is 
associated, there will be an empty text box. Enter a question for the template in 
the empty Question field.

17. Select Answer Type: You have two options for Answer types:

■ Choice - This is a pick-list type answer and can be used in scoring. Scoring 
is used for determining the Severity of the Service Request. 

■ Free Text - This is a free-form answer; you can specify the number of lines 
allowed for the answer (see below). This answer cannot be used in scoring.

18. If your question requires a Choice-type answer, select whether you wish the 
answer to be used in scoring/weighting when determining severities for 
submissions which use this template (see Set Severity Thresholds below). 
Answers to the question will be weighted from 1 to 9 during the Answer setup 
(see Set up Answers for a Choice Question below).

19. To enforce that the user is required to answer the question, select Yes in the 
Response Required field. Mandatory questions force the user to provide an 
answer before the application will continue creating the request. To make the 
question optional for the end user, choose No.

20. Select Add. The window refreshes, with the question appearing as an 
underlined link in the Template Detail area.

21. To sort the questions, select Sort and use the up and down arrows in the Sort 
Questions window to arrange the questions in the desired order. Use the back 
button to return to the Modify Template page.

22. Optionally, to edit a question, click on the hyperlink of the question you wish to 
modify.

23. Set up Answers for a Choice Question: In the Template Detail area, click the 
underlined hyperlink of a question. The Define Question and Answer window 
appears. 

24. Enter an answer for the question in an empty textbox.
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The answers you set up here becomes a pick-list for the end user, and the 
answer you select as a default appears as the default answer on the user side.

25. For each Choice-type answer, set a value of 1-9. After the end user answers the 
questions, the application will add up these values and the final score will be 
used to determine the severity of the Service Request, based on the Severity 
Thresholds you set (see below). 

26. For Text-type questions, you will not need to determine answers. Instead, in the 
Define Question and Answer window, select the number of rows the user will 
be limited to when answering. 

27. Select Update to save changes, and Back to return to the previous window.

28. Next, set up severity thresholds for the template. Select the underlined 
hyperlink of the appropriate template. The Modify Template window appears.

Use the Set Severity area to set Severity Thresholds for the template. The 
severities listed here come from the Severity setups in TeleService. For each 
Severity, enter a value in the Start and End Threshold boxes. Do not define 
overlapping thresholds or ranges (see examples, below). The weighting you 
gave to each scorable question in the defining answers step above will be 
calculated and used here. The user responses to all questions used in scoring are 
averaged, and the score determines the severity level. 

The sum score from all of the scorable answers is determined by the application 
and compared to the total possible. The percentage is determined by the 
application, and the appropriate threshold is assigned. See the example below 
for clarification.

Note: You do not need to define thresholds for all of your severities, only the 
ones you wish to use. Also: You can select one of the severities as a default and 
all templates use that severity. Severities for which you do not define thresholds 
are ignored by the application.

Sample scenario related to this setup

You have defined a new template with two questions on it. Each question has 
three possible answers, for a total of six answers defined by the administrator, 
and two possible answers for the user (user can only select one answer per 
question). 

In this example, you have set up each of the question’s three answers with 
identical scores: 1, 4, and 5. Since the user can only select one answer per 
question, the highest possible score in this scenario would be 10 (highest score 
for each question is 5, and 5 plus 5 is 10). (The user cannot see these scores.)
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The user selects an answer from the first question with a score of 1. He selects 
an answer from the second question with a score of 4. Thus, the total of the two 
answers is 5. The application find the score of 5 and compares it against the 
total possible answer points, which in this case is 10. From there, the application 
formulates a percentage of answers scored (5) verses a total possible score (10). 
The percentage in this case is be 50%. Then, based on the severity thresholds 
you set (see the example below), the application determines the severity (e.g, 
high, medium, low). Here are the thresholds set for this example:

High - Start Threshold = 61%; End Threshold = 100%

Medium - Start Threshold = 31%; End Threshold = 60%

Low - Start Threshold = 0%; End Threshold = 30%

29. When finished entering severity thresholds, select Update.When finished 
entering severity thresholds, select Update.

7.6.3.2 Setting Up a Default Template
Oracle iSupport uses the Default Template you set up when users select a product 
and urgency combination for which a template does not exist. 

Only one default template is allowed.

Prerequisites 
■ A Service Request template has been created in Oracle iSupport. 

■ The service request template feature has been enabled by selecting Yes in the 
Enable Template LOV on the service request defaults window.

Steps
1. Set up a new template with general questions. The questions should be "catch 

all" type questions related to service requests. Use the following procedure to 
set the default template.

2. In the list of templates, in the Set as Default column, select the radio button next 
to the appropriate template.

3. Select Update.
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7.7 Setting Up Products
Service request functionality in Oracle iSupport allows users to associate products 
with service requests and allows administrators the option of enforcing product 
selection during request creation. Products also can be associated with service 
request templates set up by administrators. To enable product association, you must 
set up Oracle Inventory and Oracle Install Base. 

See the Integrating Oracle iSupport with Products and Returns chapter of this guide for 
more information.

7.8 Using Knowledge Management in iSupport Service Request
The creation of new service requests can be reduced by allowing or enforcing users 
to search a knowledge base prior to submission. Oracle Knowledge Management 
must be set up to facilitate this functionality in Oracle iSupport.

See the Oracle Knowledge Management Implementation Guide for more information.

7.9 Setting Up E-mail Submission of Service Request Details
Service request functionality in Oracle iSupport allows users to have the details of a 
service request e-mailed to them by clicking a button on the service request 
verification window. 

The application that facilitates the e-mail submission is Oracle Workflow. See the 
Integrating Oracle iSupport with Oracle Workflow chapter of this guide for more 
information.

Note: A valid e-mail address must be set up for the user in his Profile in order for 
the e-mail feature to work.
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Integrating Oracle iSupport with Products

and Returns

This chapter details how to integrate Oracle iSupport with the applications that 
provide products and returns functionality. Topics include:

■ Understanding Integration with Products and Returns

■ Setting Up Oracle Inventory

■ Setting Up Oracle Bills of Materials

■ Setting Up Oracle Install Base

■ Enabling Returns Functionality

8.1 Understanding Integration with Products and Returns
Several processes within Oracle iSupport require the use of products and 
purchasing-related applications, including: 

■ Creating and processing returns

■ Viewing invoice information

■ Viewing payments data

■ Viewing shipment information

■ Creating and updating service requests

■ Maintaining products databases, such as customer products and inventory 
items 

The information in this chapter is designed to provide the merchant implementing 
Oracle iSupport with setup details directly related to Oracle iSupport. 
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The applications that integrate with Oracle iSupport and provide products 
repository and returns functionality include:

■ Oracle Inventory

■ Oracle Bills of Materials

■ Oracle Install Base

■ Oracle Order Management

■ Oracle Order Capture APIs

■ Oracle Shipping

■ Oracle Advanced Pricing

■ Oracle Purchasing

■ Oracle Service Contracts

■ Oracle Customer Care

Remember, a full install and setup of each product or purchasing application must 
be performed in order for the functionality to perform as described. Consult the 
specific product documentation for full implementation details.

8.2 Setting Up Oracle Inventory
Oracle Inventory supplies the infrastructure that holds an organization’s entire 
product repository and configuration. It integrates closely with Install Base, which 
is the repository of customer- or party-purchased products. 

Both Inventory and Install Base may be required for service request functioning, 
Products tab functionality, and Accounts tab functionality in Oracle iSupport. 

For information on how to set up Oracle Inventory, see Oracle Inventory 
Implementation Guide.

8.3 Setting Up Bills of Materials
Oracle Bills of Materials (BOM) is an application that allows the configuring of 
groups of products into coordinated and complementary systems. Within BOM, you 
can define product relationships and create products with multiple components and 
subcomponents. BOM integrates with Inventory and Install Base. 

BOM is an optional integration with products and returns functionality in Oracle 
iSupport.
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If using BOM, setup Oracle Bills of Materials. Refer to Oracle Bills of Material User’s 
Guide.

8.4 Setting Up Oracle Install Base
Oracle Install Base is a repository which maintains the customer products in tree 
structure. Install Base maintains all the customer details, installation details, 
product information, and applicable service agreements. Install Base uses the 
concurrent program, Install Base Interface, to populate tables when new data is 
added.

Oracle iSupport uses Oracle Install Base for:

■ Retrieving customer product data in the Accounts tab

■ Adding items to the Install Base using the Products tab

■ Retrieving customer products while creating service requests

Confirm the setup of Oracle Install Base. Refer to Oracle Install Base Implementation 
Guide.

8.5 Enabling Returns Functionality
The following applications and relevant dependencies are necessary for returns 
functionality in Oracle iSupport:

■ Oracle Order Capture APIs

■ Oracle Order Management

8.5.1 Understanding Returns in Oracle Order Management
In Release 11i of Oracle Order Management, RMA is often used synonymously with 
Return or Credit Orders and Returned Material. An order can have a mix of 
outbound (regular) and inbound (return) lines, if not restricted by the order type 
definition. Credit order types are of the order type category Return, while an order 
with Mixed order type category can contain both regular and return lines. Each 

Note: When setting up new users of the Oracle Install Base 
functionality, please add the role, CSI_END_USER to them. This 
role contains the required permissions for Install Base general 
users.
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order type and each line type is associated with a workflow process. The Line Type 
Category associated with the Line Type determines if it is a return. Line types can 
be variations of Return, such as Return with Approval, Return for Credit Only, and 
have a line type category of Return.

Oracle Order Management supports a variety of methods for returning products. 
An agent or administrator decides at the time of authorizing the return how to 
process the request. For example, an agent can accept the return and process a credit 
for the customer, updating all sales activity and credit balances. Or, the agent may 
accept the return for replacement and enter a replacement order instead of issuing a 
credit.

Examples of returns supported by Oracle Order Management:

RMA with Credit Only - Company issues a credit without the customer returning 
the product.

RMA with Repair - Customer returns damaged product. Company repairs and 
returns the product to customer.

RMA with Replacement - Customer returns a product. Company sends a 
replacement product rather than issuing a credit.

RMA with Receipt and No Credit - Customer returns a product sent to him on a 
trial basis or at no charge. Company does not issue a credit.

RMA with Receipt and Credit - Customer returns a product. Company issues a 
credit.

Returned Item Fails Inspection - Customer returns product. Company inspects 
product and rejects it. Company either destroys product or sends product back to 
customer.

Process Flow:
1. Create an RMA in Oracle iSupport.

2. Book the RMA into Oracle Order Management through Oracle Order Capture 
API.

3. Receive the RMA using the Receipts form of Oracle Purchasing.

4. Check the on-hand quantity of the item in inventory to verify that the correct 
quantity was received.

5. Fulfill the RMA line.

6. Generate a credit memo in Oracle Invoicing.
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7. View the credit memo in Oracle Order Management.

8. Check the Shipped and Fulfilled quantity on the RMA line.

8.5.2 Understanding Returns in Oracle iSupport
Oracle iSupport allows users to create a return by providing a UI that calls Oracle 
Order Capture APIs to submit the return to Oracle Order Management and perform 
customer validation. Oracle iSupport does not create the return to Oracle Order 
Management directly.

Navigation to the returns feature is Account tab > Return > Create Returns.

For this release of Oracle iSupport, iSupport only supports RMA with Receipt and 
Credit.

Process Flow:
Following is the process flow for creating a return within Oracle iSupport. For 
information on Oracle Workflow items associated with returns, refer to the chapter 
in this guide, Integrating Oracle iSupport with Oracle Workflow.

1. Within Oracle iSupport, the user accesses the Create Return window.

2. User enters orders associated with his account number(s). For this release of 
Oracle iSupport, the user must have an exact order number to create a return. 
Only orders that have been ordered (booked) can be returned. 

3. The user provides the following information:

■ Account Number - This must be the account number associated with the 
order.

■ Contact for the company returning the item, if appropriate.

■ Bill to address - User must enter a bill to address. This indicates where the 
credit will be sent if the credit memo cannot be applied to an invoice. User 
can select alternate address using the drop list.

■ Ship from address - User will be see a default ship from address; this 
indicates where the return is originating from. User can select alternate 
address using the drop list.

■ Return reason - A return reason must be specified for each line being 
returned.

4. User selects the lines to be returned. Only items that are "returnable" can be 
returned. Only returnable lines display a select checkbox. 
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5. The page calculates the credit amount for the user; this is the amount of the 
order line. The ordered amount is the net selling price per unit multiplied by 
the quantity ordered.

6. Having selected a valid order item and quantity, the user clicks Create Return, 
and Oracle iSupport submits the return to Oracle Order Management through 
the Oracle Order Capture API. If the return submission is successful, then the 
user receives an RMA number. If Oracle Order Management/Oracle Quoting 
return any errors, then Oracle iSupport captures and displays them on the next 
page. When the return is booked, the same order line cannot be returned twice.

7. After creation of the return from Oracle iSupport, the return is handled by 
Oracle Order Capture API, Order Management, Oracle Purchasing, Workflow 
APIs, Oracle Inventory (or Oracle Install Base), Oracle Accounts Receivable, and 
Oracle Invoicing.

8.5.3 Setting Up Oracle Quoting
Set up Oracle Quoting according to the latest Oracle Quoting Implementation Guide. 
This enables access to the Order Capture APIs that are required for returns 
functionality in Oracle iSupport.

8.5.3.1 Returns Profile Options
The following profile options must be set to allow returns functionality in Oracle 
iSupport:

ASO: Default Order Type - Set to Mixed.

ASO: Default Order State - Set to Booked.

8.5.4 Setting Up Oracle Order Management
Using the Oracle Order Management Suite, you can enter sales orders, calculate the 
price of items on order lines, fulfill the orders -- for example, by shipping the items 
-- and send information to an accounts receivable system so that invoices are 
created. The core Oracle Order Management products are: 

■ Oracle Order Management - required for returns in Oracle iSupport

■ Oracle Shipping Execution (SE) - required for returns in Oracle iSupport

■ Oracle Pricing
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These products are included when Oracle Order Management is purchased. 
Additional products are available which are also integrated with Oracle Order 
Management, and these include:

■ Oracle Advanced Pricing - required for returns in Oracle iSupport

■ Oracle Configurator

■ Oracle Accounts Receivable - a dependency for general Oracle iSupport setup

■ Oracle Advanced Planning and Scheduling

Confirm the setup of Oracle Order Management. While the steps in this section can 
assist you in setting up Order Management, you will need to refer to Oracle Order 
Management Suite Implementation Manual for complete setup information.

8.5.4.1 Set Up Transaction Type Line Types
Order Management transaction types classify orders and returns. Credit order types 
are of the order type category Return. 

In order for the returns feature to work properly, the default order type in Order 
Management must be set to Mixed. This is controlled by the profile option, ASO: 
Default Order Type = Mixed.

The following steps can assist you in setting up Order Management Line Types. For 
complete setup information, refer to the Oracle Order Management Suite 
Implementation Manual.

Steps
1. Log in to Oracle Forms; select Order Management super user or administrator 

responsibility. 

2. Navigate to Setup > Transaction Types > Define. The Transaction Types window 
displays.

3. Query for Mixed (you must enter the word exactly as shown here) in the 
Transaction Type field. (Use F11 and Ctrl +F11 to query.) The Transaction Types 
window populates with the information for the Mixed transaction type.

4. Place the cursor in the Order Category field and select an Order Category of 
Mixed.

5. Place the cursor in the Default Return Line field and select a Default Return 
Line Type of Return (Receipt).
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6. Place the cursor in the Default Order Line Type field and select a Default Order 
Line Type of Standard (Line Invoicing).

7. Access the Line Workflow Assignments window by selecting the Assign Line 
Flow button.

8. In the Access the Line Workflow Assignments window, add a new record.

9. In the Set Line Type field, select Standard (Line Invoicing) from the LOV.

10. Select an appropriate Item Type to populate the Item Type field. 

11. In the Set Process Name field, select Line Flow Generic from the LOV.

12. Select an appropriate Start Date.

13. Add a second record. 

14. In the Set Line Type field, select Return (Receipt) from the LOV.

15. Select an appropriate Item Type to populate the Item Type field. 

16. In the Set Process Name field, select Line Flow Return for Credit with Receipt.

17. Select an appropriate Start Date for the record.

18. Select Ok. Save the changes.

8.5.5 Guidelines
■ When the lot controlled and serialized items are returned, the serial number 

entered by the user is not validated against an Inventory serial number or the 
original order serial number. However, the serial number is captured in the 
RMA lines and is viewable in Oracle Receivables.

■ Currently, Oracle Install Base does not get updated automatically when a 
serialized item is returned.

■ ATO/PTO configurations are configured items. For example, a configuration 
such as a computer system can consist of many items. Fulfillment of the entire 
configuration is required before crediting. The usage of fulfillment set can 
achieve the result of triggering crediting only after the entire configuration is 
fulfilled.

■ Oracle Order Management allows the return of freight and other special 
charges. 
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8.5.6 Troubleshooting Returns in Oracle iSupport
To find out what is wrong in case the Create Return fails in Oracle iSupport, it is 
helpful to properly generate a debug file from Oracle Quoting or Oracle Order 
Management when a return is created. Use the following procedure.

Steps
1. Inside the database, one of the v$parameter, utl_file_dir, needs to be set to the 

debug file directory. Specify the correct directory in the init.ora file to set this. 

2. Ensure the settings on the following Oracle Order Management (OM) and 
Order Quoting (ASO) profile options:

■ OM: Debug Level

■ OM: Debug Log Directory - This directory needs to be the same as the 
directory pointed to by utl_file_dir above.

■ ASO: Enable ASO Debug - Set to Yes.

Additional information on this topic is available in the Profile Options chapter of this 
guide.

8.5.7 Set Up Oracle Advanced Pricing
Order Management uses Oracle Advanced Pricing for determining prices of goods 
sold; therefore, it is a mandatory module for returns execution. 

Confirm the setup of Oracle Advanced Pricing. Refer to Oracle Advanced Pricing 
Implementation Guide for setup details. 

8.5.8 Set Up Oracle Shipping
Oracle Shipping provides shipping execution for Order Management and is 
necessary for the returns integration. It is mandatory for returns in Oracle iSupport. 

Refer to Implementing Oracle Shipping for setup details.

8.5.9 Set Up Oracle Purchasing
The Receipts form of Oracle Purchasing receives an RMA when it is booked. 
Therefore, it is a mandatory module for returns execution. 

Confirm the setup of Oracle Purchasing. Refer to Implementing Oracle Purchasing.
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Integrating Oracle iSupport with Oracle

Knowledge Management

This chapter addresses Oracle iSupport’s integration with the Oracle Knowledge 
Management application. 

9.1 Overview of Oracle Knowledge Management
Oracle Knowledge Management is a comprehensive information management 
system that allows you to manage internal and external information using Oracle 
intelligent knowledge capture, storage, and distribution tools. It is a problem and 
solution management system and database. The solutions are separated by different 
criteria so that each solution has a specific meaning that relates directly to the issues 
being searched. 

Oracle Knowledge Management allows easy solution capture and rapid access to 
new solutions. It is also designed to provide focused results and to reduce the cost 
of providing service while increasing customer satisfaction, thus helping companies 
compete in the marketplace.

For users of Oracle iSupport, Oracle Knowledge Management is important to 
browse, search, and write technical content. Usually the Oracle iSupport 
administrator is set up with the capability to perform the functions of the Oracle 
Knowledge Management administrator.

For more information on Oracle Knowledge Management, see the Oracle Knowledge 
Management User Guide and the Oracle Knowledge Management Implementation Guide.
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 Integrating Oracle iSupport with Oracle

Workflow

Oracle iSupport integrates with Oracle Workflow to provide e-mail submission and 
other workflow processes. 

Topics in this chapter include:

■ Oracle Workflow Overview

■ Overview of Oracle Workflow Functionality in Oracle iSupport

■ Setting up Oracle Workflow

10.1 Oracle Workflow Overview
Oracle Applications 11i comes with Oracle Workflow (WF) already installed as part 
of the Applications Object Library (AOL). WF consists of two tiers: 

■ Workflow Client (Workflow Builder)

■ Workflow Server

The sections below provide an overview of these two tiers.

10.1.1 Workflow Client
Workflow Client is the Workflow Builder which is used by Workflow developers to 
create or modify custom workflows. This is installed on Windows 95/NT/2000 
clients only.
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10.1.2 Workflow Server
The Workflow Server consists of the following elements:

Workflow Engine: Monitors workflow states and coordinates the routing of 
activities for a process. Changes in workflow state -- such as the completion of 
workflow activities -- are signalled to the engine by a PL/SQL API or Java API. 
Based on flexibly-defined workflow rules, the engine determines which activities 
are eligible to run, and then runs them. The Workflow Engine supports 
sophisticated workflow rules, including looping, branching, parallel flows, and 
subflows.

Workflow Notification Mailer (WFMAIL): Electronic mail (e-mail) users can 
receive notifications of outstanding work items and can respond to those 
notification using their e-mail application of choice.

Note: Email notifications will only be sent if the Workflow mailer is setup and 
configured properly. The PHP/Self Service Workflow notifications page can 
also be used to view notifications. Please refer to the Workflow documentation 
for more information on how to start and configure the workflow mailer. 

Workflow Definitions Loader (WFLOAD): The Workflow Definitions Loader is a 
utility program that moves workflow definitions between the database and 
corresponding flat file representations. You can use it to move workflow definitions 
from a development to a production database, or to apply upgrades to existing 
definitions. In addition to being a standalone server program, the Workflow 
Definitions Loader is also integrated into Oracle Workflow Builder, allowing you to 
open and save workflow definitions in both a database and a file.

Workflow Monitor: Workflow administrators and users can view the progress of a 
work item in a workflow process by connecting to the Workflow Monitor using a 
standard Web browser that supports Java. The Workflow Monitor displays an 
annotated view of the process diagram for a particular instance of a workflow 
process, so that users can get a graphical depiction of their work item status. The 
Workflow Monitor also displays a separate status summary for the work item, the 
process, and each activity in the process.

Message Delivery Scheduler Concurrent Program: 

Workflow Background Engine/Workflow Background Process Concurrent 
Program: A supplemental Workflow Engine that processes deferred or timed-out 
activities.

Purge Obsolete Workflow Runtime Data Concurrent Program (WF_PURGE): This 
program purges obsolete item types runtime status information. source:
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For more information on Oracle Workflow, see the Oracle Workflow User’s Guide.

On OracleMetaLink, search for Oracle Workflow to find additional relevant 
documents.

10.2 Overview of Oracle Workflow Functionality in iSupport
The sections that follow describe Oracle Workflow’s relationship to Oracle iSupport. 
For more information on Oracle Workflow, see the Oracle Workflow User’s Guide.

10.2.1 Service Request
Oracle iSupport features the ability to create, update, and track service requests. It 
does this through integration with Oracle TeleService.

Service request types can be linked to an Oracle Workflow process that can be 
automatically launched when a service request is created, or manually launched in 
the service request window in Oracle TeleService. Oracle Workflow automatically 
notifies service personnel about their assignments based on service request. When a 
service request is escalated, Oracle Workflow processes and delivers the 
notifications regarding escalation activity.

Oracle iSupport also uses Oracle Workflow to submit service request details to 
users. This is done via the Email this to me button during service request creation.

For more information, see:

■ Oracle Workflow Guide

■ Oracle TeleService Implementation Guide

■ Oracle iSupport Implementation Guide: Integrating Oracle iSupport with Service 
Request

10.2.2 Returns
When a customer books a return in Oracle iSupport, Workflow picks it up using the 
seeded workflow, Order Flow - Return with Approval. Next, Workflow uses the 
Return for Credit with Receipt workflow to send the return to the Return Receiving 
Line stage. Then, the receiving agent from Oracle Purchasing uses Oracle 
Purchasing to pull up the Return Material Authorization (RMA) to verify and mark 
the items as received. The agent then selects a destination for the product(s), such as 
Oracle Inventory. As the receiving agent does this, a Workflow API is invoked to 
move the workflow to the next stage, and Order Management receives data that 
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updates the RMA as appropriate. The workflow now waits in Oracle Inventory. It is 
here that an agent verifies and indicates in Inventory that the correct quantity has 
been received. When a configurable item set (BOM-enabled) is returned, the 
workflow will wait here until all items are checked into the inventory. The 
workflow will next invoke the Accounts Receivable interface APIs. After all of the 
items are fulfilled, an invoice is generated and a credit memo can be generated 
through Oracle Invoice auto-invoice master program. 

For more information, see the chapter, Integrating Oracle iSupport with Products and 
Returns.

10.2.3 Homepage Subscription E-mails
The Homepage e-mail subscription feature uses Oracle Workflow to process 
e-mails. This can be useful if a user is unable to access the Homepage for a period of 
time. The user signs up for the subscription e-mails through the Profile > Support 
menu. In the Support page, the user can select the days that the e-mails should be 
sent and whether the e-mails should be HTML or text-based. The system then uses 
Workflow to sends the e-mails to the address setup in the Profile > Contact Points 
menu.

For more information, see the Setting up iSupport Homepage topic in the 
Implementation Tasks chapter. 

10.2.4 Knowledge Management
Oracle Workflow is essential for the solution authoring feature of knowledge 
management. Using Workflow, the authoring process allows users to define the 
steps in processing content. The process can be as simple as a single step, 
author-publish, or can include several approval stages prior to publication. In an 
approval-dependent process, Workflow allows content to be rejected back to the 
previous stage or a selected previous stage. Individuals involved in solution 
authoring can be assigned to specific groups that are aligned with specific stages 
and categories of content, and these groups can be sent e-mails notifying them of 
the status of content.

For more information, see the chapter, Integrating Oracle iSupport with Oracle 
Knowledge Management.

10.2.5 User Approvals
The approvals notifications used in the Oracle User Management Framework are 
dependent upon Oracle Workflow. The workflow notifications provide e-mails to 
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user approvers notifying them that they have users in the queue waiting to be 
approved. Workflow also sends e-mails to users notifying them that they have been 
approved for an application. For more information, see the Oracle Common 
Application Components Implementation Guide and the Oracle Common Application 
Components User’s Guide.

10.3 Setting up Oracle Workflow
Refer to the Oracle Workflow Guide.
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 Diagnostics and Troubleshooting

This section contains instructions on how to troubleshoot specific problems that you 
may encounter in the configuration or administration of Oracle iSupport. Topics 
include:

■ Stop/Start (Bounce) Apache Server

■ Java/HTML Stack Errors

■ How to Find Responsibility ID Values

■ Debugging Oracle iSupport Returns Functionality

■ Customizing the Oracle iSupport Quick Find Menu

■ Oracle iSupport Administration FAQs

11.1  Stop/Start Apache (Bounce) Server after Patching
After you apply a patch that affects Java applications, you should stop and re-start 
the Apache server and clear the cache on the Apache server. This helps to minimize 
patching errors.

Note: For 11.5.4 and above, the cache is being taken based on the Servlet 
Initialization parameter, page_repository_root. This parameter can be located in the 
zone.properties file section: servlet.oracle.jsp.JspServlet.initArgs=page_repository_
root=$<ANY Directory> _pages.

11.2 Java/HTML Stack Errors
The following section addresses typical issues associated with the Java applications 
and the HTML technology stack. Topics in this section include:
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■ Understanding JSPs and Server Cache

■ Where are E-Commerce Cookies Stored?

■ JspCompileException

■ NoSuchMethod

■ java.lang.nullpointerException

■ JTF-0198

11.2.0.1 Understanding JSPs and Server Cache
The HTML applications are made up of Java Server Pages (JSPs). JSPs are converted 
into Java programs (files with the extension, .java), and those Java programs are 
converted into Java binaries (files with the extension, .class). These Java binaries 
will be executed by the Jserv Java Virtual Machine (JVM). This translation process 
happens on the fly for every JSP, and after it is completed, the Java programs, along 
with the Java binary, are stored/cached in a special directory called _pages.

11.2.0.2 Where are E-Commerce Cookies Stored?
The cookie file for Netscape browsers is located under the 
Netscape\Users\YourNetscapeUser directory. The file is called cookie.txt.

Cookie files for Internet Explorer are located in the C:\WINDOWS\Cookies 
directory. The name of the file is yourWindowsUser@domain.com. 

11.2.1 JspCompileException

Problem Description
While navigating the HTML application, you receive the following error:

JSP Error: Request URI:/OA_HTML/jtfasuf.jsp

Exception:oracle.jsp.provider.JspCompileException:

Errors compiling:e:\oracrm\viscomn\html\_pages\_oa__html\\_
jtfasuf.java:706

Incompatible type for method. Can’t convert into 
java.lang.Object. 
params.put(’companyid’,ub.getCompanyPartyID());
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When applying E-Commerce patches, the Java Business Objects are replaced in the 
apps.zip and the JSP files are replaced in the system. The server cache is not rebuilt 
automatically, unless a directive has been specified in the JSP. This leads to an 
inconsistency or mismatch (displayed as the error: Incompatible type for method. 
Cannot convert into java.lang.Object) between the JSP and the Java Business Object 
in use. Therefore, the oracle.jsp.provider.JspCompileException occurs.

 The directive that makes the cache able to be rebuilt is developer_mode = true. This 
is a servlet initialization parameter for Oracle Java Server Page Servlet, and it can be 
found in the jserv.properties file located in $APACHE_TOP/Jserv/etc. path of any 
installation.

Solution Description
Most of the time, this error can be resolved by removing the server cache 
(JSP/Jserv), and stopping and re-starting the web server. When you remove the 
server cache, the Java programs and the Java binaries are rebuilt, and when 
bouncing the web server, the Java classes cached in memory are removed. This then 
eliminates any possible mismatch and the exception.

11.2.2 NoSuchMethod

Problem Description
You receive the error, java.lang.NoSuchMethodError.

This error occurs because the system is trying to use a method within a Java object 
that does not exist. This error results due to incorrect/improper setting of the 
classpath variable. In the case of Apache/Jserv, the classpath is defined in a special 
configuration file called jserv.properties, usually located at $APACHE_
TOP/Jserv/etc. (for example, $APACHE_TOP/Jserv/conf in Windows NT). 

Other, not-as-common causes for this error are:

■ Incorrect patch set level or missing patches

■ Errors while patching application

■ Bug in the application 
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11.2.3 JTF Login Page Errors

Problem Description
You are trying to log into the HTML stack via the jtflogin.jsp or the 
jtfdefaultlogin.jsp. 

Jtflogin.jsp page does not display and returns the message, error in error 
page. 

Jtfdefaultlogin.jsp page does not display and returns a message like system 
error, followed by several Java messages, the most significant being 
oracle.apps.jtf.base.session.ServletSessionManagerException.

You have tried to run the diagnostics via jtfqalgn.htm or jtfmain.htm and the 
database connectivity tests fail.

Solution Description
There can be several reasons for this problem scenario, including configuration files 
not being correct for httpd.conf, jserv.conf, jserv.properties, and zone.properties.

The following solution is for correcting one specific condition where your .dbc file 
has been manually edited, looks correct, but the connectivity issue persists.

1. Select * from fnd_application_servers:

The query should return one row. If the query return more than one row, delete 
the rows that are most obviously incorrect. You will probably be able to 
recognize the invalid rows by the IP address column (server_address) that 
points to an invalid host database tier.

The authentication string in this table (column server_id) must match the same 
string in your host_sid.dbc file (appl_server_id).

2. Make a backup copy of your .dbc file.

3. To ensure that everything is in sync, run the adgendbc.sh script located in your 
$COMMON_TOP\admin\install directory. This script takes no parameters 
except -deinstall, which you probably do not want to do. This script will assign 
a new authentication string (server_id), update your .dbc file, and update your 
fnd_application_servers table.

It’s okay if you get an error message related to unique key constraint (read the 
script file).
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4. Double-check the information in your .dbc file and fnd_application_servers 
table. It should be in sync. Display or print the .dbc file. Please do not use an 
editor, because you may forget the rule and save it.

Summary
It is strongly recommended that you do not edit your .dbc file. Results are 
unpredictable and can take a long time to diagnose.

11.2.4 java.lang.nullpointerException

Problem Description
You receive the error, java.lang.nullpointerException.

This error occurs because the system is trying to use an object (variable) that has not 
been instantiated (initialized). The instantiation problem can be due to:

■ Bug in the application

■ Invalid business scenario or flow caused by a configuration problem

Summary
If you are unable to resolve this error, create a Technical Assistance Request (TAR) 
with Oracle TeleService, and be sure to attach the log files for the application.

11.2.5 JTF-0198

Problem Description
You receive the error, JTF-0198.

This application-generated error occurs when the system cannot identify a valid 
cookie. Most of the time, the root cause of the problem is one of these two:

Note: If you receive this error while running Rapid Install: On the 
windows that tell RapidWiz where to store files/directories, do not 
press Ctrl + V (paste) with an empty clipboard. Be sure that your 
clipboard has some data stored on it before pressing Ctrl + V or 
you will receive an error, Java.lang.NullPointerException. (The 
command in Windows for copying text to the clipboard is Ctrl + 
C.):
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1. The domain name field in the ICX_PARAMETERS table is set incorrectly. 

2. You have more than one system installed (with the same domain configuration) 
and with the same cookie name, and are accessing both systems from the same 
browser/machine. Intermittently, the server rejects the cookie because it finds 
two identical cookies on the two systems that are being run. 

Solution Description
To resolve this error, use the following steps.

1. For the first case, set the domain name to either null or a fully qualified domain 
name. For example, if your domain name is computers.com, then the fully 
qualified domain name is .computers.com. This field can accept no 
abbreviated versions of the domain name. Note that the fully qualified domain 
name must contain a dot (.) starting the domain.

For domains that do not belong to the global internet (i.e., private intranets) the 
session_cookie_domain field in ICX_PARAMETERS table must be set to the 
correct domain. If the domain does not belong to the global internet, the 
preferred value for the session_cookie_domain field in ICX_PARAMETERS 
table is null.

2. Change the value of the JTF Property cookie name in one of the systems. Stop 
all browser sessions and clean browser cookie files.

The cookie file for Netscape browsers is located under the 
Netscape\Users\YourNetscapeUser directory. The file is called cookie.txt.

Cookie files for Internet Explorer are located in the C:\WINDOWS\Cookies 
directory. The name of the file is yourWindowsUser@domain.com. In the case of 
IE, you should delete the file name with the extension that matches the domain 
name of the server you are trying to reach, or delete them all.

Summary
If you are unable to resolve this error by following the above steps, create a 
Technical Assistance Request (TAR) with Oracle TeleService, and be sure to attach 
the log files for the application.

11.3 How to Find Responsibility ID Values
The following steps describe how to find the RESPONSIBILITY_ID value of a 
responsibility.
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1. Log in to Oracle Forms application as sysadmin. Select System Administrator 
responsibility. Navigate to Security > Responsibility > Define. The 
Responsibilities form opens.

2. Enter query mode (F11). Under responsibility name, type in IBU_%. Execute the 
query (Ctrl + F11). 

3. An Oracle iSupport (IBU) user responsibility and its associated details will 
appear. Use the Down Arrow key to scroll through the list of Oracle iSupport 
responsibilities.

4. To find the responsibility ID, place your cursor in the Responsibility Key field of 
the responsibility whose ID you wish to find. From the menu, select Help > 
Diagnostics > Examine. The Examine Fields and Variable Values window 
appears. 

5. In the Examine Fields and Variable Values window, click on the LOV button of 
the Responsibility Key. In the LOV that appears, select Responsibility ID. The 
Examine Fields and Variables Values window will then be populated with the 
Responsibility ID for that responsibility.

11.4 Debugging Oracle iSupport Returns Functionality
To find out what is wrong in case the Return functionality fails in Oracle iSupport, it 
is helpful to properly generate a debug file from Quoting-Forms/Order 
Management when a return is created. Use the following steps:

1. Inside the database, one of the v$parameter, utl_file_dir, needs to be set to the 
debug file directory. Specifying the correct directory in the init.ora file can set 
this. 

2. Ensure the settings on the following Order Management and Order 
Quoting-Forms (Order Capture) profiles options:

■ OM: DEBUG LEVEL needs to be set. 10 is the highest debug level.

■ OM: DEBUG LOG Directory - This directory needs to be the same as the 
directory pointed to by utl_file_dir above.

■ ASO: ENABLE ASO DEBUG - Set to Yes.

■ See the chapter, Integrating Oracle iSupport with Products and Returns for 
additional information.
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11.5 Customizing Oracle iSupport Quick Find Menu
The Quick Find Menu appears on most of the Oracle iSupport UI pages. The steps 
below can assist you in customizing this menu.

1. Log in to the JTF UI as sysadmin.

2. Navigate to Settings > System > Advanced > View. 

3. Select Oracle iSupport’s product code, IBU. 

4. You will see a corresponding category and descriptor defined for the each 
search item.

5. Remove any items which you do not wish to use.

Note: When deleting items, be sure to remove the pairs of items that end in 
.categories and .desc.

11.6 Oracle iSupport Administration FAQs
The following are common questions that might be asked by an administrator or 
primary user on Oracle iSupport.

■ How do I customize Oracle iSupport?

■ How do I remove links in the How Can We Help You? bin on the Homepage?

■ Does Oracle iSupport support different languages?

■ Can users renew contracts through Oracle iSupport?

■ What is the relationship between iSupport and TCA?

■ What is the significance of the account number in iSupport?

■ Where do users reset their passwords?

■ Why type of users can change their first and last names in the Personal Profile?

■ What type of users can see company profile information?

■ What causes permission errors under the Profile menu?

■ Why would a user not be able to see the side menus in the Profile screens?

■ What if I am a primary user who can see other companies’ information?

■ How can a user’s address information be changed?
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■ What if I have removed a permission and now I want to restore the original 
values?

■ How can a user add more than three attachments to a service request?

■ How does selecting a default responsibility for users on the iSupport UI work?

11.6.0.1 How do I customize Oracle iSupport?
Oracle JDeveloper can be used for Oracle iSupport custom development. It can be 
used to write, debug, deploy and test Java and JSP applications. 

Note: However, not every aspect of Oracle iSupport is customizable. Much of the 
Homepage code is generated in the PL/SQL layer, and to customize it you have to 
modify the PL/SQL packages.

11.6.0.2 How do I remove links in the How Can We Help You? bin on the 
Homepage?
Currently, the only way to eliminate a link from the help bin is to comment out the 
HTML section that generates the link in the procedure. Unfortunately, in the current 
code, you cannot afterward place the link back in. 

The bin is generated from the IBU_HELP_BIN package, get_html procedure.

11.6.0.3 Does Oracle iSupport support different languages?
Yes. Oracle iSupport is NLS and MLS compliant. 

Note: Some hard-coded HTML, messages, and/or displays may appear in English.

■ National Language Support (NLS) - Running of applications in one 
non-American English language.

■ Multi Language Support (MLS) - Running of applications in more than one 
language, one of which is the base language.

See OracleMetaLink for the latest NLS and MLS release notes.

11.6.0.4 Can users renew a contract through Oracle iSupport?
No, the current functionality in Oracle iSupport allows you to view contract 
information. Contract renewal can be done through Order Management or 
Contracts Core applications.
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11.6.0.5 What is the relationship between iSupport and TCA?
Trading Community Architecture is the name used in external marketing by Oracle 
to describe what is internally known as the TCA data model and architecture. TCA 
is an architecture concept designed to support complex trading communities. The 
goal of TCA is to provide the foundation for the entire Oracle E-Business Suite. To 
do this, TCA strives to model all relationships within a trading community. This 
enables one data model to store B2B, B2B2C, B2C, and B2C2C data.

For example, the trading community of an appliance manufacturer may include 
suppliers, distributors, resellers, retailers, service providers, individual consumers, 
and business consumers. The appliance manufacturer not only wishes to track 
relationships between itself and other entities within the trading community, the 
manufacturer may also be interested in relationships that other community 
members have with each other. The manufacturer may not even have direct 
relationships with all the members of its trading community. But, it is important 
that the appliance manufacturer know about these entities and how they relate to 
other entities within the community.

In summary, there is only one customer data model/schema used both by ERP and 
CRM. The 11i Customer Model is not a product that can be purchased. Rather, it is 
the underlying data model that stores customer information and is included with 
any CRM or ERP application. All CRM modules utilize the Customer Model to store 
customer information, although the degree to which the Customer Model is utilized 
differs from module to module. 

11.6.0.6 What is the significance of the account number in iSupport?
The account number represents a customer’s financial record/account. In Oracle 
iSupport, an account number is required to create a service request. Also, all 
real-time accounts inquiries in Oracle iSupport are based on the account number. 

B2C (individual) customers are assigned account numbers automatically by the 
system when they register. Customers can view their account numbers by 
navigating to the Profile screens (Profile > Accounts). 

B2B (business) users can be assigned multiple accounts during or after registration 
approval. Account assignments are made on the JTF sysadmin console by a B2B 
user’s primary user or merchant administrator. B2B users can view their account 
numbers and set a default account number in the Profile screens (Profile > 
Accounts).
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11.6.0.7 How do users reset their passwords?
Access the user’s profile information (Profile > Personal Profile) and enter a new 
password. Select Update on the page to save changes.

11.6.0.8 What type of users can change their first and last names in the Personal 
Profile?
B2B and B2C users can change their first and last names, but employee users 
cannot.

11.6.0.9 What type of users can see company profile information?
B2C users and employee users cannot see company profile information in the 
profile screens. The company information is applicable only to B2B users, and is 
contained in the TCA.

11.6.0.10 What causes permission errors under the Profile menu?
Users need IBU_PROFILE_VIEW or IBU_PROFILE_UPDATE permissions to view 
and update their profile pages.

11.6.0.11 Why would a user not be able to see the side menus in the profile 
screens?
Users need the seed data for JTF_USER_PROFILE_TYPE to access these menus.

11.6.0.12 What if I am a primary user who can see other companies’ 
information?
If this occurs, check the roles (collections of permissions) assigned to you. Most 
likely, you have been assigned a role that contains one of the following permissions:

■ IBU_USER_MGMT_VIEW_ALL_COMPANY

■ IBU_USER_MGMT_VIEW_ALL_ROLE

These two permissions should only be given to an administrator who has the 
privilege to view information across companies. 

11.6.0.13 How can a user’s address information be changed?
The application administrator or primary user can change the addresses and contact 
points (phone, fax, e-mail data) of a user by searching for the user in the 
administration screens, selecting the underlined hyperlink of the username, and 
selecting the Profile button. From there, the administrator or primary user can 
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navigate to appropriate user information from the hyperlink menu to the left of the 
Profile screens.

Users themselves can select the Profile button to access and change their address 
and contact points information.

11.6.0.14 What if I have removed a permission from a role and now I want to 
restore the original values of the role?
Re-run the driver that creates the permissions.

11.6.0.15 How can a user add more than three attachments to a service request?
On the service request creation window in Oracle iSupport, there are enough 
rows/blank entry areas to add only three attachments. If a user wishes to add more 
than three attachments to the service request, this can be done by going ahead and 
creating the service request, and then accessing the details of the service request. In 
the Service Request Details window, the user can add more attachments to the 
service request. Another way would be to zip (or compress or tar) the attachments 
into one file before attaching them to the service request.

11.6.0.16 How does selecting a default responsibility for users on the iSupport 
UI work?
A user can select a default responsibility from the Profile > Preferences menu. The 
next time the user logs in, the default responsibility chosen previously will be the 
default responsibility he logs in with. When the user selects the default 
responsibility, this overrides any default responsibility that the administrator has 
selected for the user. Conversely, if the administrator selects a default responsibility 
for the user from the Administration > Profile > Preferences menu, then when the 
user logs into the JTF login, the user will be logged in with the default responsibility 
chosen by the administrator. If a user logs in without a default responsibility having 
been set, then the user will be asked to choose from a list of responsibilities. This, 
however, can cause errors if the default responsibility the user selects in the prompt 
window is for a Forms-based product. To avoid problems ensure that all users 
always have at least one responsibility defined.
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A
Profile Options

This appendix describes the profile option settings needed to implement Oracle 
iSupport. Topics include:

■ Before you Begin

■ About User Profile Options

■ How to Set Profile Options

■ JTT Profile Options

■ Oracle User Management Profile Options

■ Oracle iSupport Profile Options

■ Oracle Service Profile Options

■ Returns Profile Options

■ Knowledge Management Profile Options

■ Miscellaneous Profile Options

A.1 Before You Begin
Before making Oracle Forms application settings, ensure that Oracle Forms 
application is up and running. All of the steps in this section require you to log onto 
Oracle Forms application with the sysadmin login.

A.2 About User Profile Options
A user profile is a set of changeable options that affect the way Oracle applications 
appear and how they function. Oracle Applications uses a set of user profile options 
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that are common to all the applications. In addition, each module has its own 
unique set of user profile options. 

For a complete list of profile options in the Oracle Application Object Library, see 
Oracle Applications System Administrator’s Guide.

The system administrator sets user profile options at four levels that have a set 
hierarchy. From lowest level to highest, the profiles categories are:

1. Site - Option settings pertain to all users at an installation site; has the lowest 
priority.

2. Application - Option settings pertain to all users of any responsibility 
associated with the application; has the next-to-lowest priority.

3. Responsibility - Option settings pertain to all users currently signed on under 
the responsibility; has the second-highest priority.

4. User - Option settings pertain to an individual user, identified by application 
username; has the highest priority.

Each user profile ordinarily exists at each level. For example, Oracle Applications 
provides a site-level Printer option, an application-level Printer option, a 
responsibility-level option, and so on. Oracle Applications enforces the level 
hierarchy to ensure that a higher-level option value overrides a lower-level value, 
with Site being the lowest and User the highest in the hierarchy. If, for example, you 
set your site-level Printer option to print to Printer 1, but your user-level Printer 
option is set to Printer 2, then printing occurs at Printer 2. 

Site-level option values are generally set by the system administrator before profile 
options are specified at the other three levels. The options specified at site-level 
work as defaults until the same options are specified at the other levels. 

Changes to the user profile option values take effect as soon as your users log on 
again or change responsibilities.

A.3 How to Set Profile Options
Use the following procedure to set any profile option.

Steps
1. Log in to Oracle Forms with System Administrator responsibility.

2. Navigate to Profile > System. The Find System Profile Values window opens.

3. Select the level(s) at which you wish to set the profile option. 
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■ Site

■ Application - If you choose this level, from the Application LOV, select the 
application for which you wish to set the profile option.

■ Responsibility - If you choose this level, from the Responsibility LOV, 
select the responsibility for which you wish to set the profile option.

■ User - If you choose this level, from the User LOV, select the user for whom 
you wish to set the profile option.

4. In the Profile field, enter the a partial profile name followed by the percent sign 
as a wildcard. Example: %iSUPPORT%. 

5. Select Find. The System Profile Values window opens with the results of your 
search.

6. Verify or set the profile option(s) at the levels that you selected.

7. Save your work.

A.4 Setting Oracle User Management Profile Options
The following is a list of profile options that affect the behavior of the Oracle (JTF) 
User Management module. Set these profile options at the site level according to 
your requirements. 

For additional information on Oracle User Management, please see the Oracle 
Common Application Components User’s Guide, (user management chapters) and 
Oracle Common Application Components Implementation Guide (setting up users 
section).

■ JTF_UM_APPROVAL_URL - Defines the absolute path of the login page 
(jtflogin.jsp) that an approver must go to in order to accept or reject a request. 
The URL is included in the workflow notification sent to each approver. The 
same URL is sent to the user after their request is accepted or rejected.

■ JTF_UM_MERCHANT_NAME - Defines the name of your organization. The 
workflow inserts this name into the request approvals and rejections when they 
are sent to the user.

■ JTF_UM_APPROVAL_OWNER - Set by default to sysadmin, this profile 
option is used in the approval process. If the last approver in a predefined 
approval definition fails to approve a request, the person defined in this profile 
option will be the escalation point of contact and will receive the request. The 
user specified as the value for this profile option must have the CRM_HTML_
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ADMINISTRATION responsibility and the JTF_REG_APPROVAL and JTF_
SECURITY_ASSIGN_ROLE permissions.

■ JTF_UM_APPROVAL_TIMEOUT_MINS - Defines (in minutes) how long a 
workflow notification remains in a queue before it is timed out. The default is 
1440 (1 day). If you enter 0 as the value, no time out occurs. If no value is set, 
the profile option is defaulted to 0.

Note: The Process Timeout field in the parameters window when starting the 
JTF Approval workflow must be set to Yes for this profile option to take effect.

■ JTF_REGISTRATION_CACHE - Determines whether the browser will cache 
the data entered by a user during the registration flow. The default value is Yes. 
If set to Yes and if the user presses the Back button, then the data entered on the 
previous page is available. If the profile option is set to No, then the data (page) 
expires as soon as the user leaves the page.

■ JTF_PRIMARY_USER - Predetermines the username that corresponds with the 
Universal Primary User Approver. 

■ JTF_INDIVIDUALUSER_ACCOUNT - When set to Yes, this profile option 
creates a new account (in the HZ_CUST_ACCOUNTS table) for each individual 
user. It also associates the user with the corresponding account. Users must 
have an account in order to purchase products through Oracle iStore.

A.5 Oracle Common Application Components (JTT) Profile Options
Several Oracle Common Application Components (JTT) profile options must be set 
for the Oracle iSupport UI to appear. The values of the JTT profiles set the basic JTT 
Foundation default elements and values. These profiles are seeded in the Profiles 
window in ERP, and values are defined by the user (as System Administrator). 

These affect all users logged in with any responsibility that is associated with the 
application.

Steps
1. Log on to Oracle Forms as sysadmin/sysadmin.

2. Select the System Administrator responsibility.

3. Navigate to Profile > System > Find System Profile Values window.

4. Query the system for JTF profile options:

a. Check the Application checkbox. Clear the Site checkbox, if necessary.
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b. Enter iSupport in the Application field.

c. In the Profile field, enter JTF_PROFILE%, and select Find.

5. Verify and/or set the following JTF profile option for Oracle iSupport. Use the 
topic below, Finding Responsibility ID and Application ID Values, for 
assistance.

■ JTF_PROFILE_DEFAULT_RESPONSIBILITY - This value tells the system 
which responsibility to grant to users who are automatically approved by 
the system. This default responsibility ID is different in every instance. Use 
the following steps to find this value.

Finding Responsibility ID and Application ID Values

Use the following steps to find the APPLICATION_ID and RESPONSIBILITY_
ID value of a responsibility.

a. Log in to the Oracle Forms application as sysadmin. Select System 
Administrator responsibility. Navigate to Security > Responsibility > 
Define. The Responsibilities window opens.

b. From the top menu, select View > Find. Search for the responsibility that 
you wish to be the default responsibility, highlight it, and click Ok in the 
search window. The Responsibilities window is populated with the record 
for the selected responsibility.

c. With the cursor in any field of the record, select Help > Diagnostics > 
Examine. The Examine Field and Variable Values window opens.

d. In the Examine Field and Variable Values window, select APPLICATION_
ID from the Field LOV. The Value field displays the value of 
APPLICATION_ID.

e. In the Examine Field and Variable Values window, select 
RESPONSIBILITY_ID from the Field LOV. The Value field displays the 
value of RESPONSIBILITY_ID.

6. Verify and/or set these additional JTF profile options for Oracle iSupport:

■ JTF_PROFILE_DEFAULT_APPLICATION - 672.

This sets the default application. This must be set to the Oracle iSupport 
application ID, 672.

■ JTF_PROFILE_DEFAULT_BLANK_ROWS - 3

This sets the default number of blank rows in tables on the Oracle iSupport UI. 
It can be set to any integer greater than zero. The recommended value is 3.
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■ JTF_PROFILE_DEFAULT_CSS - jtfucss.css

This designates the default cascading style sheet to use for HTML display. The 
recommended value is jtfucss.css.

■ JTF_PROFILE_DEFAULT_CURRENCY - USD

This tells the application which country’s monetary currency to use as a default. 
Set it to USD for U.S. Dollars if this is what you wish the default currency to be.

■ JTF_PROFILE_DEFAULT_NUM_ROWS - 10

This tells the application how many rows to display when displaying tables on 
the UI. The recommended value is 10.

■ JTF_NAV_CUSTOM_RENDERER 

This enables a custom menu with the java class name.

A.6 Oracle iSupport Profile Options
This section describes the profile options in Oracle iSupport. Many of them are 
required For the service request functionality to work in Oracle iSupport, and you 
must set profile options in Oracle Forms. These profile values are specific to Oracle 
iSupport. For Oracle TeleService profile options, see the Oracle TeleService 
Implementation Guide.

Name of Profile Option Description

Oracle iSupport: Address 
Field Mandatory in Service 
Request Creation

Possible Values: 

■ Yes

■ No (default) 

Oracle iSupport: 
Configuration of Selection 
of Service Request 
Templates

Configures the showing of template names during service 
request creation. This profile can be set at all levels: Site, 
Application, Responsibility, and User.

Oracle iSupport: Default 
Attachment Category for 
Uploading an Attachment

Distinguishes between the attachments uploaded by internal 
support agents and the ones that are uploaded by customer 
and employee users. The administrator can specify a different 
attachment category (user defined) for customers and 
employee users when attachments are uploaded during the 
creation and updating of service requests. This profile option 
can be set at four different levels: Site, Application, 
Responsibility, and User.



Oracle iSupport Profile Options

Profile Options A-7

Oracle iSupport: Default 
Closed Status 

This is the closed status of a service request when the user 
selects the Close button. However, when status transition is 
used, sysadmin needs to make sure that this status is a valid 
next status. Otherwise the applications error out. This value is 
mandatory and can be set at application and site levels.

Oracle iSupport: Default 
KM Solution Note Type

Oracle iSupport: Default 
Note Type for Call Back 
Note

Stores the default note type for the callback note. The callback 
note is the question or statement that the customer enters 
while placing a callback request. 

Oracle iSupport: Default 
Service Request 
Attachment Category

Possible Values: Miscellaneous (default value)

Can be set at all levels – Site, Application, Responsibility, and 
User

Oracle iSupport: Default 
Solved Service Request 
Status 

This value determines the status of the service request when it 
is solved after a knowledge base search in Oracle iSupport. 
This value is mandatory, and can be set at application and site 
levels.

Oracle iSupport: Default 
Updated Service Request 
Status

During service request update, automatically highlights a 
particular service request status in the Status dropdown list 
on the Service Request Details page. A user does not need to 
explicitly select a status when updating a service request. 
However, the user still has the option to select a status from 
the status dropdown field if needed.

Oracle iSupport: Default 
Updated Service Request 
Status

Determines the default state of a service request when it is 
updated.

Oracle iSupport: Display 
Only Return Lines in 
Return Detail

Displays only return lines or return lines plus order lines in 
return detail.

Oracle iSupport: Enable 
Guest User 

Indicates whether a service organization wants to utilize guest 
user functionality. 

Possible Values:

■ No (default value) – guest user feature not enabled

■ Yes – guest user feature enabled 

Name of Profile Option Description
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Oracle iSupport: Enable 
Interaction Logging

Controls whether or not an interaction and interaction 
activities are created in the Interaction History tables when a 
service request is created or updated in Oracle iSupport. The 
service request log in Oracle iSupport shows these 
interactions if this profile is set to Yes.

Possible values:

■ Yes

■ No (default value at the Application level)

If this profile is set to Yes, then you must set up the profile 
option Service: Default System Resource.

Oracle iSupport: Enable 
Platform in Template 
Search

Determines whether to use a platform in the criteria to search 
a template. 

Oracle iSupport: Enable 
Problem Code in Template 
Search

Determines whether to use a problem code in the criteria to 
search a template. 

Oracle iSupport: Enable 
Product in Template Search

Determines whether to use a product in the criteria to search a 
template. 

Oracle iSupport: Enable 
Request Type, Product, and 
Problem Code Mapping

Determines whether, in Oracle iSupport, problem codes can 
be associated with service request types and/or inventory 
items in a many to many relationship. This profile option can 
be set at all levels – Site, Application, Responsibility, and User.

Possible values:

■ Yes: Enable the mapping between problem code, request 
type, and product.

■ No: Do not enable the mapping between problem code, 
request type, and product.

Name of Profile Option Description
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Oracle iSupport: Enable 
Responsibility and Type 
Mapping

Determines whether, in Oracle iSupport, the service request 
types can be associated with responsibilities in a many to 
many relationship. The Service Request Create window, 
depending on the setup, may display only the service request 
types associated with a user’s current responsibility or the 
entire web enabled service request types.

Possible values: 

■ Yes: Mapping between the service request type and 
responsibility will be used during service request 
creation. 

■ No: Mapping between the service request type and 
responsibility will be used during service request creation 
mapping table 

Oracle iSupport: Enable 
Service Request Template

Determines whether service request template is able to be 
used. Yes: enable the template in creating a service request. 
No: do not use the template,show note type page. 

Oracle iSupport: Enable SR 
Type in Template Search

Determines whether to use a service request type in the 
criteria to search a template. 

Oracle iSupport: Enable 
Urgency in Template 
Search

Determines whether to use urgency in the criteria to search a 
template. 

Oracle iSupport: Enforce 
Entitlement Check Option

-

Oracle iSupport: Enforce 
Product Selection Option

This value determines whether a product is mandatory while 
creating a service request. Not mandatory. Can be set at all 
levels.

Oracle iSupport: Guest 
User Quick Find Display

Possible Values: 

■ No (default value) – Quick Find is not displayed to guest 
users 

■ Yes – Quick Find is displayed to guest users

Can only be set at the Site level.

Oracle iSupport: Guest 
User Responsibility

Determines what responsibility is assigned to a guest user 
when entering iSupport guest enabled pages.

Valid Values: Any valid responsibility

Default Value: IBU_GUEST_USER_RESP (iSupport Guest 
User)

Name of Profile Option Description
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Oracle iSupport: 
Homepage Display 
Message

-

Oracle iSupport: 
Homepage Login Bin 
Menu Name 

For the login bin menu, which supplies the login bin content.

Oracle iSupport: 
Homepage Quick Menu 
Name

 For Quick Menu or the Support Resources bin

Oracle iSupport: 
Implementation Class of 
CIC Interface

-

Oracle iSupport: Internal 
Organization for Employee 
Service Request

-

Oracle iSupport: iSupport 
Home Page Show Welcome 
Text to Guest User

Possible values:

■ Yes

■ No (default value)

Oracle iSupport: 
Mandatory Layout Time 
Stamp

Determines the value for the time stamp recorded on creation 
of a mandatory layout.

Oracle iSupport: Page 
Level Configuration 
Option

Possible values:

■ Off (default value) 

■ On 

Oracle iSupport: Pass 
Default Owner to SR API 
When Auto Assignment is 
Off

-

Oracle iSupport: Published 
Status of an Attachment 
Uploaded from iSupport

Specifies different publish statuses (Internal or Published) of 
an attachment for customers and employee users during the 
creation and updating of service requests. This profile option 
can be set at the Site and Responsibility levels.

Oracle iSupport: Search 
Knowledge Base Option

Determines whether a Knowledge Base prompt shows up on 
the Service Request creation page or not, and whether or not 
the Knowledge Base search procedure is required. Not 
mandatory. Can be set at all levels.

Name of Profile Option Description
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Oracle iSupport: Service 
Request Account Option

Possible values:

■ Mandatory with "Select One" Option 

■ Mandatory without "Select One" Option (default value)

■ Optional 

Can be set at the Site and Responsibility levels.

Oracle iSupport: Service 
Request Attachment 
Option

Determines at the site and responsibility levels whether users 
(employees and customers) can view the attachment section 
of the service request in Oracle iSupport. This profile option 
dictates whether or not the user can view the attachment 
section while creating and updating the service request.

Possible values:

■ Do not Show – do not ever show the attachment section

■ Show during Create – show the attachment section only 
during SR creation

■ Show during Update – show the attachment section only 
during SR updates

■ Show during both Create and Update (default value) – 
show the attachment section during service request 
creation and updates

Can be set at the Site and Responsibility levels.

Oracle iSupport: Service 
Request Bill To Address 
Option

Possible values:

■ Mandatory

■ Not Displayed (default value) 

■ Optional

Oracle iSupport: Service 
Request Bill To Contact 
Option

Possible values:

■ Mandatory

■ Not Displayed (default value) 

■ Optional

Oracle iSupport: Service 
Request Closed Note Type

Determines the default Note Type when a Service Request is 
closed.

Oracle iSupport: Service 
Request Configuration 
Option

-

Name of Profile Option Description
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Oracle iSupport: Service 
Request Creation Note 
Type

Determines the default Note Type when a Service Request is 
created. Not mandatory. Can be set at all levels.

Oracle iSupport: Service 
Request Escalate Note 
Type

Determines the default Note Type when a Service Request is 
escalated.

Oracle iSupport: Service 
Request Installed At 
Address Option

Possible values:

■ Mandatory

■ Not Displayed (default value) 

■ Optional

Oracle iSupport: Service 
Request Installed at 
Contact Option

-

Oracle iSupport: Service 
Request Location Address 
Validation Class

Provides an open interface to allow a support organization to 
do address validation based on its needs, like jurisdiction 
checking. 

Oracle iSupport: Service 
Request Product Category 
Set

-

Oracle iSupport: Service 
Request Product Option

-

Oracle iSupport: Service 
Request Reopen Time 
Limit in Hours

Set to the time limit in hours within which one can reopen a 
service request.

Oracle iSupport: Service 
Request Ship To Address 
Option

Possible values:

■ Mandatory

■ Not Displayed (default value) 

■ Optional

Oracle iSupport: Service 
Request Ship To Contact 
Option

Possible values:

■ Mandatory

■ Not Displayed (default value) 

■ Optional

Name of Profile Option Description
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A.7 Oracle Service Profile Options
The following service core profile options can be set according to your business 
requirements. See the Oracle TeleService Implementation Guide for further information 
about these and other Oracle Service profile options.

Oracle iSupport: Service 
Request Template Option

Possible values

■ Do not Include Default and Highlight “Select One” 
Option

■ Do not Include Default and Highlight First One

■ Include Default and Highlight “Select One” Option 
(default value) 

■ Include Default and Highlight Default

■ Include Default and Highlight First One

Can be set at all levels – Site, Application, Responsibility, and 
User.

Oracle iSupport: Service 
Request Update Note Type

Determines the default Note Type used when a Service 
Request is updated. Not mandatory. Can be set at all levels.

Oracle iSupport: Show 
Address Section in Service 
Request

Possible values: 

■ Yes

■ No (default) 

Oracle iSupport: Show 
Task in Service Request 
Module 

Indicates whether the related published tasks for a service 
request are shown to a user or not. The possible values are:

■ Yes: The Service Request Details Page displays a task 
section showing published tasks. Tasks are also shown in 
the log section of the service request

■ No: The Task section is hidden from the Service Request 
Details Page, and no task is shown in log section.

This profile option can be set at all the levels – Site, 
Application, Responsibility and User.

Service: Restrict Installed 
Base for location validation

Possible values: 

■ Yes

■ No

No default value.

Name of Profile Option Description
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■ Service: Default Service Request Severity: Determines the default severity of a 
created service request. 

■ Service: Default Service Request Status: Determines the default status of a 
created service request. 

■ Service: Default Service Request Type: Determines the default type of a 
created service request. 

■ Service: Default Service Request Urgency: Determines the default urgency of a 
created service request. 

■ Service: Default Service Request Owner: Determines the default Resource ID 
when a Service Request is created. This should be set at the application level.

■ Service: Default Service Request Owner Type: Determines the default owner 
type of a created service request. 

■ Service: Default Product Category Set: Determines the default product 
category set for a service request. 

■ Service: Default Platform Category Set: Determines the default platform 
category set for a service request. 

■ Service: Inventory Validate Organization: Maps Inventory/Product 
Organization.source:

■ Service Item Flexfield (Product): This value determines the Oracle Inventory 
key flexfield structure you want to use when displaying the product. This value 
is mandatory; without it, the system will be unable to display the product 
number. It is recommended that you set this profile to MSTK. Set at application 
and site levels.

■ Service: Item Flexfield (Service): This value determines the Oracle Inventory 
key flexfield structure you want to use when displaying support services. This 
value is mandatory. It is recommended that you set this profile to MSTK. Set at 
application and site levels.

■ Service: System generated Service Request Number 

■ Service: Active Knowledge Base System - Selection for which integrated 
HTML based Knowledge Base System is being used. Allowed values: Oracle 
Basic Knowledge Base Search, Oracle Advanced Knowledge Base Search.

■ Service: Auto Launch Workflow - Determines whether Workflow launches 
automatically when a service request is created.
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■ Service: Allow Updates Across Organizations - Allows users to make updates 
and deletions to data not belonging to their own operating units. Set to Yes.

■ Service: Use SR Type – Responsibility Mapping - No default values.

■ Service: Restrict Installed Base for Location Validation - Possible values are 
Yes and No, with no default value.

■ Service: Default Make Public Flag 

■ Service: Publish Flag Update Allowed 

■ Service: Time Unit of Measure Class

■ Service: Minute Unit of Measure

■ Service: Hour Unit of Measure 

■ Service: Day Unit of Measure - Identifies the unit of measure representing the 
day. This option is required.

■ Service: Month Unit of Measure 

■ Service: Item for facilitating conversions of units of time Service: INC_
DEFAULT_INCIDENT_OWNER - Determines the default Resource ID when a 
service request is created. Set this at the application level.

A.8 Returns Profile Options
The following profile options allow returns functionality in Oracle iSupport:

■ ASO: Default Order Type - This profile determines how the order is to be 
processed in Oracle Order Management. The order types are set up in Oracle 
Order Management. This profile also determines what price list and currency 
code appear by default in the main Quoting window. If this profile value is null, 
no default value is assumed. Set to Mixed.

■ ASO: Default Order State - Set to Booked.

■ ASO: Enable ASO Debug - Set to Yes to allow returns debugging. 

■ ASO: Product Organization - Defines which product organization to look for 
products. Note the space between the name ASO and the colon (:) in the name of the 
profile. Set this to your master organization.

■ ASO: Validate Salesrep - This profile is used to determine whether a Sales 
representative must be specified on a quote prior to creating an order. If this 
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profile is set to Yes, a sales representative must be specified on the quote prior 
to creating an order. If this profile is set to No, then a sales representative will be 
defaulted from ASO: Default Salesrep. If this profile value is null, a default 
value of Yes is assumed. For Oracle iSupport, set this value to No.

■ OM: Debug Level - This profile option determines the level of debug messages 
printed in a OE Debug log file. To print all messages set it to 5 and for no 
messages set it to NULL. The default value is NULL.

■ OM: DEBUG LOG Directory - The directory path of the OM debug log file. 
Specify the value from the session parameter utl_file_dir from 
v$parameters. The default value is NULL. 

A.9 Oracle Knowledge Management Profile Options
Oracle Knowledge Management has its own set of profile options. If you are 
implementing Knowledge Management, set the following profile options:

■ CS_KB_ALLOW_KB_NOTE_UPDATE - Allows the update of notes that have 
been saved to the Knowledge Base. Seeded value: No. Allowed values: No, Yes

■ CS_KB_DEFAULT_SOLUTION_TYPE - Allows you to define a specific 
Solution Type as a default. Allowed values: any. Seeded default values: 

■ KB_SYMPTOM

■ KB_FACT

■ KB_CHANGES

■ KB_CAUSE

■ KB_OBJECTIVE

■ KB_ACTION

■ CS_KB_DEF_CONTRIBUTION_STATUS - Default Status for Knowledge Base 
Contributions: You can use the status with user privileges to determine which 
users can see what information. Seeded default value: Draft. Allowed values:

■ DRAFT

■ PUBLIC

■ PUBLIC_INTERNAL

■ TECHNICAL_REVIEW

■ UNDER_EDIT
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■ PUBLIC_LIMITED

■ CS_KB_MAX_SEARCH_RESULTS - Maximum Number of Search Results to 
be Queried from the Database: You can set up this value to any reasonable 
number. The top scored results in the database will be displayed from the 
highest score to the lowest score. Seeded default value: 100

■ CS_KB_PRODUCT_CATEGORY_SET - Service: Default Knowledge Base 
Category Set. This selects the Product Category Set to populate the Product 
LOV in the Knowledge Management windows. 

A.10 Miscellaneous Profile Options
A number of profile options categorized here as miscellaneous should be set at the 
site-level.

■ MO: Operating Unit - Set this to your master organization.

■ OE: Item Validation Organization - Set this to your master organization.

■ APPS_SERVLET_AGENT - This is the URL that will be used to call JSP forms 
from applications menus. Set to the URL for the Apache server.
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B
Seed Data

This appendix lists that data that ships with Oracle iSupport as seed data, or data 
that is shipped "out-of-the-box." Covered here are: 

■ Seeded Menus

■ Seeded Functions

■ Seeded User Responsibilities

■ Seeded User Roles

■ Seeded Permissions

B.1 Seeded Menus
This section lists menus associated with the application.

B.1.1 Oracle iSupport Menus
The table below, Oracle iSupport Menus, shows the main menus and a description 
of each menu.

Table B–1 Oracle iSupport Menus

Menu Description

IBU_A_FB_MENU Administration > Survey

IBU_A_FORUM_MENU Administration > Forum

IBU_A_FR_CATEGORY_MENU Administration > Forum > Category

IBU_A_FR_FORUM_MENU Administration > Forum > Forum

IBU_A_FR_USERGROUP_MENU Administration > Forum > Usergroup
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IBU_A_PROFILE_MENU Administration > Homepage

IBU_A_RM_MENU Administration > Support > Request Management

IBU_A_ROOT_MENU Administration tabs: User, Homepage, etc.

IBU_A_SUB Administration > Homepage > Subscription

IBU_A_SUPPORT_MENU Administration > Support

IBU_A_USER_MENU Administration > User

IBU_ACCOUNT_MENU Account submenu

IBU_BUS_USER_HELP_MENU - Menu for home page bin for business users

IBU_BUS_USER_PROFILE_MENU Profile menu for B2B user

IBU_BUS_USER_TOP_MENU Top menu for iSupport B2B user

IBU_DEFAULT_CONFIG_MENU Menu for default configuration UI

IBU_EMP_USER_HELP_MENU Menu for home page bin for employee users

IBU_EMP_USER_PROFILE_MENU Menu for employee profile

IBU_EMPL_ISUPPORT_MENU iSupport menu for iSupport employee user

IBU_EMPL_REQ_MENU Support menu for employee users

IBU_EMPL_USER_TOP_MENU Top menu for iSupport employee user

IBU_GUEST_LOGINBIN_MENU Menu for guest user login bin 

IBU_GUEST_SUPPORT_MENU Guest users Support submenu

IBU_GUEST_USER_HELP_MENU Menu for home page bin for guest users

IBU_GUEST_USER_TOP_MENU Top level menu for guest users

IBU_HOME_MENU iSupport > Home

IBU_IB_MENU Home > Products

IBU_IND_USER_HELP_MENU Menu for home page bin for individual users

IBU_IND_USER_PROFILE_MENU User profile menu for iSupport B2C user

IBU_IND_USER_TOP_MENU Top menu for iSupport B2C user

IBU_INQ_MENU iSupport > Account (for sys_admin responsibility)

IBU_ISUPPORT_MENU iSupport (primary user iSupport menu)

IBU_PRI_USER_HELP_MENU Menu for home page bin for primary users

IBU_PRI_USER_REQ_MENU iSupport > Support menu (for iSupport primary user)

IBU_PRI_USER_TOP_MENU Top menu for iSupport primary user

IBU_PROFILE_ACCOUNT_MENU Menu for account settings

Table B–1 Oracle iSupport Menus

Menu Description
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B.1.2 Oracle iSupport Top Menus by User Type
The table below, Oracle iSupport Top Menus by User Type, shows the top menus by 
user type.

B.1.3 Oracle iSupport Menu Structures by User Type
The tables below shows the Oracle iSupport menu structures by user types.

IBU_PROFILE_COMPANY_MENU Company profile menu

IBU_PROFILE_EMP_MENU Side menu for employee  profile

IBU_PROFILE_MENU Menu for iSupport settings

IBU_PROFILE_USER_MENU User profile menu

IBU_REQ_MENU Home > Support

IBU_ROOT_MENU iSupport (sys_admin) responsibility)

IBU_ROOT_MENU_GUEST Guest users iSupport submenu

IBU_ROOT_PROFILE_MENU Root menu for profile

IBU_SUPPORT_MENU Support submenu

Table B–2 Oracle iSupport Top Menus by User Type

Menu Description

IBU_BUS_USER_TOP_MENU Top menu for iSupport Business (B2B) User

IBU_EMPL_USER_TOP_MENU Top menu for iSupport Employee (B2E) User

IBU_GUEST_USER_TOP_MENU Top menu for iSupport Guest User

IBU_IND_USER_TOP_MENU Top menu for iSupport Individual (B2C) User

IBU_PRI_USER_TOP_MENU Top menu for iSupport Primary User

IBU_SYS_ADMIN_TOP_MENU Top menu for iSupport Administrator

Table B–3 Menu Structure for an Oracle iSupport Business User

Global Level 1 Level 2

iSupport Home -

- Accounts Orders

Table B–1 Oracle iSupport Menus

Menu Description
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- - Invoices

- - Payments

- - Contracts

- - Returns

- - Products

- Support Ask Me

- - Technical Library

- - Forum

- - View/Update Request

- - Create Request

Profile User Profile Personal Profile

- - Contact Points

- - Addresses

- - Navigation Preferences

- - Display Preferences

- - Accounts

- - Support

- - My Enrollments

- Company Profile Information

- - Contact Points

- - Addresses

- - Administrators

Contact Us - -

Feedback - -

Table B–3 Menu Structure for an Oracle iSupport Business User

Global Level 1 Level 2
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Table B–4 Menu Structure for an Oracle iSupport Employee User

Global Level 1 Level 2

iSupport Home -

- Support (same as a business user)

Profile User Profile Personal Profile

- - Contact Points

- - Addresses

- - Navigation Preferences

- - Display Preferences

- - Support

Feedback - -

Table B–5 Menu Structure for an Oracle iSupport Guest User

Global Level 1 Level 2

iSupport Home -

- Support Solutions

- - Technical Library

Login - -

Register - -

Table B–6 Menu Structure for an Oracle iSupport Individual User

Global Level 1 Level 2

iSupport Home (same as a business user)

- Accounts (same as a business user)

- Support (same as a business user)

Profile User Profile (same as a business user)
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Table B–7 Menu Structure for an Oracle iSupport Primary User

Global Level 1 Level 2

iSupport Home (same as a business user)

- Accounts (same as a business user)

- Support (same as a business user)

Profile (same as a business user) -

Contact Us - -

Feedback - -

Administration User -

- Pending Approvals -

Table B–8 Menu Structure for an Oracle iSupport Administrator

Global Level 1 Level 2

iSupport (same as employee user) -

Profile (same as a business user) -

Feedback - -

Administration User User

- - Pending Approvals

- Homepage Content

- - Subscription

- Support Request Template

- - Call Me

- - Survey

- - Technical Library

- - User Group

- Forum Category

- - Forum
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B.2 Oracle iSupport Functions
The table below, Oracle iSupport Functions, shows the functions that are linked to 
menus, along with a description of each function.

- - Message

- - User Group

- Solutions Knowledge

- - Authoring

- - Setup

- MES Categories

- - My Channels

- - Publish

- - Administration

Table B–9 Oracle iSupport Functions

Function Description

IBU_ACCOUNT_CONTACT not used

IBU_A_CAT_FN Administration > Support > Technical Library

IBU_A_CM_FN Administration > Support > Call Me

IBU_A_FB_LIST_FN Administration > Survey > Feedback List

IBU_A_FR_CT_CREATE_FN Administration > Category > Create

IBU_A_FR_CT_DELETE_FN Administration > Category > Delete

IBU_A_FR_CT_MODSTATUS_FN Administration > Category > Modify

IBU_A_FR_CT_RENAME_FN Administration > Category > Rename

IBU_A_FR_FR_CREATE_FN Administration > Forum > Create

IBU_A_FR_FR_DELETE_FN Administration > Forum > Delete

IBU_A_FR_FR_MODATTR_FN Administration > Forum > Modify Attribute

IBU_A_FR_FR_MODSTATUS_FN Administration > Forum > Modify Status 

IBU_A_FR_FR_MOVE_FN Administration > Forum > Move 

IBU_A_FR_FR_RENAME_FN Administration > Forum > Rename 

Table B–8 Menu Structure for an Oracle iSupport Administrator

Global Level 1 Level 2
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IBU_A_FR_MESSAGE_FN Administration > Forum > Messages 

IBU_A_FR_UG_ASSC_FN Administration > Forum > Associate Usergroup 

IBU_A_FR_UG_DISASSC_FN Administration > Forum > Disassociate Usergroup 

IBU_A_PZ_FN Administration > Homepage > Personalize

IBU_A_RM_FN Administration > Support > Request Management 

IBU_A_RM_TEMPLATE_FN Administration > Support > Request Management > Template 

IBU_A_RPT_FN Not used in generic product.

IBU_A_SUB_FN Administration > Homepage > Subscription subtab

IBU_A_TM_FN Administration > Subscription > Template

IBU_A_UG_FN Administration > Support > Usergroup

IBU_A_USER_APPROVALS_FN Administration > User > Pending Approvals

IBU_A_USER_FN Administration > Users

IBU_CMN_FORUM Forum tab 

IBU_COMPANY_ADDRESS Profile > Company address

IBU_COMPANY_ADMIN Profile > Company Administrators 

IBU_COMPANY_CONTACT_POINTS Profile > Contact points of company 

IBU_COMPANY_INFORMATION Profile > Company Information 

IBU_GEN_PREF Profile > General Preferences 

IBU_HLP_CALLME Support > Contact Us

IBU_HLP_FEEDBACK Support > Survey

IBU_HOM_HOME iSupport Home

IBU_INQ_ACCOUNT Accounts

IBU_INQ_CONTRACTS Accounts > Contracts

IBU_INQ_DEFECTS Defects

IBU_INQ_INSTALLBASE Install Base

IBU_INQ_INSTALLBASEREPORT Install Base Report

IBU_INQ_INSTALLBASE_ADDPRODUCT Install Base Add Product

IBU_INQ_INSTALLBASE_BUILT Install Base as Built

IBU_INQ_INSTALLBASE_SUMMARY Install Base Summary

IBU_INQ_INVOICES Accounts > Invoices

IBU_INQ_ORDERS Accounts > Orders

Table B–9 Oracle iSupport Functions

Function Description
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B.3 Seeded User Responsibilities
The table below, Oracle iSupport User Responsibilities, displays seeded user 
responsibilities and their descriptions.

IBU_INQ_PAYMENTS Accounts > Payments

IBU_INQ_RMAS Accounts > Returns

IBU_LOGIN_FN JTF Login page. If you want to use your own login page or to use the 
guest user home page as the login page, then you can customize IBU_
LOGIN_FN to point to the appropriate JSP.

IBU_PERSONAL_PROFILE Profile button

IBU_PROFILE_CONTRACT not used

IBU_PROFILE_GENERAL Profile > User Profile > Support

IBU_REGISTER_FN JTF Register page

IBU_REQ_ASKME Search Knowledge Base

IBU_REQ_CREATESR Support > Create Service Requests

IBU_REQ_VIEWSR Support > View Service Requests

IBU_SYSTEM_ADD not used

IBU_SYSTEM_ADM not used

IBU_SYSTEM_CSI not used

IBU_SYSTEM_LIC not used

IBU_SYSTEM_PRF not used

IBU_SYSTEM_ROL not used

IBU_SYSTEM_USR not used

IBU_USER_ACCOUNTS Profile > User Profile > Accounts

IBU_USER_ADDRESSES Profile > User Profile > Addresses

IBU_USER_CONTACTPOINTS Profile > User Profile > Contact Points

IBU_USER_CONTRACTS not used

Table B–9 Oracle iSupport Functions

Function Description
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B.4 Seeded User Roles
This section contains information about seeded roles and permissions.

B.4.1 User Roles
The table below, Oracle iSupport User Roles, displays seeded user roles and their 
descriptions.

B.4.2 Oracle iSupport User Roles by User Type
The table below, Oracle iSupport User Roles by User Type, displays Oracle iSupport 
typical users and the roles they must receive to receive their appropriate 
permissions.

Table B–10 Oracle iSupport User Responsibilities

Responsibility Description

IBU_GUEST_USER_RESP iSupport Guest User

IBU_BUSINESS_USER_RESP iSupport Business (B2B) Users

IBU_INDIVIDUAL_USER_RESP iSupport Individual (B2C) User

IBU_EMPLOYEE_USER_RESP iSupport Employee (B2E) Users

IBU_PRIMARY_USER_RESP iSupport Primary User

IBU_SYS_ADMIN For iSupport Administrator user

Table B–11 Oracle iSupport User Roles

Role Description

IBU_B2B_PRIMARY_USER_MANAGEMENT Contains permissions for standard iSupport Primary User.

IBU_EMPLOYEE Contains permissions for standard Employee User.

IBU_GUEST_USER Contains permissions for standard guest users.

IBU_REG_USER Contains permissions for standard registered B2B and B2C 
users.

IBU_SYSTEM_ADMIN Contains permissions for standard iSupport Administrator.
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B.5 Seeded Permissions
This section displays the user roles and the permissions that they contain.

The table below, Oracle iSupport Permissions, displays the permissions associated 
with the seeded user roles.

Table B–12 Oracle iSupport User Roles by User Type

User Roles Assigned

B2C, B2B users IBU_REG_USER

Primary User IBU_REG_USER, IBU_B2B_PRIMARY_USER_MANAGEMENT

Employee User IBU_REG_USER, IBU_EMPLOYEE

Guest User IBU_GUEST_USER

iSupport Administrator IBU_REG_USER, IBU_SYSTEM_ADMIN

Table B–13 Oracle iSupport Permissions 

Role Permissions

IBU_B2B_PRIMARY_USER_
MANAGEMENT

IBU_USER_MGMT

- IBU_USER_MGMT_VIEW_COMPANY_USER

- IBU_USER_MGMT_VIEW_MY_ROLE

- JTF_PRIMARY_USER_SUMMARY

- IBU_ADMIN_UPDATE

- IBU_ADMIN_VIEW

IBU_EMPLOYEE IBU_SR_Upload_Attachment

IBU_GUEST_USER IBU_GUEST_USER. Used in code logic to determine if the 
current user is a guest user. 

- IBU_HOMEPAGE_HIDE_CUSTOMIZE. Used to 
determine if the Customize link should be hidden from 
the user for the home page.

IBU_REG_USER CSI_ACCT_ACCESS_ONLY

- CSI_ADDI_ATTR_UPDATE
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- CSI_ADDI_ATTR_VIEW

- CSI_CONTACT_DETAIL_UPDATE

- CSI_CONTACT_DETAIL_VIEW

- CSI_CONTRACT_UPDATE

- CSI_CONTRACT_VIEW

- CSI_CREATE_INST_UPDATE

- CSI_CREATE_INST_VIEW

- CSI_GENERAL_ATTRIB_CUST_ONLY

- CSI_INST_CONFIG_UPDATE

- CSI_INST_CONFIG_VIEW

- CSI_INST_GENERAL_UPDATE

- CSI_INST_GENERAL_VIEW

- CSI_LATEST_TRANSACTION_UPDATE

- CSI_LATEST_TRANSACTION_VIEW

- CSI_PARTY_CONTACT_UPDATE

- CSI_PARTY_CONTACT_VIEW

- CSI_PERZ_EDIT_UPDATE

- CSI_PERZ_EDIT_VIEW

IBU_REG_USER (cont.) CSI_PRICING_UPDATE

- CSI_PRICING_VIEW

- CSI_PROPERTY_READ

- CSI_REPAIR_ORDER_UPDATE

- CSI_REPAIR_ORDER_VIEW

- CSI_SEARCH_PRODUCT_UPDATE

- CSI_SEARCH_PRODUCT_VIEW

- CSI_SERVICE_REQUEST_UPDATE

- CSI_SERVICE_REQUEST_VIEW

Table B–13 Oracle iSupport Permissions 

Role Permissions
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- CSI_SHOW_EXT_CONTACTS

- CSI_SHOW_EXT_LOCATIONS

- CSI_SHOW_EXT_PARTIES

- CSI_SHOW_INST_CUSTOMER_MENU

- CSI_SPLIT_QUANTITY_UPDATE

- CSI_SPLIT_QUANTITY_VIEW

- CSI_TRANSACTION_DETAIL_UPDATE

- CSI_TRANSACTION_DETAIL_VIEW

- CSI_TRANSACTION_INSTANCE_UPDATE

- CSI_TRANSACTION_INSTANCE_VIEW

- CS_Freq_Used_Sol_View

- CS_Products_Add

- CS_Products_Delete

- CS_Products_Update

- CS_Products_View

- CS_Rec_Sol_View

- CS_Solution_View

- CS_Solution_View_All

IBU_REG_USER (cont.) IBU_CallMe

- IBU_Contracts_View

- IBU_Defects_View

- IBU_Forum

- IBU_Forum_View_Restrict

- IBU_Homepage

- IBU_Homepage_Update

- IBU_Invoices_View

- IBU_Orders_View

Table B–13 Oracle iSupport Permissions 

Role Permissions
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- IBU_Patch_View

- IBU_Payments_View

- IBU_Profile_Update

- IBU_Request_Close

- IBU_Request_Create

- IBU_Request_Escalate

- IBU_Request_Update

- IBU_Request_View

- IBU_Request_View_Account

- IBU_Request_View_Company

- IBU_Returns_Add

- IBU_Returns_View

- IBU_Role_Mgt

- IBU_SR_Upload_Attachment

- IBU_Survey_Create

- IBU_Technical_Library_View

- IBU_User_Mgt

IBU_SYSTEM_ADMIN CS_Assoc_Ext_Obj_To_Sol

- CS_Assoc_Ext_Obj_To_Stmt

- CS_Categories_View

IBU_SYSTEM_ADMIN (cont.) CS_EMPLOYEE_CONTACT_ADD

- CS_Freq_Used_Def_Update

- CS_Freq_Used_Def_View

- CS_Freq_Used_Sol_View

- CS_PROPERTY_UPDATE

- CS_Products_Add

- CS_Products_Delete

Table B–13 Oracle iSupport Permissions 

Role Permissions
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- CS_Products_Report

- CS_Products_Update

- CS_Products_View

- CS_Rec_Sol_Update

- CS_Rec_Sol_View

- CS_Solution_Create

- CS_Solution_Delete

- CS_Solution_Status_Update

- CS_Solution_Update

- CS_Solution_View

- CS_Solution_View_All

- CS_Solution_View_B

- CS_Solution_View_Internal

- CS_Solution_View_Public

- CS_Solution_View_Restricted

- CS_Statement_Create

- CS_Statement_Delete

- CS_Statement_Global_Update

- CS_Statement_Update

- CS_Statement_View

IBU_SYSTEM_ADMIN (cont.) CS_Types_Edit

- CS_Types_View

- CS_Workflow_Setup_View

- IBU_Forum_Category_Edit

- IBU_Forum_Edit

- IBU_Forum_Messages_Edit

- IBU_Forum_User_Group_Edit

Table B–13 Oracle iSupport Permissions 

Role Permissions
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- IBU_Personalized_Homepage_Edit

- IBU_Request_Management_Edit

- IBU_Subscription_Edit

- IBU_Survey_Import

- IBU_TEMPLATE_MANAGEMENT

- IBU_USER_MGMT

- IBU_USER_MGMT_VIEW_ALL_ROLE

- IBU_USER_MGMT_VIEW_ALL_USER

- IBU_USER_MGMT_VIEW_COMPANY_USER

- IBU_USER_MGMT_VIEW_MY_ROLE

- IBU_User_Group_Edit

- JTF_DAC_Maintain

- JTF_REG_APPROVAL

- JTF_SECURITY_ASSIGN_ROLE

- IBU_ADMIN_UPDATE

- IBU_ADMIN_VIEW

Table B–13 Oracle iSupport Permissions 

Role Permissions
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C
Functions and Variables for Page-Level

Configurability

C.1 Functions for Page-Level Configurability
The table in this section lists the functions that are used to place your customized 
Java service pages (JSPs) on content pages that Oracle supplies. With these 
functions, you can configure the high-level look and feel of your Oracle iSupport 
web pages. The end of function names relates to the placement of a customized JSP 
on an Oracle content page as follows:
■ TOP means that a customized JSP will go at the top of the content page.

■ LEFT means that a customized JSP will go at the left of the content page.

■ RIGHT means that a customized JSP will go at the right of the content page.

■ BOTTOM means that a customized JSP will go at the bottom of the content 
page.

l

Table C–1 Functions for Configurability of Look and Fee of Pages

Page Name Function Name

Home Page IBU_HOME_SECTION_TOP
IBU_HOME_SECTION_LEFT
IBU_HOME_SECTION_RIGHT
IBU_HOME_SECTION_BOTTOM

Create Service Request 
First Page

IBU_SR_CNFG_CREATE_MAIN_TOP
IBU_SR_CNFG_CREATE_MAIN_LEFT
IBU_SR_CNFG_CREATE_MAIN_RIGHT
IBU_SR_CNFG_CREATE_MAIN_BOTTOM
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Create Service Request 
Template Page

IBU_SR_CNFG_CREATE_TMPL_TOP
IBU_SR_CNFG_CREATE_TMPL_LEFT
IBU_SR_CNFG_CREATE_TMPL_RIGHT
IBU_SR_CNFG_CREATE_TMPL_BOTTOM

Create Service Request 
Verification

IBU_SR_CNFG_CREATE_VRFY_TOP
IBU_SR_CNFG_CREATE_VRFY_LEFT
IBU_SR_CNFG_CREATE_VRFY_RIGHT
IBU_SR_CNFG_CREATE_VRFY_BOTTOM

Create Service Request 
Confirmation

IBU_SR_CNFG_CREATE_CNFM_TOP
IBU_SR_CNFG_CREATE_CNFM_LEFT
IBU_SR_CNFG_CREATE_CNFM_RIGHT
IBU_SR_CNFG_CREATE_CNFM_BOTTOM

Service Request Details IBU_SR_CNFG_DETAILS_TOP
IBU_SR_CNFG_DETAILS_LEFT
IBU_SR_CNFG_DETAILS_RIGHT
IBU_SR_CNFG_DETAILS_BOTTOM

Service Request Summary IBU_SR_CNFG_SUMMARY_TOP
IBU_SR_CNFG_SUMMARY_LEFT
IBU_SR_CNFG_SUMMARY_RIGHT
IBU_SR_CNFG_SUMMARY_BOTTOM

Service Request Search IBU_SR_CNFG_SEARCH_TOP
IBU_SR_CNFG_SEARCH_LEFT
IBU_SR_CNFG_SEARCH_RIGHT
IBU_SR_CNFG_SEARCH_BOTTOM

Order Summary IBU_ORDERSU_SECTION_TOP
IBU_ORDERSU_SECTION_LEFT
IBU_ORDERSU_SECTION_RIGHT
IBU_ORDERSU_SECTION_BOTTOM

Order Detail IBU_ORDERDT_SECTION_TOP
IBU_ORDERDT_SECTION_LEFT
IBU_ORDERDT_SECTION_RIGHT
IBU_ORDERDT_SECTION_BOTTOM

Order Shipment IBU_ORDERSH_SECTION_LEFT
IBU_ORDERSH_SECTION_RIGHT
IBU_ORDERSH_SECTION_TOP
IBU_ORDERSH_SECTION_BOTTOM

Table C–1 Functions for Configurability of Look and Fee of Pages

Page Name Function Name
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Invoice Summary IBU_INVSU_SECTION_TOP
IBU_INVSU_SECTION_LEFT
IBU_INVSU_SECTION_RIGHT
IBU_INVSU_SECTION_BOTTOM

Invoice Detail IBU_INVDT_SECTION_TOP
IBU_INVDT_SECTION_LEFT
IBU_INVDT_SECTION_RIGHT
IBU_INVDT_SECTION_BOTTOM

Invoice Payment IBU_INVPT_SECTION_LEFT
IBU_INVPT_SECTION_RIGHT
IBU_INVPT_SECTION_TOP
IBU_INVPT_SECTION_BOTTOM

Payment Summary IBU_PAYSU_SECTION_TOP
IBU_PAYSU_SECTION_LEFT
IBU_PAYSU_SECTION_RIGHT
IBU_PAYSU_SECTION_BOTTOM

Payment Detail IBU_PAYDT_SECTION_LEFT
IBU_PAYDT_SECTION_RIGHT 
IBU_PAYDT_SECTION_TOP
IBU_PAYDT_SECTION_BOTTOM

Return Creation IBU_RETCRT_SECTION_TOP
IBU_RETCRT_SECTION_LEFT
IBU_RETCRT_SECTION_RIGHT
IBU_RETCRT_SECTION_BOTTOM

Return Confirmation IBU_RETCONF_SECTION_TOP
IBU_RETCONF_SECTION_LEFT
IBU_RETCONF_SECTION_RIGHT
IBU_RETCONF_SECTION_BOTTOM

Return Summary IBU_RETSUM_SECTION_TOP
IBU_RETSUM_SECTION_LEFT
IBU_RETSUM_SECTION_RIGHT
IBU_RETSUM_SECTION_BOTTOM

Return Detail IBU_RETDET_SECTION_TOP
IBU_RETDET_SECTION_LEFT
IBU_RETDET_SECTION_RIGHT
IBU_RETDET_SECTION_BOTTOM

Table C–1 Functions for Configurability of Look and Fee of Pages

Page Name Function Name
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C.2 Variables for Page-Level Configurability
The table in this section lists the variables that are available to use in your 
customized Java service pages (JSPs). The variables provide access to elements of 
the content that Oracle supplies. 

Return Search IBU_RETSRCH_SECTION_TOP
IBU_RETSRCH_SECTION_LEFT
IBU_RETSRCH_SECTION_RIGHT
IBU_RETSRCH_SECTION_BOTTOM

Technical Library IBU_TECHLIB_SECTION_TOP
IBU_TECHLIB_SECTION_LEFT
IBU_TECHLIB_SECTION_RIGHT
IBU_TECHLIB_SECTION_BOTTOM

Contact Us (Call Me) IBU_CALLBACK_SECTION_TOP
IBU_CALLBACK_SECTION_LEFT
IBU_CALLBACK_SECTION_RIGHT
IBU_CALLBACK_SECTION_BOTTOM

Knowledge Management 
Browse

CS_KB_BROWSE_TOP_FN
CS_KB_BROWSE_LEFT_FN 
CS_KB_BROWSE_RIGHT_FN
CS_KB_BROWSE_BOTTOM_FN

Refer to Oracle Knowledge Management 
Implementation Guide for details on using these 
functions.

Knowledge Management 
Search Result

CS_KB_SEARCH_RESULT_TOP_FN 
CS_KB_SEARCH_RESULT_LEFT_FN
CS_KB_SEARCH_RESULT_RIGHT_FN
CS_KB_SEARCH_RESULT_BOTTOM_FN

Refer to Oracle Knowledge Management 
Implementation Guide for details on using these 
functions.

Knowledge Management 
Solution Detail

CS_KB_SOLN_DETAIL_TOP_FN 
CS_KB_SOLN_DETAIL_LEFT_FN 
CS_KB_SOLN_DETAIL_RIGHT_FN 
CS_KB_SOLN_DETAIL_BOTTOM_FN 

Refer to Oracle Knowledge Management 
Implementation Guide for details on using these 
functions.

Table C–1 Functions for Configurability of Look and Fee of Pages

Page Name Function Name
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Table C–2 Context Variables Available for Custom JSPs

Context Variables for a 
Logged-In User Means to Retrieve the Context Variable

UserID ((Long)pageContext.getAttribute ("ibuConfigUserID", 
PageContext.REQUEST_SCOPE))

RespID id ((Long)pageContext.getAttribute 
("ibuConfigRespID",PageContext.REQUEST_SCOPE))

AppID id ((Long)pageContext.getAttribute ("ibuConfigAppID", 
PageContext.REQUEST_SCOPE))

RespAppID ((Long)pageContext.getAttribute ("ibuConfigRespAppID", 
PageContext.REQUEST_SCOPE))

CustomerID ((Long)pageContext.getAttribute ("ibuConfigCustomerID", 
PageContext.REQUEST_SCOPE))

CompanyID ((Long)pageContext.getAttribute ("ibuConfigCompanyID", 
PageContext.REQUEST_SCOPE))

CompanyName (String)pageContext.getAttribute ("ibuConfigCompanyName", 
PageContext.REQUEST_SCOPE

UserName (String)pageContext.getAttribute ("ibuConfigUserName", 
PageContext.REQUEST_SCOPE))

FirstName (String)pageContext.getAttribute ("ibuConfigFirstName", 
PageContext.REQUEST_SCOPE))

LastName (String)pageContext.getAttribute ("ibuConfigLastName", 
PageContext.REQUEST_SCOPE))

user session ((oracle.apps.jtf.base.session.FWSession)pageContext.getAttrib
ute ("ibuConfigFWSession", PageContext.REQUEST_SCOPE))

AppsContext ((oracle.apps.jtf.base.session.FWAppsContext)pageContext.get
Attribute ("ibuConfigFWAppsContext", 
PageContext.REQUEST_SCOPE)).

Connection ((oracle.apps.jtf.base.session.FWAppsContext)pageContext.get
Attribute ("ibuConfigFWAppsContext", 
PageContext.REQUEST_SCOPE)).getConnection()
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Glossary

account

Account refers to the details or attributes of a deploying company’s selling 
relationship with a party. A selling relationship can include orders or negotiated 
prices. Account attributes do not describe a party; they only exist when a selling 
relationship is present between the deploying company and the party. 

account number

Number designated in the Trading Community Architecture (TCA) or Accounts 
Receivable (AR) and used to group account information about a party.

account site

A party site that is used within the context of an account, e.g., for shipping or billing 
purposes.

business entity

A branch, subsidiary, division, etc. of a company.

company

The entire business, including all business entities in the organizational structure.

contact point

A means of contacting a party other than sending physical mail, e.g., a phone 
number, e-mail address, telex number, fax number, etc.

customer

A person or organization with whom the deploying company has a selling 
relationship, regardless of whether anything has actually been purchased or 
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serviced. A selling relationship may be established by actually selling products, or it 
may be established by simply negotiating terms that will be used if you later sell 
products. In both scenarios, a selling relationship exists.

deploying company

The Oracle customer that has, or will, install, implement, and run all or part of the 
Oracle E-Business suite. 

DUNS Number

A unique identifier used by Dun & Bradstreet, a major business data content 
provider. The DUNS number is an attribute in the TCA.

GUI

An acronym for Graphical User Interface.

instance, item instance

In Oracle Install Base, an instance is an occurrence of an item entity. For example, a 
manufacturer has a part number for a television he makes; each time he sells one 
television, an occurrence of this part number is recorded in Install Base

location

A point in geographical space described by a street address.

merchant

An Oracle E-business suite customers. Used to alleviate confusion with the term 
customers, which refers to customers of a business using Oracle products.

multiple organizations (multi org)

The ability to define multiple organizations and the relationships among them 
within a single installation of Oracle Applications. These organizations can be sets 
of books, business groups, legal entities, operating units, or inventory 
organizations.

party

An entity in the TCA that can enter into business relationships. A party is a real 
person, an organization, a branch, a subsidiary, a legal entity, a holding company, 
etc. In TCA, the attributes of a party are considered universal, i.e., they are 
independent of your selling or buying relationship with the party.
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party relationship

In TCA, a binary relationship between two parties, such as a partnership. A party 
relationship can be a party itself, meaning certain party relationships can enter into 
relationship themselves.

party site

In TCA, the link between a party and a location that indicates the location is valid 
for that party. A party site is not intended to represent a distinct business entity 
with which you can do business.

registration

Refers to the process by which any user would gain access to application 
functionality.

Registration Admin UI

User Interface (UI) used by merchant administrator or any person granted 
privileges to maintain users and accounts.

Registration Self-Service User UI

User Interface (UI) that is used by individual users or business users to register 
themselves.

registration template

Part of the Oracle CRM JTF User Management Framework (JUMF), registration 
templates are JSP pages set up by the application administrator to capture 
accommodate user information-gathering requirements.

responsibilities

A grouping of application menus that determine the user interface accessible to a 
particular user.

roles

Groupings of permissions which are page- and function-level, granular privileges 
used to maintain application security.

self-service registration

Refers to the process of user self-registration through a self-service UI, as opposed 
to being registered by an administrator. Self-service registration includes the UI and 
background processes used to complete the registration processes (including 
assigning users the appropriate data access and UI access privileges).
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system administrator

Also called sysadmin, the system administrator is a user who performs the 
highest-level administrator tasks in Oracle applications. 

TCA

An acronym for Trading Community Architecture, sometimes used interchangeably 
with the Oracle Trading Community Model.

Trading Community Model

The Oracle Trading Community Model, also known as Trading Community 
Architecture (TCA).

UI

An acronym for User Interface.

user

Refers to any person who needs access to any application. This includes various 
types of customers, partners, suppliers, and employees.

user types

Users are categorized into types based on their registration requirements and access 
privileges. User types can be associated with default roles, responsibilities, 
accounts, registration templates, and approval requirements.

user type, business

A user with a selling relationship to the deploying company.

user type, employee

A user who is an employee of the deploying company.

user type, individual

A user with no selling relationship to the deploying company.

user type, primary

A designated person of a party, business entity, or internal group (for example, sales 
department) who is responsible for approving other users and resetting passwords.
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